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2 Iepazīšanās lapa

Paredzētais pielietojums:

Mediadent ir attēldiagnostikas programmatūra, kas paredzēta tikai zobu, sejas un žokļu speciālistiem, t.i.,
licencētiem zobārstiem, ortodontiem un zobārstu asistentiem.  Mediadent vizualizē, apstrādā un saglabā digitālus
vai digitalizētus attēlus, kas iegūti ar zobu attēldiagnostikas ierīcēm.
Ar Mediadent attēlus var nosūtīt uz dažādām arhivēšanas un komunikācijas sistēmām.

Mediadent programmatūru paredzēts izmantot datorā ar Windows operētājsistēmu zobārsta praksē vai zobārsta
darbavietā (birojā).

Mediadent piedāvā dažādus digitālus attēlu apstrādes rīkus, lai uzlabotu iegūto 2D un 3D attēlu kvalitāti un
diagnostisko vērtību. Tā ļauj lietotājam palielināt/samazināt attēlus, lietot iepriekš definētus filtrus, piemēram,
mainīt attēlu asumu un kontrastu, un veikt mērījumus attēlos. Dentofaciālās ortopēdijas modulis ļauj
ortodontiem un sejas un žokļu ķirurgiem veikt automatizētu cefalometrisko analīzi.

Mediadent mērķis ir atvieglot attēlu interpretāciju, sniedzot lietotājam skaidru, uzlabotu priekšstatu par pacienta
zobu veselību, un pēc tam atbalstīt diagnostiku, ārstēšanas plānošanu un turpmāko uzraudzību. 

Atlikušais risks:

Corilus vēlas vērst uzmanību uz šādiem atlikušajiem riskiem, kas saistīti ar Mediadent izmantošanu:
1. Programmatūras kļūdas ir raksturīgas jebkurai programmatūras sistēmai, piemēram  Mediadent. Corilus ir
ieviesti procesi, lai nepieļautu, identificētu un savlaicīgi novērstu zināmās kļūdas. Neraugoties uz šiem
centieniem, pastāv risks, ka tomēr pastāv nezināma kļūda Mediadent, kas, iespējams, var izraisīt nepareizu
informācijas apstrādi vai nepareizu attēlojumu.
2. Corilus pievērš vislielāko uzmanību savu produktu un saistīto pakalpojumu informācijas drošības un datu
aizsardzības nodrošināšanai. Tomēr kiberdrošība ir kopīga Corilus un programmatūras lietotāju atbildība, un
drošības incidenti vienmēr ir potenciāls risks savienotā vidē. Tāpēc mēs stingri iesakām jums kā   Mediadent
lietotājam aizsargāt savas darbstacijas, regulāri atjauninot operētājsistēmu un programmatūras izstrādes
komplektus/draiverus, kā arī instalējot ugunsmūri un galapunktu aizsardzības programmatūru (piemēram,
pretvīrusu programmatūru).
3.  Mediadent paļaujas, ka lietotājs programmatūru lietos pareizi. Lai atbalstītu pareizu lietošanu, Corilus un tās
izplatītāji nodrošina un regulāri atjaunina minimālo prasību sarakstu (kas ir šīs lietotāja rokasgrāmatas daļa),
mācību materiālus un lietotāja dokumentāciju par   Mediadent. Tomēr nevar izslēgt cilvēciskas kļūdas,
lietojot Mediadent, un tās, iespējams, var izraisīt kļūdainu rezultātu.
4. Lietotājs joprojām ir atbildīgs par zobu attēldiagnostikas aparatūras apkopi un konfigurāciju. Kļūdas, kas tieši
saistītas ar nepareizi funkcionējošu zobārstniecības attēldiagnostikas aparatūru, var radīt risku  Mediadent
programmatūrā (piemēram, avota attēls tiek ievietots   Mediadent nepareizi kalibrēts).   Mediadent neuzņemas
atbildību par ierīču, ar kurām tā ir saskarnē, darbības traucējumiem vai nepareiziem (piemēram, nepareizi
kalibrētiem) attēliem, kas tiek nosūtīti uz  Mediadent.
5. Corilus vēlas nodrošināt modernu attēldiagnostikas programmatūru un vislabāko servisu un atbalstu. Tāpēc
mēs esam izveidojuši un uzturam efektīvu kvalitātes vadības sistēmu, kas balstīta uz ISO-13485 standartu. Lai
gan mēs nepārtraukti uzlabojam savus kvalitātes vadības procesus, vienmēr pastāv neliela iespēja, ka var rasties
kļūda, kas potenciāli var ietekmēt produkta veiktspēju vai drošību. Šādā gadījumā mēs lūdzam lietotāju pēc
iespējas ātrāk sazināties ar Corilus (attiecīgā gadījumā ar izplatītāja starpniecību), lai mēs varētu noteikt
problēmas cēloni un veikt nepieciešamos korektīvos un preventīvos pasākumus.

Visi identificētie riski tiek pēc iespējas samazināti, un neviens no šiem atlikušajiem riskiem netiek uzskatīts par
nepieņemami lielu. Nav konstatētas nevēlamas blakusparādības un kontrindikācijas attiecībā uz  Mediadent
izmantošanu.

Klīniskais ieguvums:

Mediadent piedāvā plašu modernu attēlu uzlabošanas, apstrādes un mērīšanas rīku klāstu, kas nodrošina
pozitīvu ietekmi uz pacientu pārvaldību, atbalstot precīzu diagnostiku, ārstēšanas plānošanu un turpmāko
uzraudzību.

Īpaši apsvērumi:

Mediadent attēldiagnostikas programmatūra vienmēr ir integrēta pacientu pārvaldības sistēmā.

Visas pacientu pārvaldības sistēmas, kas ir saderīgas ar OLE saskarnes izmantošanu, tiek uzskatītas par
saderīgām, ja tās pareizi īsteno "Iegulšana Mediadent" dokumentācijas specifikācijas. 
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Komandrindas saskarnes izmantošana vairs netiek oficiāli atbalstīta, bet mēs to atbalstām pēc iespējas labāk
atpakaļsaderības dēļ. Ja jums ir jautājumi par šāda veida saskarni, lūdzu, sazinieties ar savu izplatītāju. 

Jūs varēsiet palaist Mediadent, izmantojot pacientu pārvaldības sistēmu, noklikšķinot uz  Mediadent ikonas. 

Savietojamo attēldiagnostikas aparatūras ierīču sarakstu var atrast mūsu tīmekļa vietnē www.imagelevel.com. Ja
jums ir jautājumi par savietojamību, aicinām sazinieties ar jūsu izplatītāja atbalsta dienestu.

Galalietotāja licences līgumu (EULA) var atrast:
- Kā izvēlnes elementu palīdzības izvēlnē
- Informācijas lodziņā
- Mūsu tīmekļa vietnē: https://www.corilus.be/en/end-user-license-agreement-eula

Jauniem lietotājiem iesakām iepazīties ar moduli "Darba sākšana", lai gūtu labu pārskatu par visbiežāk
izmantotajām funkcijām.

 Lūdzu, izlasiet 13. sadaļu, kur ir sniegta svarīga informācija lietotājiem.

Kas jauns Mediadent v8 versijā

Šajā tēmā jūs atradīsiet paskaidrojumu par  Mediadent jaunajām funkcijām. Šī sadaļa ļaus jums gūt ātru pārskatu
par jaunumiem, lai pieredzējuši lietotāji varētu jaunās iespējas izmantot savā darbā.

Kas jauns Mediadent v8 versijā ('Kas jauns Mediadent' in the on-line documentation)

1. Darba sākšana

Jauni lietotāji var doties uz sadaļu "Darba sākšana". Šeit atradīsiet pārskatu par biežāk izmantotajām
funkcijām Mediadent.

Tas ir lielisks sākuma punkts.

Darba sākšana (Section 5)

2. Soli pa solim

Izpildiet šos soļus un uzziniet, kā iegūt, apstrādāt, izdrukāt un saglabāt attēlu.

1. Attēla iegūšana (Section 5.2)

2. Darbs ar attēliem (Section 7.2)

3. Saglabāšana un drukāšana ('Saglabāšana un drukāšana' in the on-line documentation)

3. Kā lietot programmu

Sadaļā "Kā lietot programmu" ir sniegti noderīgi padomi par to, kā lietot Mediadent.

Kā lietot programmu (Section 8.1)

4. Ātra uzziņa

 Noklikšķiniet uz tēmām, ja vēlaties ātru pārskatu par funkcionalitāti, kas pieejama attiecīgajā izvēlnē vai ikonā.

Ikonu kopas pārskats (Section 4.2)

Izvēlņu pārskats (on-line documentation)

5. Palīdzība
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Šajā sadaļā lasiet, kā izmantot palīdzību un kā saņemt atbalstu.

Palīdzības izmantošana (on-line documentation)

Atbalsta saņemšana (Section 13)

6. Šajā dokumentā un uz marķējuma izmantotie simboli

Simbols Uzraksts Apraksts

Ražotājs
Norāda ražotāja nosaukumu un adresi.

Ražošanas datums
Norāda produkta izgatavošanas datumu, kur gads izteikts
ar četriem cipariem ("GGGG") un mēnesis izteikts ar
diviem cipariem ("MM"). Programmatūrai tas norāda
ražošanas laidiena datumu.

Iepazīstieties ar
lietošanas instrukciju

Norāda, ka lietotājam ir nepieciešams iepazīties ar
lietošanas instrukciju. Lietotāja rokasgrāmata (lietošanas
instrukcija) tiek piegādāta elektroniskā formātā. Ar
lietotāja rokasgrāmatu var iepazīties, izmantojot
Mediadent programmatūras palīdzības sadaļu, izmantojot
palīdzības izvēlni vai nospiežot īsinājumtaustiņu "F1".
Varat arī lejupielādēt PDF formāta kopiju
vietnēwww.imagelevel.comvai pieprasīt bezmaksas
eksemplāru papīra formātā, sazinoties ar mūsu klientu
atbalsta dienestu. Papīra rokasgrāmatas tiks piegādātas ne
vēlāk kā 7 kalendāro dienu laikā.

CE
marķējums

Burti "CE" ir uz daudziem produktiem, ko tirgo
paplašinātajā vienotajā tirgū Eiropas Ekonomikas zonā
(EEZ). Tie norāda, ka EEZ tirgotie produkti ir novērtēti kā
atbilstoši augstām drošības, veselības un vides
aizsardzības prasībām.

Medicīniska ierīce
Norāda, ka prece ir medicīniska ierīce.

Unikāls ierīces
identifikators

Norāda datu nesēju, kas satur unikālā ierīces
identifikatora ("UDI") informāciju.

Atsauce uz lietošanas
pamācību/rokasgrāmatu

Norāda, ka ir jāizlasa lietošanas pamācība/rokasgrāmata.

Ievērot piesardzību!

Norāda, ka ir jāievēro piesardzība, lietojot ierīci vai vadīklu
tuvu simbola atrašanās vietai. Norāda, ka pašreizējā
situācijā nepieciešama operatora izpratne vai operatora
rīcība, lai izvairītos no nevēlamām sekām. Uz veselības
lietotnes kvalitātes marķējuma: lai norādītu, ka veselības
lietotnes lietošanai nepieciešams veselības aprūpes
speciālista apstiprinājums.
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3 Informācija lietotājiem
 

3.1 Minimālās sistēmas prasības

Operētājsistēma:
Microsoft Windows 10 vai jaunāka versija
Jaunākā informācija par atbalstītajām operētājsistēmas versijām:
https://support.microsoft.com/nl-be/help/13853/windows-lifecycle-fact-sheet

Procesors:
Procesors ar diviem vai vairāk kodoliem.

Galvenā atmiņa:
4 GB RAM vai vairāk 

Grafika:
2D attēlveidošanai: 

Integrēta vai atsevišķa videokarte. 
Izšķirtspēja:  1024x768 vai vairāk
Atmiņa: 256MB

3D skatītājam:
Atsevišķa videokarte
Izšķirtspēja: 1024x768 vai UHD, vai HD
Atmiņa: 4GB

CT attēlu uzņemšanai:
Atkarībā no izmantotās apratūras.
Atsevišķa videokarte.
Izšķirtspēja: 1024x768 vai UHD, vai HD
Atmiņa: 4GB
Dažām ierīcēm nepieciešams NVIDIA CUDA atbalsts
(https://developer.nvidia.com/cuda-zone) 

USB porti:
1 brīvs USB1.1 ports (vai jaunāka versija) licences atslēgai (viena lietotāja instalācija)
1 brīvs USB2.0 ports (vai jaunāka versija) USB tveršanas ierīcēm.

Glabāšana:
Tips: Ieteicams izmantot ātru SSD disku.
Lielums: Min. 512 GB
Lietotājam jābūt pilnām tiesībām uz programmas un datu direktoriju.

Tīkla adapteris:
Windows draiveris, kas pieejams instalētajai operētājsistēmai. 
10/100/1000 Mbps
RJ-45 savienotājs
Stabils tīkla savienojums. 
Dažām rentgena iekārtām nepieciešama papildu tīkla karte.

Tīkla datu koplietošana:
failu izmaiņu paziņojums, lai pareizi atsvaidzinātu attēlu bibliotēku un statusa skatu.
Windows:  SMBv2 vai jaunāka versija
NAS / Linux:  Samba 2.0 vai jaunāka versija (smb.conf | Noklusējuma iestatījums: change
notify = yes)
Lietotājam jābūt datu koplietošanas lasīšanas/rakstīšanas tiesībām.

Programmatūra
PDF, lai piekļūtu elektroniskajām lietošanas instrukcijām ("Lietotāja rokasgrāmata") vai
iebūvētajam Windows palīdzības skatītājam
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3.2 Svarīga informācija lietotājiem

Produkta kalpošanas laiks:

Produkta kalpošanas laiks Mediadent programmatūrai ir dokumentēts 6 gadi no iegādes datuma. Lietotājiem, kas
iegādājas bez abonementa, atjauninājumi tiek nodrošināti vienu gadu no iegādes datuma. Pēc šī perioda beigām
atbalsts un atjauninājumi attiecas tikai uz tajā laikā izmantoto programmatūras versiju. Turpmākie
atjauninājumi būs pieejami tikai tad, ja tobrīd ir spēkā abonements.
 
Ir svarīgi nodrošināt, lai jūsu sistēma un saistītā aparatūra arī turpmāk atbilstu minimālajām sistēmas prasībām
visā produkta darbības laikā. Ja rodas jautājumi par programmatūras darbības laiku, atjauninājumiem vai
apkopi, sazinieties ar izplatītāju.

 

Brīdinājumi un piesardzības pasākumi:
Mediadent lietotājiem jābūt zobārstniecības speciālistiem, kas ir
kvalificēti veikt zobu attēldiagnostiku un interpretēt attēlus. 
Ievada apmācību par Mediadent programmatūras lietošanu nodrošina
jūsu izplatītājs instalēšanas procesa laikā. Lietotāji saņem arī piekļuvi
pilnai dokumentācijai, kas pieejama vietnē www.imagelevel.com. Ja
rodas papildu jautājumi par lietošanu, lietotājs tiek aicināts sazināties
ar izplatītāju, lai saņemtu atbalstu vai pieprasītu ieplānot apmācību.
Šī programmatūra ir tikai diagnostikas palīglīdzeklis. Pirms pieņemat
lēmumu par ārstēšanu, jums ir jāizmanto profesionālajā apmācībā
iegūtās zināšanas un spriestspēja.
Instalāciju var veikt tikai vidē, kas atbilst minimālajām sistēmas
prasībām (Section 3.1). Lietotājs ir atbildīgs par atbalsta infrastruktūru
(piemēram, datoru uzturēšanu, tīkla savienojumiem, elektroapgādi) un
tās stabilitāti.
Minimālajās sistēmas prasībās (Section 3.1) lietotājs tiek informēts,
ka virtualizācijas izmantošana netiek oficiāli atbalstīta. Ja jums ir
jautājumi par virtualizācijas izmantošanu, lūdzu, sazinieties ar savu
izplatītāju.
Radiogrāfiskie attēli nav piemēroti diagnostikas vajadzībām, ja tos
skatās displejos vai monitoros, kas neatbilst minimālajām sistēmas
specifikācijām (Section 3.1).
Visām pievienotajām ierīcēm jābūt iekļautām savietojamības sarakstā
(pilnu pārskatu skatīt mūsu vietnē www.imagelevel.com), lai tās tiktu
oficiāli atbalstītas. 
Lietotājs joprojām ir atbildīgs par attēlu un saistīto metadatu kvalitātes
pārbaudi, lietojot Mediadent programmatūru un importējot uz
Mediadent un eksportējot no tās.
Ieteicams mērījumus vai zīmējumus veikt tikai kalibrētiem attēliem.
Veicot mērījumus attēlā bez kalibrēšanas informācijas, ir jāizmanto
zināma garuma atskaites segments.
Par programmatūrā veiktajām anotācijām un mērījumiem atbildat jūs.
Radiogrāfiskais attēls ir trīsdimensiju objekta divdimensiju attēls, un
mērījumi var būt kļūdaini. Mērījumi ir tikai informatīvi, un par darbībām,
kas prasa precīzu novietojumu uz pacienta, atbildat jūs. 
Panorāmas vai OPG attēli pēc savas būtības satur izkropļojumus, ko
rada palielinājums gan vertikālā, gan horizontālā virzienā. Jebkura
kalibrēšana šo tipu attēlos jāuzskata par aptuvenām vadlīnijām, kas
attiecas tikai uz kalibrēšanas tiešā tuvumā esošo apgabalu. Iepriekš
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noteikta garuma objektu, piemēram, implantu simulatoru, ievietošana
sniedz aptuvenu informāciju. 
Informācija par pacienta orientāciju netiek sniegta intraorālajiem
attēliem, digitālās radiogrāfijas (CR) attēliem, cefalometriskiem slīpiem
attēliem vai krāsu attēliem. Šo attēlu orientācija ir atkarīga no lietotāja
darbībām un pacienta novietojuma. 
Attēla iegūšana jāveic, kad sensors ir gatavs ekspozīcijai. Lūdzu,
pārbaudiet sensora ekspozīcijas statusu (ja tas tiek rādīts Mediadent),
pirms iegūstat attēlu.

Nopietni incidenti:
Lūdzu, nekavējoties ziņojiet savam izplatītājam par jebkādiem ar Mediadent
programmatūru saistītiem incidentiem. Jūsu izplatītājam ir jādara viss
nepieciešamais, lai izpildītu savas juridiskās un līgumiskās saistības un pēc
iespējas ātrāk palīdzētu mazināt incidenta sekas.

Jūs varat arī sazināties ar vietējo kompetento iestādi, lai nodrošinātu
piesardzības pasākumus. ES kompetento iestāžu kontaktinformācija ir pieejama
to tīmekļa vietnē.

Šajā tabulā sniegta norāde par Mediadent mērījumu precizitāti. Šo mērījumu laikā novērotās novirzes var patiesi
neatspoguļot klīniskajā praksē veikto faktisko zobu mērījumu iespējamās novirzes, jo tos var būt grūtāk veikt.
Lai saglabātu mērījumu konsekvenci, ieteicams kalibrēt sensoru, izmantojot standarta kalibrēšanas algoritmus.

Mediadent mērījumu precizitāte
Zelta

standarts:
patiesais

objekta garums
(mm)

Vidējais mērījums
(mm)

Standartnovirze
(mm)

95% ticamības intervāls
(mm)

Testa objekts 1:
10.000  10.004 0.018 10.000 +- 0.016

Testa objekts 2:
20.000  20.022 0.029 20.000 +- 0.026
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4 Kas jauns Mediadent v8 versijā
 

4.1 Ekrāna izkārtojuma maiņa Mediadent

Mediadent v8 versijā ir ļoti vienkārši mainīt ekrāna izskatu.

Varbūt vēlaties izmantot klasiskās ikonas, kuras lietojāt iepriekšējā versijā.

Turpmākajā sadaļā jūs iepazīstināsim ar nepieciešamajām darbībām, kas jāveic, lai jūs atgūtu pazīstamo
darbvirsmu.

Darbība Paskaidrojums

Mediadent izvēlnē izvēlieties Options > Setup Jums tiks piedāvātas
vairākas opcijas.

Izvēlieties pēdējo cilni "Style" Cilnē "Style" ir
pieejamas visas opcijas,
lai mainītu programmas
izskatu.

Cilnē "Select style" izvēlieties "Presets" Jūsu ērtībai esam
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izveidojuši vairākus
sākotnējos iestatījumus,
no kuriem varat
izvēlēties.

Nolaižamajā izvēlnē "Presets" izvēlieties "Classic". Sākotnējais
iestatījums "Classic"
nodrošinās jums
klasiskās ikonas kopā ar
programmas
iepriekšējās versijas
izskatu.

Izvēlieties "Save Changes" Neaizmirstiet saglabāt
izmaiņas, citādi tās
netiks lietotas.

Izvēlieties "Exit" Izejiet no iestatīšanas
ekrāna.

Lai redzētu jauno
izvēlēto sākotnējo
iestatījumu, programma
būs jāpalaiž no jauna.

Tāpēc izejiet no
programmas,
noklikšķinot uz pogas
"Exit", un palaidiet
programmu no jauna.

Pēc programmas atkārtotas palaišanas jūs iegūsiet klasisko izskatu.
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Lai atgrieztos pie jaunā izskata, veiciet iepriekš minētās darbības un izvēlieties "Default" stilu.

4.2 Ikonu pārskats

Šajā sadaļā mēs īsi izskaidrosim ikonu kopas lietošanu un sniegsim pārskatu par dažādajām ikonām un to
funkcijām.

Tas sniegs lielisku pārskatu par Mediadent iespējām.

Kad attēls tiek ielādēts skatvietā, jūs redzēsiet attiecīgās aktīvās ikonas.
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Jauna Mediadent v8 versijas funkcionalitāte

Jaunais filtru logs sniedz vizuālu priekšstatu par to, kā uzlabot attēla kvalitāti.

Darbs ar filtru logu (Section 7.2.9)

Ikona Iepriekšējā
ikona

Paskaidrojums

Ikona, ar ko aktivizē attēlu bibliotēku. Attēlu bibliotēkā tiek
glabāti visi attiecīgā atlasītā pacienta attēli.

Sadaļas par attēlu bibliotēku:

Darbs ar attēlu bibliotēku (Section 7.5.4)

Attēlu secības maiņa (on-line documentation)

Kā meklēt attēlus (Section 8.3.3)

Ikona, ar ko aktivizē statusa paneli.

Ja ikona spīd zaļā krāsā, tas nozīmē, ka ir definēti vairāki
statusa paneļi.

Sadaļas par statusa paneli:

Statusa panelis (Section 12.3)

Darbs ar statusa paneli attēlu iegūšanas režīmā (Section
7.4.2)

Ikona, ar ko aktivizē anotācijas.

Sadaļas par anotācijām:

Darbs ar anotācijām (Section 7.2.3)

Ikona, kas ļauj izvēlēties interešu reģiona formu.

Nospiediet un TURIET nospiestu kreiso peles pogu, līdz
ikona tiek izvērsta.

Sadaļa par interešu reģionu:

Darbs ar interešu reģionu (Section 7.2.5)

Ikona, kas ļauj izvēlēties skatvietu skaitu.

Nospiediet un TURIET nospiestu kreiso peles pogu, līdz
ikona tiek izvērsta.

Sadaļas par skatvietām:

Skatvieta (Section 12.1)

Darbs ar skatvietām (Section 7.1.2)

Darbības ar skatvietu (on-line documentation)
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Ikona, ar ko aktivizē tālummaiņas logu.

Sadaļa par tālummaiņas logu:

Darbs ar tālummaiņas logu (Section 7.2.4)

Ikona, ar ko saglabā attēlu.

Sadaļas par attēlu saglabāšanu:

Attēla saglabāšana (Section 5.4)

Pārskats par konkrētu papildu informāciju un
atslēgvārdiem (Section 7.5.2)

Ikona, ar ko dzēš aktīvo attēlu.

Sadaļas par attēlu dzēšanu:

Kā atgūt izdzēstu attēlu (Section 8.4.3)

Darbs ar attēlu bibliotēku (Section 7.5.4)

Ikona, ar ko aktivizē histogrammu.

Sadaļas par histogrammu:

Kā darbojas histogramma? (Section 12.5)

Darbs ar pelēko toņu korekciju (Section 7.2.1)

   

Ikona, ar ko aktīvo attēlu pagriež par 90°.

Otra ikonas funkcija ir iespēja "brīvi" pagriezt attēlu. Nospiediet
un turiet peles kreiso pogu uz ikonas, un kļūs pieejama otrā
funkcija.

Brīvā pagriešana (on-line documentation)

    

Ikonas, ar kurām attēlu apvērš vertikāli vai horizontāli. 

Ikona, ar ko invertē aktīvo attēlu.

Ikona, ar ko drukā attēlus.

Sadaļas par attēlu drukāšanu:

Attēlu drukāšana (Section 5.5)

Statusa paneļa drukāšana (on-line documentation)

Šī ir viena no svarīgākajām ikonām programmā Mediadent.
Noklikšķinot uz ikonas, tiks palaists attēlu iegūšanas režīms un
būs iespējams izmantot attēlu iegūšanas ierīci.

Sadaļas par attēlu iegūšanu:

Attēla iegūšana (Section 5.2)

Darbs ar statusa paneli attēlu iegūšanas režīmā (Section
7.4.2)
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Ikona attēlu iegūšanai ar statusa paneli.

Sadaļas par statusa paneli:

Statusa panelis (Section 12.3)

Darbs ar statusa paneli attēlu iegūšanas režīmā (Section
7.4.2)

Ikona, ar ko aktivizē WDMvideo kadru tveršanas moduli. Šis
modulis ļaus jums izmantot kameru, lai uzņemtu attēlus.

Sadaļa par video kadru tveršanas moduli:

Darbs ar Video kadru tveršanas moduli (Section 7.7.1)

Ja izmantojat Durr Vistacam, ikona izskatīsies šādi:

Ikona, ar ko aktivizē WDM videostraumējuma moduli.

Sadaļa par WDM videostraumējuma moduli:

Darbs ar WDM videostraumējuma moduli (on-line
documentation)

Ikona, ar ko aktivizē kādu no optimizācijas profiliem.
Optimizācijas profili var uzlabot attēlu kvalitāti.

Nospiediet un TURIET kreiso peles pogu, līdz ikona tiek
izvērsta, vai noklikšķiniet ar labo peles pogu, un parādīsies
optimizācijas profilu saraksts.

               
Sadaļas par optimizācijas profiliem:

Darbs ar optimizācijas funkciju (Section 7.2.7)

Optimizācijas modulis (Section 11.1)
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Ikona, lai atkārtoti ielādētu sākotnējo saglabāto attēlu.
Sākotnējo attēlu vienmēr var izgūt.

Ikona, ar ko aktivizē ierīces, kas izmanto TWAIN interfeisu.

Sadaļas par TWAIN moduli:

Darbs ar TWAIN moduli (on-line documentation)

Ikona, ar ko aktivizē pilnekrāna statusa ekrānu.

Sadaļas par pilnekrāna statusa ekrānu:

Pilnekrāna statusa panelis (on-line documentation)

HT17 Kā eksportēt pilnekrāna statusa paneli (on-line
documentation)

Ikona, ar ko palaiž Reporter moduli. Reporter modulis ir
atsevišķs modulis. Ja šī ikona nav redzama, tas nozīmē, ka tā nav
aktivizēta. Sazinieties ar savu izplatītāju, lai iegūtu vairāk
informācijas.

Ja ikona spīd zaļā krāsā, tas nozīmē, ka Reporter modulī ir
dokumenti par šo pacientu.

Sadaļas par Reporter moduli:

Darbs ar Reporter moduli (on-line documentation)

Ikona, ar ko palaiž Dicom tīkla moduli.

Sadaļas par Dicom moduli:

Dicom modulis (on-line documentation)

Ikona, ar ko palaiž Dicom drukāšanas moduli.

Sadaļas par Dicom moduli:

Dicom modulis (on-line documentation)

Ikona, ar ko attēlam lieto automātisko kontrastu.

Sadaļas par filtriem:

Darbs ar filtriem (Section 7.2.6)

Ikona, ar ko attēlam lieto asuma palielināšanas filtru.

Sadaļas par filtriem:

Darbs ar filtriem (Section 7.2.6)

Ikona, ar ko attēlam lieto trokšņu samazināšanas filtru.

Sadaļas par filtriem:

Darbs ar filtriem (Section 7.2.6)

Ikona, ar ko lieto Cosmetic moduli.

Sadaļas par Cosmetic moduli:

Cosmetic modulis (on-line documentation)
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Ikona, ar ko izmanto DFO (Dentofaciālā ortopēdija) analīzes rīku.
Tas piedāvā iespēju ātri izveidot ortodontisko analīzi. Lai iegūtu
vairāk informācijas, sazinieties ar vietējo izplatītāju.

Ikona, ar ko attēlam lieto filtrus.

Sadaļas par filtriem:

Darbs ar filtriem (Section 7.2.6)

('HT12 Kā importēt
attēlus' in the on-
line
documentation)

Direktoriju importēšanas ikona. Šī ir izvēles ikona. Pēc noklusējuma
šī ikona nav aktivizēta.

Sadaļas par direktoriju importēšanu:

HT12 Kā importēt attēlus (on-line documentation)

Lai šo ikonu pievienotu ikonu joslai, izlasiet šo sadaļu: Kā pielāgot
ikonu kopu (Section 8.2.2)

Direktoriju eksportēšanas ikona. Tāpat kā iepriekš minētā ikona, arī
šī ikona pēc noklusējuma nav aktivizēta.

Sadaļas par direktoriju eksportēšanu:

Kā eksportēt vairākus viena pacienta attēlus (Section
8.6.2)

Lai šo ikonu pievienotu ikonu joslai, izlasiet šo sadaļu: Kā pielāgot
ikonu kopu (Section 8.2.2)

Ikona IzietMediadent. Programmu Mediadent var konfigurēt, lai tā
NEAIZVĒRTOS. Tas paātrinās Mediadent palaišanas procesu,
izmantojot pacientu pārvaldības sistēmu.

Šī ir ikona Dental Eye. Šis ir papildu modulis, ko izmanto kopā ar
Dentaleyepad. Šī intelektiskā zobārstniecības kamera seko darba
plūsmai, tāpēc tā fokusē pareizajā vietā, palielina un patstāvīgi
atspoguļo attēlus. Vairāk informācijas par šo jauno kameru var
atrast šajā tīmekļa vietnē: DentaleyePad.

Šī kamera ir pilnībā integrēta Mediadent statusā. Tas ļauj,
piemēram, automātiski piesaistīt zobus.

Sadaļas par DentalEyepad integrāciju var atrast šeit: Kā lietot
Dentaleyepad kameru Mediadent ('DentaleyePad' in the
on-line documentation) 

Varat paslēpt neizmantotās ikonas. Lai uzzinātu, kā to izdarīt, izlasiet sadaļu Kā pielāgot ikonu kopu
(Section 8.2.2).

4.3 Jauni darbvirsmas izveides un modificēšanas rīki Mediadent versijā 8

Šajā jaunākajā versijā ir daudz kas pievienots, lai uzlabotu darbvirsmu izveidi programmā.

Lai saprastu, kas ir darbvirsma, vispirms izlasiet šo sadaļu:  Darbvirsma (Section 12.2) 

Šajā sadaļā mēs izskaidrosim papildu rīkus, kas jums ir pieejami, lai modificētu darbvirsmu.

1. Darbvirsmas paneļa opciju aktivizēšana

Izvēlnē izvēlieties Display > Desktop Panels > Position/size controls
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2. Pārskats par rīklodziņa ikonām un piemēri

Ikona Paskaidrojums

Šīs ir vadīklas, kas nosaka rīklodziņa pozīciju. Opcijas ir pa kreisi, pa labi, augšā un apakšā. Rīklodziņu var arī
vilkt un nomest manuāli.

Snap to grid (Fiksēt pie režģa): ja ikona spīd sarkanā krāsā, ekrāna elementi tiks fiksēti pie režģa. To var
deaktivizēt, noklikšķinot uz ikonas.

Align to grid (Līdzināt pie režģa): šī funkcija ļauj ekrāna elementus līdzināt pie režģa.

Ekrāna elementu līdzināšana.

Līdzināt pa kreisi, līdzināt pa labi, līdzināt uz augšu, līdzināt uz apakšu.

Līdzināšana tiek veikta attiecībā pret pirmo atlasīto lodziņu.
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Piemērs: līdzināšana uz augšu

Atlasiet pirmo lodziņu 

Atlasiet otro lodziņu ar Ctrl un noklikšķiniet uz otrā lodziņa

Noklikšķiniet uz ikonas "līdzināt uz augšu" (align top) 

 

 Rezultāts:

Līdzināšana blakus vai viens virs otra.

Piemērs: līdzināšana blakus viens otram.

Atlasiet pirmo lodziņu un atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl .

Noklikšķiniet uz ikonas  , lai novietotu 2 lodziņus vienu otram blakus.
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Rezultāts: 2 lodziņi ir novietoti viens otram blakus.

Vienāds lielums

Šī opcija ļauj izveidot vienāda lieluma ekrāna elementus.

Pirmais atlasītais lodziņš noteiks otra atlasītā lodziņa lielumu.

Atlasiet pirmo lodziņu, kuram ir vēlamais lielums.

Atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl.
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Noklikšķiniet uz ikonas 

Rezultāts: Otrais lodziņš ir tāda paša lieluma kā pirmais lodziņš.

 

4.4 Kā izmantot iepriekšējo izskatu

Mediadent v8 versijā ir ļoti vienkārši mainīt ekrāna izskatu.
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Varbūt vēlaties izmantot klasiskās ikonas, kuras lietojāt iepriekšējā versijā.

Turpmākajā sadaļā jūs iepazīstināsim ar nepieciešamajām darbībām, kas jāveic, lai jūs atgūtu pazīstamo
darbvirsmu.

Darbība Paskaidrojums

Mediadent izvēlnē izvēlieties Options > Setup Jums tiks piedāvātas
vairākas opcijas.

Izvēlieties pēdējo cilni "Style" Cilnē "Style" ir
pieejamas visas opcijas,
lai mainītu programmas
izskatu.

Cilnē "Select style" izvēlieties "Presets" Jūsu ērtībai esam
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izveidojuši vairākus
sākotnējos iestatījumus,
no kuriem varat
izvēlēties.

Nolaižamajā izvēlnē "Presets" izvēlieties "Classic". Sākotnējais
iestatījums "Classic"
nodrošinās jums
klasiskās ikonas kopā ar
programmas
iepriekšējās versijas
izskatu.

Izvēlieties "Save Changes" Neaizmirstiet saglabāt
izmaiņas, citādi tās
netiks lietotas.

Izvēlieties "Exit" Izejiet no iestatīšanas
ekrāna.

Lai redzētu jauno
izvēlēto sākotnējo
iestatījumu, programma
būs jāpalaiž no jauna.

Tāpēc izejiet no
programmas,
noklikšķinot uz pogas
"Exit", un palaidiet
programmu no jauna.

Pēc programmas atkārtotas palaišanas jūs iegūsiet klasisko izskatu.
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Lai atgrieztos pie jaunā izskata, veiciet iepriekš minētās darbības un izvēlieties "Default" stilu.

4.5 3D skatītājs

3D Viewer ir izvēles pievienojumprogramma, ko var izmantot jaunākajā Mediadent versijā v8.

Tas ir integrēts skatītājs un ļauj skatīt 3D attēlus tieši no Mediadent attēlu bibliotēkas. Intuitīva 3D attēlu vizualizācija, ko atvieglo
Mediadent, atbalsta diagnostiku un ārstēšanas plānošanu. Tas nodrošina izmaksu ziņā efektīvu veidu, kā aplūkot 3D attēlus pazīstamā
programmā.

Sazinieties ar savu izplatītāju, lai iegūtu plašāku informāciju par izvēles 3D Viewer moduli.

3D skatītājs spēj ģenerēt daudzplakņu (MPR), telpiskās (3D) un rentgena rekonstrukcijas un satur nepieciešamos rīkus rūpīgai
un padziļinātai medicīnisko attēlu apskatei, t. i., anotācijas un mērījumu rīkus.

Jūs varat palielināt vai samazināt attēlu un pagriezt 3D attēlu ap tā centru, lai to labāk apskatītu.

Grupas pārskats ļauj pārvietoties pa attēliem vai dažādiem rekonstrukcijas griezumiem.

Līdzās iekšējam 3D skatītājam jūs programmā Mediadentvarat izmantot vairākus citus skatītājus.

Lai aktivizētu 3D skatītāja moduli, veiciet dubultklikšķi uz 3D attēla attēlu bibliotēkā.

Tiek parādīts 3D skatītāja atlasītājs:
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Izvēlieties 3D skatītāju.           

Kā redzat, mēs atbalstām arī trešo pušu skatītājus.

Ir iespējams integrēt trešord pušu skatītājus:

AsahiVision

Ez3D

Ez3D-I

EzImplant

3D Planner (Villa)

CS 3D Imaging (Carestream)

Ja ir instalēts kāds no šiem skatītājiem, to var palaist no Mediadent.

Šajā nodaļā ir aprakstīts iekšējais 3D skatītājs.

 Mēs atbalstām dažādas 3D ierīces; dodieties uz tīmekļa vietni un pārbaudiet, vai jūsu 3D ierīce tiek atbalstīta.

Ja jūsu ierīces nav sarakstā, tad pirms 3D attēlu (griezumu) izmantošanas skatītāja programmatūrā tie būs jāimportē.

Lai importētu 3D attēlu, izpildiet šādas darbības:

1. 3D attēla importēšana

Lai importētu 3D attēlu, izpildiet šādas darbības

Darbība Paskaidrojums

Izvēlieties File > Import CT Images izvēlnē Pirms datortomogrāfijas attēlu analizēšanas
programmā tie vispirms ir jāimportē.

Atlasiet failus, kas veido 3D attēlu, un noklikšķiniet uz "Import"
(Importēt) pogas.

3D attēlu veido vairāki faili. Katrs fails ir
griezums, ko izmanto 3D attēla veidošanai.
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Attēls ir integrēts Mediadent un gatavs apskatei ar 3D skatītāju.

Veiciet dubultklikšķi uz attēla, un tiks palaists 3D skatītājs.                        

Kad griezumi ir importēti, 3D skatītājs var
rekonstruēt 3D attēlu.

 Veiciet dubultklikšķi uz datortomogrāfijas attēla, un tiks atvērts 3D skatītāja atlases ekrāns ar aktīvu 3D attēlu.

Šajā nodaļā ir izskaidroti dažādi skati.

2. Dažādi skati

Pārskats par 3D skatītāja ekrānu.

Ir 3 dažādi skati\:

3D telpiskais skats : Šis skats ļauj apvienot telpisko skatu (logs labajā pusē) ar 3 skatiem (aksiālo, sagitālo un koronālo).

Ir iespējams pagriezt attēlu telpiskajā skatā.

          

 

2D grupas (2D Stack) skats: Šis skats ļauj apskatīt griezumus, no kuriem veidots 3D attēls.

Varat ritināt pa dažādiem griezumiem un analizēt attēlu pa griezumiem.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

28

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



                       

 

Izliekts daudzplakņu (Curved MPR) skats: Pamatojoties uz daudzstūri, jūs varat rekonstruēt panorāmas attēlu. Varat zīmēt vairākus
daudzstūrus un skatīt tos dažādos logos.

3D telpiskais skats

3D attēlus var skatīt 3D telpiskajā skatā.

Darbības ar attēlu:

Labajā pusē attēlu var pagriezt, vienkārši nospiežot un turot nospiestu peles kreiso pogu, vienlaikus pagriežot attēlu pareizajā
pozīcijā.

Ekrāna kreisajā pusē ir 3 dažādi logi (aksiālais, sagitālais un koronālais), attēlus var ritināt, izmantojot slīdņus.

3D skatītājā attēlu var apskatīt dažādos režīmos
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Ikona Attēls

Šis ir skats, kurā galvenajā logā būs redzami mīkstie audi, bet kreisajā pusē - aksiālais, sagitālais un koronālais
skats. Jums ir iespēja pagriezt attēlu galvenajā logā.

Šis skats ļaus jums izvēlēties griezumu griešanas veidu.
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Šajā gadījumā galvenajā skatā tiek parādīta kaulu struktūra.
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Invertē attēlu galvenajā skatā.

Parāda Dicom tagus uz attēliem.

Šī ikona parāda lineālu attēla malā. To var aktivizēt vai deaktivizēt, noklikšķinot uz ikonas.

Šīs ikonas ļauj mainīt kreisās un labāspeles pogas darbību.

Rotate 3D Object (Pagriezt 3D objektu)
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Scale 3D Object (Mērogot 3D objektu)

Window Level (Loga līmenis)

Offset (Nobīde)

Rotate 3D Camera (Pagriezt 3D kameru)

Translate 3D Camera (Translēt 3D kameru)

Izmantojot šo ikonu, varat atgriezties pie sākotnējās analīzes. Tas nozīmē, ka pēc pagriešanas, skatu izmaiņu
veikšanas u. c. ir iespējams atgriezties pie situācijas, it kā attēls tiktu palaists pirmo reizi.

Šī ikona ļauj saglabāt pašreizējo stāvokli. Tas nozīmē, ka pēc šī stāvokļa saglabāšanas fails tiks atvērts saglabātajā
stāvoklī.

Ļoti interesanta funkcija - ar šo ikonu jūs varat saglabāt pašreizējā stāvokļa ekrānuzņēmumupacienta attēlu
bibliotēkā.

Ar šo ikonu iziet no 3D skatītāja.

2D grupas (2D Stack) skats

2D grupas skats ir vienkāršs skats, kas ļauj iziet cauri dažādiem griezumiem.

Lai ritinātu, vienkārši izmantojiet turus labajā pusē.

Ja vēlaties, ekrānā varat skatīt 4, 9 vai 12 griezumus.

Jums ir pieejamas opcijas saglabāt statusu un izveidot ekrānuzņēmumu , ko var saglabāt pacienta bibliotēkā.

Sīkāku informāciju par dažādām pogām skatiet iepriekšējā sadaļā (3D skatītājs).

Izliekts daudzplakņu (Curved MPR) skats

Šis skats ļauj rekonstruēt panorāmas attēlu, par pamatu izmantojot daudzstūri, kas ir uzzīmēts griezumā.

Varat rekonstruēt pat vairākus attēlus, par pamatu izmantojot daudzstūrus, kas ir uzzīmēti griezumā kreisajā ekrānā.
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Pirms sākat darbu, ielādējietattēlu 3D skatītājā un izvēlieties cilni Izliekts daudzplakņu (Curved MPR) skats.

Pārvietojiet slīdni uz leju, lai redzētu pareizo griezumu, ko vēlaties izmantot par pamatu panorāmas attēlam.

Lai sāktu rekonstrukciju, noklikšķiniet uz daudzstūra pirmā punkta.

Klikšķiniet tālāk, lai izvietotu pārējos daudzstūra punktus.

Lai beigtu, veiciet dubultklikšķi uz pēdējā punkta. Panorāmas attēls tiek automātiski rekonstruēts.
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Ar šo pogu tiek noņemti visi attēlā uzzīmētie daudzstūri.

Jums ir iespēja izpētīt vairākus daudzstūrus.

Izvēlieties daudzstūru skaitu, ko vēlaties izpētīt.

- 1 daudzstūris

- 2 daudzstūri

- 4 daudzstūri

Nākamajā ekrānuzņēmumā redzama 2X2 atlase, kurā redzama 4 daudzstūru rekonstrukcija.

Viena no interesantākajām iespējām ir izveidot paraksiālu šūnu.

Pēc tam, kad daudzstūris ir uzzīmēts, noklikšķiniet ar labo peles pogu, un parādīsies šāda izvēlne.
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Izvēlieties "Create Paraxial cell" (Izveidot paraksiālo šūnu), un tā tiks uzzīmēta attēlā.
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5 Darba sākšana

Pirms sākat izmantot programmatūru, ir svarīgi izprast dažādos ekrāna elementus un veidu, kā varat
pārvietoties pa dažādām opcijām.

Pēc iepazīšanās ar ekrāna elementiem varat veikt darbības, lai iegūtu attēlu.

Pamata darbības ar attēlu var būt noderīgas, ja jums ir nepieciešams attēlu analizēt diagnostikas nolūkos.

Ir vairāki veidi, kā kopīgot savus attēlus ar kolēģiem vai citām sistēmām.

Instrukcijas soli pa solim
1. Pārskats par ekrāna elementiem (Section 5.1)

2. Attēla iegūšana (Section 5.2)

3. Pamata darbības ar attēlu (Section 5.3)

4. Attēla saglabāšana (Section 5.4)

5. Attēla izdrukāšana (Section 5.5)

6. Attēla nosūtīšana pa e-pastu (Section 8.6.1) 

5.1 Pārskats par Mediadent ekrāna elementiem

Jūs palaidīsiet Mediadent, izmantojot savu pacientu pārvaldības sistēmu. Mediadent saņems informāciju
par pacientiem (vārdu, ...) no pacientu pārvaldības sistēmas.

Šajā sadaļā sniegsim pārskatu par dažādiem Mediadent ekrāna elementiem un to funkcijām.

Tas ir labs veids, lai labāk iepazītu Mediadent.

Pēc Mediadent palaišanas var tikt parādīts šāds ekrāns:

  

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

37

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Šīs ir dažādas izvēlnes opcijas. Lielākajā daļā no šiem gadījumiem opcijas ir pieejamas arī Ikonu kopā.

Šos lodziņus uz ekrāna sauc par skatvietām. Jūs varat aktivizēt Skatvietu un ielādēt pacienta attēlu.
Analīzes un diagnostikas vajadzībām ekrānā var būt līdz 5 skatvietām. Tas nozīmē, ka varat salīdzināt
līdz 5 viena pacienta attēlus. Iepazīstiet skatvietu sniegtās iespējas sadaļā Darbs ar skatvietām
(Section 7.1.2).

Šī ir statusa josla, un tajā var redzēt pacienta vārdu un ārsta vārdu.

Ikonu kopa ļauj ātri piekļūt noteiktām funkcijām. Noklikšķinot uz ikonas, jūs nokļūsiet uz vajadzīgo
funkcionalitāti.

Attēlu bibliotēka satur visus konkrētā pacienta attēlus. Informāciju par pacientu var izlasīt statusa
joslā. Pacienta attēlus var apskatīt arī Statusa panelī. Sk. arī Darbs ar attēlu bibliotēku (Section
7.5.4).

Pelēko toņu korekcijas slīdnis ir viena no efektīvākajām Mediadent funkcijām. Tas ļauj ierobežot
pelēko toņu skaitu attēlā. Sk. arī Darbs ar pelēko toņu korekciju (Section 7.2.1).

Pseidokrāsas slīdnis ļauj pārvērst attēla pelēkos toņus par pseidokrāsām. Sk. arī Darbs ar
pseidokrāsām (Section 7.2.2).

Attēla Histogramma attēlo pikseļu sadalījumu. Tā parāda pikseļu daudzumu katrā pelēkajā tonī. Jūs
varēsiet uzlabot attēlus. Sk. arī Pamata darbības ar attēlu (Section 5.3).

Ekrāna apakšā redzēsiet joslu:

Josla norāda, cik liela vieta diskā ir izmantota. Ja josla ir zaļa, jums ir pietiekami daudz vietas, lai saglabātu
attēlus. Ja josla ir oranža vai sarkana , ir pienācis laiks palielināt cietā diska/servera ietilpību.

Jaunais paziņojumu centrs, kas ir integrēts apakšējā informācijas joslā ekrāna apakšā, sniedz vizuālu
palīdzību un brīdina par problēmām.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

38

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Ja viss ir kārtībā, josla ir zaļa.

Veicot dubultklikšķi uz joslas, tiks parādīts, vai ir kāda problēma.

Jūs saņemsiet pārskatu par problēmām, ja tādas ir. Vienkārša luksofora gaisma parādīs, vai problēma ir kritiska
vai nav.

Zaļa: viss ir kārtībā
Oranža: esiet uzmanīgi, jums vajadzētu pievērst uzmanību problēmai
Sarkana: kritiska kļūda

Ekrānā parādīsies problēmu apraksts.

5.2 Attēla iegūšana

Viena no Mediadent unikālajām iespējām ir tā, ka tā atbalsta lielāko daļu pasaulē vadošo rentgena un video ierīču. Lai iegūtu pārskatu
par atbalstītajām ierīcēm, apmeklējiet mūsu tīmekļa vietni www.imagelevel.com.

Ir svarīgi saprast, ka attēlu iegūšanas ekrāns var atšķirties atkarībā no izmantotās ierīces. Bieži vien tiek palaists ierīcei specifisks
attēlu iegūšanas ekrāns; sekojiet piegādātāja sniegtajām instrukcijām.

Ekrānuzņēmumos kā piemēru izmantosim "X-Ray Demo Sensor". Arī jūs varat izmantot X-Ray Demo Sensor.

Šajā sadaļā tiks izskaidroti attēla iegūšanas procesa soļi:

1. Aktīvās ierīces pārbaude
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Pirms attēla uzņemšanas ir jāpārbauda, vai ir izvēlēta pareizā ierīce. Kad tā ir izvēlēta, jūs varēsiet uzņemt attēlu ar šo ierīci.

Tas nav jāpārbauda katru reizi, kad vēlaties uzņemt attēlu. Kad ir izvēlēta pareizā ierīce, tā paliks aktīva.

Darbība Paskaidrojums

Mediadent izvēlnē
izvēlieties Opcijas > X-
Ray Acquisition

Sarakstā Options > X-Ray Acquisition atradīsiet Mediadent atbalstītās ierīces.

Lūdzu, pārliecinieties, ka atlasījāt savu attēlu iegūšanas ierīci.

Iespējams, ka redzat tikai ierobežotu ierīču sarakstu. Tas ir atkarīgs no uzstādītajiem moduļiem.

Sadaļā MediadentIestatīšana uzzināsiet vairāk par moduļiem, kurus var aktivizēt.

Ja jums ir vairāk nekā 1 ierīce attēlu uzņemšanai, varat izveidot makro, kas ļaus automātiski izvēlēties vienu no ierīcēm.

Sk. arī sadaļu Kā izveidot makro.

2. Attēla iegūšana

Darbība Paskaidrojums

1. Mediadent izvēlnē izvēlieties File>Acquire

-vai-

Ikonu kopā noklikšķiniet uz ikonas

Varat izvēlēties
izmantot Mediadent izvēlni.

Standarta Mediadent
darbvirsmas apakšējā
kreisajā stūrī redzēsiet
ikonu kopu.

  

Tiek parādīta zobu shēma
(Statuss).

Tagad varat atlasīt
zobu/zobus, kuru attēlu
vēlaties uzņemt.

Šis ekrāns var būt
atšķirīgs. Tas ir atkarīgs
no izmantotās attēlu
iegūšanas ierīces. Šajā
piemērā mēs
izmantojam X-Ray
Demo Sensor.

Tas būs atkarīgs arī no
izvēlētās darbvirsmas.
Plašāk par
darbvirsmu Mediadent
lasiet sadaļā
Darbvirsma.

Ja ir aktivizēts
pozicionēšanas palīgs, jūs
saņemsiet informāciju par to,
kā pozicionēt sensoru.

Sīkāka informācija par
pozicionēšanas palīgu
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(Section 7.3.3) ir pieejama
šeit.

2. Atlasiet zobu vai zobu, kuru attēlu vēlaties uzņemt.

Jums ir arī iespēja izvēlēties interproksimālo radiogrammu ("Bitewing").

Jums ir arī iespēja izvēlēties
interproksimālo radiogrammu
("Bitewing).

Lai iepazītos ar dažādām zobu
shēmas iespējām, izlasiet
sadaļu Darbs ar zobu shēmu.

Kad ir atlasīts pareizais
zobs/zobi vai interproksimālā
radiogramma, varat sākt attēla
uzņemšanu.

Neaizmirstiet pareizi pozicionēt pacientu vai objektu, kura attēlu vēlaties uzņemt, pirms
noklikšķināt uz pogas Grab (Uzņemt).

3. Attēlu var uzņemt, noklikšķinot uz pogas Grab attēlu iegūšanas ekrānā.

.
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Attēls parādīsies skatvietā un
attēlu bibliotēkā.

4. Kad esat pabeiguši, noklikšķiniet uz pogas Exit. Noklikšķinot uz pogas Exit,
jums tiks piedāvāts saglabāt
attēlus.

Pēc attēla uzņemšanas jums ir arī iespēja aktivizēt filtru logu. Tas ļaus izvēlēties jūsu vajadzībām piemērotāko filtru.

Noklikšķiniet uz filtru loga ikonas attēlu iegūšanas ekrānā.

 

Izlasiet šo sadaļu, lai uzzinātu, kā izmantot filtru logu: Darbs ar filtru logu (Section 7.2.9)        
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3. Attēla saglabāšana

Kad esat veikuši attēla iegūšanu un izejat no attēlu iegūšanas ekrāna, jums tiks parādīts dialoglodziņš, lai saglabātu attēlus.

Šajā dialoglodziņā jums ir iespēja arī pievienot papildu informāciju vēlākai uzziņai.

 Jūs varat pievienot šādu informāciju:

Attēla nosaukums
Info: papildu informācija par attēlu
Iestatījumi: U (kV), I(mA), t(s), DAP
TÜV: Tas nav obligāts, un to var konfigurēt tā, lai tas netiktu parādīts dialoglodziņā Save as... (Saglabāt kā...). Sazinieties ar
mums, lai iegūtu vairāk informācijas. (Section 13)
Lai sakārtotu attēlus, norādiet papildu informāciju un atslēgvārdus.

 

Attēla nosaukums.

Papildu informācija vēlākai uzziņai.

Mērījumi: tīri jūsu informācijai; tas neietekmēs attēlu vai ierīci.

"Use the default image name ("Izmantot attēla noklusējuma nosaukumu"): ja šī opcija ir atzīmēta, tiks izmantots
noklusējuma nosaukums. Lai iegūtu vairāk informācijas, skatiet sadaļu Attēla noklusējuma nosaukuma
norādīšana (Section 7.5.6).

TÜV iestatīšana: Ja šī opcija ir atzīmēta, attēls tiks bloķēts, un to vairs nevarēs mainīt/saglabāt. Dažās valstīs ir
jāizveido atsauces attēli, kurus pēc tam nedrīkst mainīt.

Attēlam var pievienot papildu informāciju un atslēgvārdus, lai vēlāk varētu to izmantot uzziņai. Skatiet arī sadaļas
Darbs ar attēlu bibliotēku (Section 7.5.4) un Papildu informācijas un atslēgvārdu norādīšana
(Section 7.5.2). Skatiet arī sadaļu par to, kā iestatīt attēla noklusējuma nosaukumu: Attēla noklusējuma
nosaukuma norādīšana (Section 7.5.6).

Save (Saglabāt) un Save All (Saglabāt visus)  attēlus attēlu bibliotēkā.

Delete (Dzēst) un Delete All (Dzēst visus)   attēlus attēlu bibliotēkā.

Iziet no ekrāna

Izvēlēties, lai mainītu dialoglodziņa novietojumu = ekrāna apakšā, vidū vai augšā.

Lai saglabātu attēlu, piešķiriet attēlam nosaukumu un aizpildiet papildu informācijas laukus, noklikšķiniet uz Save (Saglabāt) pogas.

Tomēr ir ļoti praktiski strādāt ar statusa paneli. Tas ļaus ietaupīt laiku, jo attēlu nosaukumi tiks automātiski aizpildīti (zoba/zobu
numurs), pamatojoties uz statusa panelī veikto piesaisti. Uzziniet vairāk par darbu statusa paneli tēmā: Darbs ar statusa paneli.
(Section 7.4.1)

Iespējams, ka jūsu attēlu iegūšanas process ir automatizēts.

Dažās praksēs ir vairāk nekā 1 attēlu iegūšanas ierīce, piemēram, ierīce panorāmas un cefalometriskajiem attēliem un cita ierīce
intraorālajiem attēliem.

Mediadent ir iespējams automatizēt attēlu iegūšanas procesu un izmantot funkciju taustiņus vai ikonas ikonu kopā, lai
aktivizētu pareizo ierīci konkrētam attēlam.

Aprakstu par to, kā automatizēt attēlu iegūšanas procesu, var atrast tēmā Kā izveidot makro (Section 8.7.1).
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Dažiem rentgena moduļiem ir dažas specifiskas funkcijas. Šīs funkcijas varat apskatīt šeit (Section 6.1).

5.3 Darbs ar attēliem

Mediadent piedāvā plašu rīku klāstu, ar kuriem manipulēt ar attēliem, lai tie palīdzētu jums noteikt diagnozi.

Bieži vien neapstrādāts attēls ir sliktas kvalitātes, attēli var būt pārāk gaiši vai pārāk tumši.

Var būt nepieciešams tuvināt konkrētu attēla apgabalu, lai veiktu detalizētu analīzi.

Šajā sadaļā tiks izskaidrotas pamata darbības ar attēliem.  

Bet vispirms ielādēsim attēlu skatvietā un noskaidrosim, kādas ir iespējas!

1. Darbības ar attēlu, izmantojot peli

Darbība Rezultāts

KREISĀ peles poga - Pāriet uz pilnekrāna režīmu

- Maina attēla spilgtumu un kontrastu

1. Attēla pilnekrāna skats

Veicot dubultklikšķi ar kreiso peles pogu uz attēla, jūs
varēsiet aplūkot attēlu pilnekrāna režīmā.

Lai atgrieztos, vienkārši veiciet dubultklikšķi vēlreiz, un jūs
atgriezīsieties Mediadent ekrānā.

Lai veiktu detalizētu analīzi, varat skatīt
attēlu pilnekrāna režīmā.

2. Spilgtuma un kontrasta maiņa

Nospiedietun turiet ​ KREISO peles pogu un pārvietojiet
kursoru uz attēla: uz augšu un uz leju, no kreisās uz labo pusi.

Ja attēla kvalitāte ir slikta, varat ātri mainīt
kontrastu un/vai spilgtumu.

LABĀ peles poga - Aktivizē palielināšanasrāmi

- Maina palielinājumu palielināšanas
rāmī

3. Attēla daļas palielināšana

Nospiedietunturiet ​ LABO peles pogu, lai izmantotu
palielināšanas rāmi. Varat pārvietot kursoru, vienlaikus
nospiežot un turot nospiestu peles labo pogu, varat iet uz
konkrētu apgabalu, kuru vēlaties analizēt sīkāk.

Lai detalizēti analizētu noteiktu
problēmzonu, varat aktivizēt
palielināšanas rāmi. 

Palielināšanas rāmis parādīsies, ja
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nospiedīsiet un turēsiet nospiestu
peles labo pogu.

4. Palielinājuma maiņa palielināšanas rāmī

Nospiedietunturiet ​ LABO peles pogu, lai izmantotu
palielināšanas rāmi.

Nospiežot un turot nospiestu peles LABO pogu, varat
pagriezt peles ritenīti uz augšu un uz leju.

Dažreiz palielinājums palielināšanas rāmī
nav pietiekams. Palielinājuma rāmī var veikt
tālummaiņu. Tas ļaus jums detalizēti
analizēt pacienta problēmu.

Ja vēlaties mainīt palielinājumu
palielināšanas rāmī, varat pagriezt peles
ritenīti uz augšu un uz leju, vienlaikus
nospiežot un turot nospiestu peles
LABO pogu.

2. Darbības ar attēliem, izmantojot pelēko toņu korekciju

Pelēko toņu korekcijas funkcija ir ļoti efektīva funkcija programmā Mediadent.

Tā ļaus jums uzlabot attēla kvalitāti ar vienu peles klikšķi (automātiska pelēko toņu korekcija, kas
aprakstīta attiecīgajā sadaļā).
Tā ļaus izmainīt attēlus, kas ir sliktākas kvalitātes, pārāk gaiši vai pārāk tumši.

Pelēko toņu korekcijas funkcija ļaus jums izfiltrēt pelēkos toņus, kas nav būtiski.

Histogramma parāda attēla pelēko toņu sadalījumu.

Piemēram:Ja attēls ir pārāk spilgts, redzēsiet, ka histogrammā diagrammas labajā pusē parādās smailes.
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Ekrānuzņēmumā redzams, ka labajā pusē ir smailes, kas norāda, ka attēls ir pārāk gaišs.

Aktivizējot pelēko toņu korekcijas funkciju, pelēkie toņi histogrammas kreisajā pusē nav būtiski, un tos var
atmest.

Šajā piemērā attēls ir ļoti gaišs, jo ekspozīcijas laiks ir pārāk īss.

Lai iegūtu labāku attēla kvalitāti, mēs izmantosim pelēko
toņu korekcijas lineālu.

Pelēko toņu korekcijas lineāls un
histogramma darbojas kopā.

Šajā sadaļā mēs aplūkosim šādas tēmas: 

1. Pelēko toņu korekcijas slīdņa izmantošana

Šajā piemērā mēs bīdīsim pelēko toņu korekcijas lineālu pa labi, jo histogramma norāda, ka ir būtiski pelēkie
toņi.

Vispirms novietojiet peli pēc iespējas tālāk kreisajā slīdņa stūrī.

Lai izmantotu slīdni, NOSPIEDIET un TURIET ​ kreiso peles pogu, vienlaikus velkot slīdni pa labi.
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Redzēsiet, kā attēls mainās kustības laikā.

2. Automātiskās pelēko toņu korekcijas izmantošana

Mēs esam jums vēl vairāk atvieglojuši darbu ar automātiskās pelēko toņu korekcijas funkciju.

Nospiediet ikonu pelēko toņu korekcijas lineāla labajā pusē, un Mediadentautomātiski izfiltrēs visbūtiskākos
pelēkos toņus.

3. Attēla atiestatīšana

Izmaiņas var atiestatīt, noklikšķinot uz mazās ikonas, kas atrodas pelēko toņu korekcijas lineāla kreisajā pusē.
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Jūs redzēsiet, ka attēls atgriežas sākotnējā stāvoklī.

4. Pārveidotā attēla saglabāšana

Kad attēls ir pārveidots, izmantojot pelēko toņu korekcijas funkciju, varat to saglabāt.

1. Noklikšķiniet uz ikonas Saglabāt (Save) .

2. Saglabāt kā jaunu attēlu Izvēlieties JĀ, ja vēlaties saglabāt attēla sākotnējo
versiju.

Izvēlieties NĒ, ja vēlaties aizstāt sākotnējo versiju.

Mēs izvēlēsimies saglabāt attēlu kā jaunu attēlu. Tas
nozīmē, ka tiks izveidots jauns fails.

3. Nosaukuma piešķiršana failam Ja izvēlējāties JĀ, jums tiks lūgts norādīt nosaukumu.

4. Noklikšķiniet uz Save pogas Attēls parādīsies attēlu bibliotēkā.

Šajā ekrānuzņēmumā ir parādīta atšķirība starp 2 attēliem. Kreisais attēls ir pārveidotais attēls ar pelēko toņu
korekcijas funkciju, bet labais attēls ir sākotnējais attēls.  
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5.4 Attēla saglabāšana

Kad esat veikuši attēla iegūšanu un izejat no attēlu iegūšanas ekrāna, jums tiks parādīts dialoglodziņš, lai
saglabātu attēlus.

Šajā dialoglodziņā jums ir iespēja arī pievienot papildu informāciju vēlākai uzziņai.

 Jūs varat pievienot šādu informāciju:

Attēla nosaukums
Info: papildu informācija par attēlu
Iestatījumi: U (kV), I(mA), t(s), DAP
TÜV: Tas nav obligāts, un to var konfigurēt tā, lai tas netiktu parādīts dialoglodziņā Save as... (Saglabāt
kā...). Sazinieties ar mums, lai iegūtu vairāk informācijas. (Section 13)
Lai sakārtotu attēlus, norādiet papildu informāciju un atslēgvārdus.

 

Attēla nosaukums.

Papildu informācija vēlākai uzziņai.
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Mērījumi: tīri jūsu informācijai; tas neietekmēs attēlu vai ierīci.

"Use the default image name ("Izmantot attēla noklusējuma nosaukumu"): ja šī opcija ir
atzīmēta, tiks izmantots noklusējuma nosaukums. Lai iegūtu vairāk informācijas, skatiet
sadaļu Attēla noklusējuma nosaukuma norādīšana (Section 7.5.6).

TÜV iestatīšana: Ja šī opcija ir atzīmēta, attēls tiks bloķēts, un to vairs nevarēs
mainīt/saglabāt. Dažās valstīs ir jāizveido atsauces attēli, kurus pēc tam nedrīkst mainīt.

Attēlam var pievienot papildu informāciju un atslēgvārdus, lai vēlāk varētu to izmantot
uzziņai. Skatiet arī sadaļas Darbs ar attēlu bibliotēku (Section 7.5.4) un Papildu
informācijas un atslēgvārdu norādīšana (Section 7.5.2). Skatiet arī sadaļu par to,
kā iestatīt attēla noklusējuma nosaukumu: Attēla noklusējuma nosaukuma
norādīšana (Section 7.5.6).

Save (Saglabāt) un Save All (Saglabāt visus)  attēlus attēlu bibliotēkā.

Delete (Dzēst) un Delete All (Dzēst visus)   attēlus attēlu bibliotēkā.

Iziet no ekrāna

Izvēlēties, lai mainītu dialoglodziņa novietojumu = ekrāna apakšā, vidū vai augšā.

Lai saglabātu attēlu, piešķiriet attēlam nosaukumu un aizpildiet papildu informācijas laukus, noklikšķiniet uz
Save (Saglabāt) pogas.

Tomēr ir ļoti praktiski strādāt ar statusa paneli. Tas ļaus ietaupīt laiku, jo attēlu nosaukumi tiks
automātiski aizpildīti (zoba/zobu numurs), pamatojoties uz statusa panelī veikto piesaisti. Uzziniet vairāk
par darbu statusa paneli tēmā: Darbs ar statusa paneli. (Section 7.4.1)

5.5 Attēlu drukāšana

Attēlu drukāšana ir viens no vienkāršākajiem veidiem, kā kopīgot attēlus ar kolēģiem vai pacientiem.

Programmā Mediadent veiciet šādas darbības:

1. Izvēlieties pacientu, kuram vēlaties izdrukāt attēlus

2. Izvēlieties ikonu Print ikonu kopā

 

-vai-

Mediadent izvēlnē izvēlieties File>Print
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1. Drukāšanas moduļa pārskats

Atkarībā no izvēlētās darbvirsmas statusa panelī un pacienta bibliotēkā redzēsiet šī pacienta attēlus.

Ekrāna elementi

 Statusa panelis
Parāda attēlus statusa panelī.

 Attēlu bibliotēka
Visi attēli, kas uzņemti konkrētajam pacientam, tiks sakārtoti šī pacienta
bibliotēkā. Jūs redzēsiet apakšmapes. Izvēlieties kādu no apakšmapēm, ja
vēlaties izdrukāt kādu no attēliem.

Statusa panelis un Attēlu bibliotēka ir dažādi veidi, kā sakārtot pacienta
attēlus. Drukāšanas modulī redzēsiet abas šīs bibliotēkas, un varat izvēlēties
attēlus no abām bibliotēkām.
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 Papildu lauki, kurus varat pielāgot
Jūs varat mainīt pacienta vārdu, datumu un ārsta vārdu.

Ja vēlaties, varat pievienot papildu komentārus.

 Izvades ekrāns
Šajā daļā tiek parādīts attēlu izkārtojums uz papīra. Šajā piemērā
redzams, ka tiks izdrukāti 6 attēli.

Vienkārši veiciet dubultklikšķi uz attēla, un tas parādīsies vienā no izvades
ekrāna lodziņiem

Šajā piemērā mums ir iespēja pievienot 6 attēlus 1 lapā.

To var mainīt, pielāgojot opciju Attēlu skaits vienā lappusē (Pics/Page) .

 Poga Clear (Notīrīt)
​ Poga Clear (Notīrīt) notīra visus attēlus lapā

 Poga Del (Dzēst)
​ Poga Del (Dzēst) dzēš attēlu, kas atlasīts izvades ekrānā.

 Borders (Apmales)
Fixed (Fiksētas)

Smart (Gudras)

 Anotācijas
Izvēloties šo opciju, uz attēla tiks izdrukātas anotācijas.

 Pics/Page (Attēli/lapa)
Izvēloties opciju Pics/Page (Attēli/lapa), varēsiet izvēlēties attēlu skaitu
vienā lapā (1, 2, 3 vai 6 attēli).
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 Copies (Eksemplāri)
Izvēlieties eksemplāru skaitu, ko vēlaties izdrukāt

 Poga Print (Drukāt)
​ Poga Print (Drukāt) uzsāk drukāšanu jūsu printerī.

 Setup Printer (Printera iestatīšana)
Ja vēlaties mainīt printera iestatījumus, piemēram, mainīt papīra
izmēru vai orientāciju, varat izvēlēties pogu "Setup Printer" (Printera
iestatīšana).

 Exit (Iziet)
​ Ar pogu Exit (Iziet) iziet no drukāšanas moduļa.

2. Drukājamo attēlu atlase

Ja vēlaties drukāt attēlu, vienkārši veiciet dubultklikšķi uz tā, un tas parādīsies izvades ekrānā.

Attēla nosaukums tiks parādīts kā uzraksts lapā.

PIRMS atlasāt drukājamos attēlus, izvēlieties attēlu skaitu, ko drukāsiet vienā lapā.

Ja vispirms atlasīsiet attēlus un pēc tam mainīsiet attēlu skaitu lapā, zaudēsiet atlasītos attēlus.

Darbība Paskaidrojums un rezultāts

1. Veiciet dubultklikšķi uz attēla no Statusa paneļa Veicot dubultklikšķi uz attēla, tas tiks
ielādēts izvades ekrānā.

2. Veiciet dubultklikšķi uz cita attēla.

3. Noklikšķiniet uz apakšmapes "ortho" attēlu bibliotēkā.  Izvēlieties citu apakšmapi, piemēram,
"ortho folder.
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4. Veiciet dubultklikšķi uz attēla, kas atrodas mapē "ortho".

Izmantojot papildu Reporter moduli, varat izveidot standarta dokumentus, piemēram, nosūtījuma dokumentus, un pievienot pacienta
attēlus un informāciju. Lai iegūtu vairāk informācijas, izlasiet tēmu Darbs ar Reporter moduli (Section 7.6.1).

Ja jums ir problēmas ar visu šo elementu skatīšanu uz ekrāna, iespējams, būtu jāapsver iespēja izvēlēties citu darbvirsmu, kas ir labāk
piemērota jūsu ekrānam. Izlasiet tēmu Citas darbvirsmas ielādēšana (Section 8.2.7).
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6 Modulim/ierīcei specifiskas funkcijas
 

6.1 X-ray Morita PDC

Attēlu izgūšana
Mediadent ļauj izgūt iepriekš iegūtos attēlus, izmantojot rentgena moduli: X-ray Morita PDC.

1. Atveriet X-ray
Morita PDC moduli.

2. Noklikšķiniet uz
File > Reload Image.

3. Izvēlieties datuma
diapazonu no attēla,
kuru vēlaties izgūt.

4. Nospiediet "Search
images".
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5. Sarakstā izvēlieties
attēlu, kuru vēlaties
izgūt.

6. Nospiediet
"Reload".

 7. Pēc pieprasījuma
izslēdziet Morita ierīci
un noklikšķiniet uz
OK.

8. Dialoglodziņā tiek
parādīts, ka tiks
atvērts Morita
interfeiss.
Noklikšķiniet uz OK.
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9. Morita interfeisā
noklikšķiniet uz
"Reload".

10. Aizveriet Morita interfeisu. Tagad attēls tiks ielādēts Mediadent.

Attēlus var izgūt tikai no datora, kurā tika uzņemti attēli.

6.2 X-Ray VDX

Atkārtota filtra lietošana uzņemtajiem attēliem
Mediadent ļauj atkārtoti lietot citus filtrus pēc tā paša attēla iegūšanas, sniedzot iespēju iegūt labāku kopējo attēlu
atbilstoši diagnozes tipam.

Tas pats attēls tiek atkārtoti lietots, un objektam/pacientam nav atkārtoti jālieto rentgena starojuma doza!

1. Atveriet X-ray
VDX moduli.

2. Iegūstiet attēlu ar
sensoru.

3. Noklikšķiniet uz
"Filters" ekrāna
augšējā kreisajā
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pusē.

Ja šī opcija ir pelēkota, tas nozīmē, ka sensors joprojām ir ieslēgts. Lai izslēgtu sensoru, nospiediet
taustiņu "ESC" uz tastatūras.

4. No saraksta
atlasiet filtru, kuru
vēlaties atkārtoti
izmantot
pašreizējam
attēlam.
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5. Tas pats attēls
tiek parādīts
Mediadent skatvietā
ar lietotajiem
jaunajiem filtriem.

Jūs varat atkārtot 3. un 4. darbību, cik vien reizes vēlaties, izmantojot vienu un to pašu iegūto attēlu.

6.3 X-Ray Athlos

Moduļa specifiskās īpašības
Mediadent ļauj izmantot Bluetooth intraorālos sensorus: Optimum Air/DC-Air

Šiem konkrētajiem ierīcēm ir 3 svarīgas funkcijas, kas tiek rādītas statusa joslā:

- Sensora Bluetooth signāla stiprums

- Sensora baterijas līmenis

- Ekspozīcijas līmenis

 

1. Ievadiet
rentgena Athlos
moduli

2.
Indikatori statusa
joslā:
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 2.1.  Bluetooth
signāls

 

 2.2.  Baterijas
līmenis

 
3. Ekspozīcijas
līmenis

 

 

 

Ir 4 diapazoni, balstoties uz ražotāja norādītajām ieteicamajām mediānas vērtībām ekspozīcijas laikā.

Sarkans:  Nepieņemams ekspozīcijas līmenis, diagnostiskā kvalitāte nav pietiekama.
Dzeltens:  Minimālais ekspozīcijas līmenis diagnostiskajam attēlam.
Zaļš:  Pieņemams ekspozīcijas līmenis, apmierinoši diagnostiskie attēli.
Gaiši zils: : Izcila kvalitāte.

Sekojošais simbols uz baterijas norāda, ka sensors ir ievietots un uzlādējas:

 

6.4 X-ray Trident

Atgūt pēdējo attēlu ar X-View
Mediadent ļauj atgūt iepriekš iegūto attēlu, izmantojot rentgena moduli: X-ray Trident.

1. Ievadiet rentgena
moduli Trident.

2. Noklikšķiniet uz
Fails > Iegūt pēdējo
attēlu (XView)

 

Attēlus var atgūt tikai datorā, kurā tie tika uzņemti.

6.5 X-Ray MDP

Moduļa specifiskās iezīmes
Mediadent ļauj izmantot MDP sensoru, izmantojot MDP moduli.

Ekspozīcijas perioda progresijas joslas indikācija:
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Kā lietotājs, jūs varēsiet redzēt, kad sensors ir gatavs ekspozīcijai, ļaujot jums iegūt attēlu īstajā brīdī.

Programmatūra parāda progresijas joslu, kas vizuāli norāda sensora gatavību ekspozīcijai. Krāsas attēlo
šādus statusus:

Zaļš: Sensors ir gatavs ekspozīcijai.
Dzeltens: Sensors uzsilst; gatavojieties ekspozīcijai.
Sarkans: Sensors nav gatavs; lūdzu, uzgaidiet.

 

Ekspozīcijas laika konfigurācija:

MDP moduļa iestatījumos ekspozīcijas laiku var konfigurēt līdz maksimālajam 10 min. Tas nodrošina, ka
neviena ekspozīcijas laika konfigurācija nepārsniedz sensora specifikācijās noteikto maksimālo ierobežojumu.

 

6.6 X-Ray iRay Technology

Pievienot kalibrēšanas failus
Pēc draiveru instalēšanas un sensora konfigurēšanas iRay iestatījumos, jums manuāli jākopē kalibrēšanas faili uz
sensora mapi:

Mediadent\Devices\iRayTechnology\<sensora numurs>\Correct\Default\
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7 Darbs ar Mediadent
 

7.1 Darbs ar Mediadent ekrānu

7.1.1 Attēlu direktorija eksportēšanas ekrāna pārskats

Attēlu direktorija eksportēšanas ekrāns
Attēlu direktorija eksportēšanas ekrāns ir dialoglodziņš, ko izmanto, lai atlasītu attēlus, kas jāeksportē noteiktā
formātā un uz konkrētu mapi (mērķa mapi).

Šo opciju izmanto arī attēlu nosūtīšanai pa e-pastu.

Attēlu bibliotēkā tiek parādīti attēli, kas uzņemti atlasītajam pacientam.

Pogas, lai attēlus pievienotu eksportējamo attēlusarakstam 

- Poga "Add" (Pievienot) : Atlasiet attēlu un noklikšķiniet uz Add (Pievienot) vai noklikšķiniet ar
LABO peles pogu uz attēla.

- Poga "Add all" (Pievienot visus) : Pievieno visus attēlus no atlasītās mapes pacienta attēlu
bibliotēkā

- "Add all + sub folders" (Pievienot visus + apakšmapes) : Pievieno visus attēlus no pacienta
attēlu bibliotēkas (ieskaitot attēlus apakšmapēs).

- "Remove from list" (Noņemt no saraksta) : Will Noņem atlasīto attēlu no eksportējamo attēlu
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saraksta.

Eksportējamo failu sarakstā ir atlasītie attēli, kurus vēlaties eksportēt vai nosūtīt pa e-pastu.

Destination folder (Mērķa mape) ir mape, uz kuru eksportēsiet failus.

​ Poga "Estimate" (Novērtēt) ir praktiska, jo tā aprēķina eksportējamo vai pa e-pastu nosūtāmo
attēlu failu skaitu, avota lielumu, galamērķa lielumu, saspiešanu, mapi un failu. Šī informācija tiks

parādīta Info lodziņā .

​ "Export" (Eksportēt) poga faktiski eksportē attēlus uz mērķa mapi.

​ E-pasta poga palaiž jūsu e-pasta programmu un pievieno attēlus jaunam e-pasta ziņojumam.
Jums tikai jāpievieno adresātu vārdi, un attēli tiks nosūtīti.

​ Exit (Iziet) poga aizver dialoglodziņu.

Neizejiet, pirms visi faili ir eksportēti, jo tas pārtrauks eksportēšanas procedūru.

Skatvieta ļauj apskatīt attēlus pirms to atlasīšanas eksportēšanai vai nosūtīšanai pa e-pastu.

Veiciet dubultklikšķi uz attēla, un tas tiks ielādēts skatvietā.

Lodziņā Export File Type (Eksporta faila veids) var izvēlēties faila veidu, uz kuru eksportēt failus.
Sīkāku informāciju par dažādiem failu veidiem, uz kuriem var eksportēt, skatiet tēmā"Eksporta faila
veidi" ('Eksporta failu veidi' in the on-line documentation).

Svarīgi ņemt vērā, ka, jo augstāka ir kvalitāte, jo lielāki kļūst attēlu faili. Dažās e-pasta
programmās ir ierobežots nosūtāmo failu lielums.  Ja attēlu faili ir pārāk lieli, e-pasta programma
attēlus nenosūtīs.

Info lodziņā tiek sniegta noderīga informācija, piemēram eksportējamo vai pa e-pastu nosūtāmo
attēlu failu skaits, avota lielums, galamērķa lielums, saspiešana, mape un fails.

Info lodziņa apakšdaļā esošajā zaļajā joslā ir redzams arī eksportēšanas progress.

Noklikšķinot uz šīs pogas, varat izvēlēties citu mērķa mapi.

7.1.2 Darbs ar skatvietām

Šajā sadaļā mēs izskaidrosim, kā ielādēt attēlu skatvietā.

1. Lai attēlu ielādētu skatvietā, vispirms ir jāaktivizē skatvieta, noklikšķinot ar peles kreiso pogu skatvietas

apgabalā .

Aktīvā skatvieta ir iezīmēta ar rāmi (šajā ekrānuzņēmumā rāmis ir dzeltens). 
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2.  Pēc tam ir jāveic dubultklikšķis uz attēla attēlu bibliotēkā , un attēls tiks ielādēts atlasītajā skatvietā.

 

Tagad attēls ir gatavs analīzei.

7.1.3 Darbs ar darbvirsmām

Šajā sadaļā mēs izskaidrosim, kas ir Mediadentdarbvirsma un kā var ielādēt citu darbvirsmu, lai tā labāk atbilstu jūsu vajadzībām.

Pieredzējušiem lietotājiem izskaidrosim, kā konfigurēt jaunu darbvirsmu.
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Jums ir arī iespēja dzēst jūsu izveidoto darbvirsmu.

Mēs izskaidrosim šādas tēmas:

1. Pārskats par Mediadent Darbvirsmu

Darbvirsma ir veids, kādā ekrānā tiek attēloti dažādi ekrāna elementi, piemēram, skatvietas, ikonu kopa, attēlu bibliotēka u.c.

Darbvirsma nosaka:

Cik daudzas Viewports <STRONG>Viewport </STRONG>is a region to which you can load an <STRONG>image </STRONG>for
analysis purposes. Loading an image can be done by first <STRONG>activating </STRONG>the Viewport. To activate a Viewport you
have to select it by clicking in the region with your left mouse button. Once the Viewport is activated you will see that it changes color
(dark grey). Now you can <STRONG>double click </STRONG> uz attēla, un tas tiks ielādēts skatvietā.  ir redzamas.
Kāda ir ikonu kopas pozīcija
Kur atrodas attēlu bibliotēka
Vai un kur ir novietota histogramma
Vai un kur ir novietota spilgtuma/kontrasta josla

Īsāk sakot, tā nosaka jūsu darbvirsmas izskatu programmā Mediadent.

Vairāk par dažādiem darbvirsmas elementiem lasiet tēmā par ekrāna elementiem (Section 5.1).

Viens Mediadent standarta darbvirsmas piemērs:

 

 
Svarīgi saprast, ka darbvirsma ir saistīta arī ar jūsu ekrāna izšķirtspēju. Mainot ekrānu vai ekrāna izšķirtspēju, var būt nepieciešams ielādēt
citu darbvirsmu vai izveidot savu darbvirsmu.

               

2. Kā ielādēt citu darbvirsmu

Ielādētā darbvirsma ir  Mediadentekrāna izkārtojums, kas ir konfigurēts atbilstoši jūsu monitora izmēram un izšķirtspējai.

Tajā būs redzami visi dažādie Mediadent ekrāna elementi.

Lai uzzinātu vairāk par darbvirsmu, izlasiet sadaļu Darbvirsma (Section 12.2).

Ja jūs neapmierina pašreizējā Mediadent ekrāna konfigurācija, varat ielādēt citu darbvirsmu.

Ņemiet vērā, ka, ielādējot darbvirsmu, kas neatbilst jūsu monitoram, daži Mediadent ekrāna elementi pazudīs no jūsu ekrāna.

Piemēram, izvēloties darbvirsmu, kas ir piemērota platākam monitoram, Mediadent ekrāna elementi (piemēram, pelēko toņu korekcija,
histogramma u.c.), kas atrodas labajā pusē, netiks parādīti mazākā monitorā.

1.  Mediadent izvēlnē izvēlieties Display > Desktop Panels > Load desktop

Tiks parādīts pieejamo noklusējuma darbvirsmu saraksts. Šīs darbvirsmas ir saistītas ar jūsu ekrāna izšķirtspēju.

2. Noklikšķiniet uz darbvirsmas, kuru vēlaties ielādēt
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Parādīsies sākotnēji instalēto darbvirsmu saraksts. Norādītie nosaukumi ir aktuālākās ekrāna izšķirtspējas. Atkarībā no ekrāna veida jums būs
iespēja izvēlēties vienu no darbvirsmām.

Darbvirsma "1024x767" nozīmē, ka Mediadent darbvirsma tiks rādīta jūsu monitorā ar izšķirtspēju 1024 pikseļi (platums) × 768 pikseļi
(augstums).

Ja aktivizējat kādu no noklusējuma darbvirsmām, iespējams, jūsu darbvirsma var nebūt optimizēta. Piemēram, jūsu ekrānā vēl var būt palikusi
vieta, kas netiek izmantota.

 Ja darbvirsma nav optimizēta, ir 2 opcijas, ko varat izmantot, lai optimizētu darbvirsmu: 

1. Pēc tam, kad esat ielādējuši vienu no noklusējuma darbvirsmām un tā jūs neapmierina, varat izvēlēties opciju Display>Desktop
Panels>Autoset desktop  Mediadent izvēlnē.

Šī opcija izmantos optimālāko noklusējuma darbvirsmu.

2. Ja vēl ir iespējami uzlabojumi, izvēlieties Display>Desktop Panels>Fit this desktop to screen
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Kad darbvirsma jūs apmierina, tā ir jāsaglabā.

Lai saglabātu pielāgoto darbvirsmu, izvēlieties Display>Desktop Panels>Save desktop as ...

Piešķiriet darbvirsmai nosaukumu, šajā gadījumā "adapted". Šī darbvirsma būs aktīva, kad nākamreiz palaidīsiet programmu.
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Izvēloties optimizēto darbvirsmu, jūs maksimāli izmantosiet sava monitora izšķirtspēju.

Kad esat izveidojuši ideālo darbvirsmu, iespējams, vēlēsieties automātiski izveidot visus darbvirsmas, pamatojoties uz šo ideālo darbvirsmu.

To var izdarīt, izmantojot šādu opciju: Display>Desktop Panels>Auto create desktop (all presets) from current

Tas automātiski izveidos visas darbvirsmas (1. skatvietu, 2. skatvietu, 3. skatvietu...), pamatojoties uz šo ideālo darbvirsmu. Tātad, ja pēc tam
pārslēgsieties uz citu darbvirsmu, jo, piemēram, vēlaties redzēt vairāk skatvietu, darbvirsma jau būs optimizēta.

3. Darbvirsmas konfigurēšana

Darbvirsma ir veids, kādā ekrānā tiek attēloti dažādi  Mediadent elementi.

Priekšrocība ir tā, ka varat mainīt dažādu ekrāna elementu izkārtojumu atbilstoši jūsu darba specifikai.

Ja vēlaties izmainīt darbvirsmu, vispirms ir jāzina, kā aktivizēt/deaktivizēt noteiktu ekrāna elementu.

Pēc aktivizēšanas varat pārvietot ekrāna elementus vai pat mainīt to lielumu atbilstoši savām vajadzībām.

Lai mainītu darbvirsmu, ir jāveic šādas darbības:
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1. Ekrāna elementu aktivizēšana/deaktivizēšana

2. Darbvirsmas atbloķēšana

3. Elementu pārvietošana vai lieluma maiņa

4. Darbvirsmas bloķēšana

5. Darbvirsmas saglabāšana

Vispirms izlasiet sadaļu Pārskats par Mediadent ekrāna elementiem (on-line documentation), lai labāk izprastu dažādos ekrāna
elementus.

1. Mediadent ekrāna elementu aktivizēšana/deaktivizēšana

Aktivizējot ekrāna elementu, šis elements būs redzams.

Lai aktivizētu elementu

Display > Desktop Panels > atlasiet deaktivizēto elementu

Piezīme: pārliecinieties, vai  zīme ir pirms opcijas

vai noklikšķiniet uz atbilstošās ikonas ikonu kopā, lai aktivizētu elementu.

Lai deaktivizētu elementu, izvēlieties

Display > Desktop Panels > atlasiet aktīvo elementu

Piezīme: pārliecinieties, ka   zīme NAV pirms opcijas

vai noklikšķiniet uz atbilstošās ikonas ikonu kopā, lai deaktivizētu elementu.

2. Ekrāna izkārtojuma maiņa un saglabāšana

Kad esat izvēlējušies ekrāna elementus, kurus vēlaties aktivizēt, jums ir iespēja tos pārvietot uz citu ekrāna vietu.

Lai mainītu darbvirsmu un to saglabātu, ir jāveic šādas darbības:

Darbība Paskaidrojums

1. Darbvirsmas atbloķēšana

1. Vienmēr vispirms atbloķējiet darbvirsmu

Display > Desktop Panels > Lock desktop Piezīme: pārliecinieties, ka pirms opcijas nav zīme  .

Pirms izmaiņu veikšanas vienmēr atbloķējiet darbvirsmu.

Darbvirsma ir atbloķēta, ja ekrāna elementa
kreisajāaugšējā stūrī un labajā apakšējā stūrī ir
pieejami turi.

2. Mediadent ekrāna elementu pārvietošana un/vai lieluma maiņa

2. Ekrāna elementi ir brīvi, un tos var pārvietot uz citu ekrāna vietu vai mainīt to
lielumu, lai parādītu visas opcijas. 

Pārvietojiet ekrāna elementus uz citu vietu, velkot un
nometot elementus, izmantojot turus, kas atrodas
elementa kreisajā augšējā stūrī .

Mainiet ekrāna elementu lielumu, izmantojot turi,
kas atrodas labajā apakšējā stūrī.

3. Darbvirsmas bloķēšana

3. Ja rezultāts jūs apmierina, darbvirsma ir jānobloķē.

Display > Desktop Panels > Lock Desktop Piezīme:    zīmei izvēlnē jāatrodas pirms opcijas.

4. Darbvirsmas saglabāšana

Display>Desktop Panels>Save desktop as … Parādīsies sākotnēji instalēto darbvirsmu saraksts
(atzīmētas ar *). Tās nevar mainīt.
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5. Ierakstiet atpazīstamu darbvirsmas nosaukumu lauciņā "Save current
desktop as:" (Saglabāt pašreizējo darbvirsmu kā).

6. Noklikšķiniet uz    , lai apstiprinātu.

Pēc darbvirsmas saglabāšanas to varēsiet atlasīt,
izmantojot Display > Desktop Panels>Load
Desktop

Noklikšķiniet uz šī virsraksta, lai apskatītu piemērus

Darbība Paskaidrojums

Kā aprakstīts iepriekš, atbloķējiet darbvirsmu .

Mēs deaktivizēsim Kontrasta/intensitātes kombināciju.

Mediadent izvēlnē izvēlieties

Display > Desktop Panels > noņemiet atlasi vienam elementam

Piemēram: Contrast/Intensity combo (Kontrasta/intensitātes
kombinācija)

Ekrāna elements vairs nav redzams.

Piezīme: pārliecinieties, ka pirms opcijas Contrast/Intensity combo

nav zīme    .

Papildu skatvietas pievienošana

Mediadent izvēlnē izvēlieties

Ņemiet vērā, ka aktivizētās skatvietas parādīsies zem esošajām
skatvietām. Ja darbvirsma ir atbloķēta, jūs varēsiet pārvietot
skatvietas uz citu vietu, un redzēsiet, ka parādās jaunas aktivizētās
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Display > ViewPort un atlasiet skatvietu, kuru vēlaties aktivizēt.

Šajā piemērā mēs vēlamies redzēt 3 skatvietas.

skatvietas.

Šajā piemērā 3. skatvieta bija zem 1. skatvietas. Pārvietojot 1.
skatvietu, jūs redzēsiet 3. skatvietu.

Tagad varat izvietot 3 skatvietas. Skatiet sadaļu Jauni darbvirsmas
izveides un modificēšanas rīki Mediadent versijā 8 (Section
4.3).

.

Kā aprakstīts iepriekš, bloķējiet darbvirsmu un saglabājiet to. .

3. Jauni papildu rīki, lai izveidotu vai modificētu darbvirsmu

Šajā jaunākajā versijā ir daudz kas pievienots, lai uzlabotu darbvirsmu izveidi programmā.

Lai saprastu, kas ir darbvirsma, vispirms izlasiet šo sadaļu:  Darbvirsma (Section 12.2) 

Šajā sadaļā mēs izskaidrosim papildu rīkus, kas jums ir pieejami, lai modificētu darbvirsmu.

1. Darbvirsmas paneļa opciju aktivizēšana

Izvēlnē izvēlieties Display > Desktop Panels > Position/size controls
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2. Pārskats par rīklodziņa ikonām un piemēri

Ikona Paskaidrojums

Šīs ir vadīklas, kas nosaka rīklodziņa pozīciju. Opcijas ir pa kreisi, pa labi, augšā un apakšā. Rīklodziņu var arī
vilkt un nomest manuāli.

Snap to grid (Fiksēt pie režģa): ja ikona spīd sarkanā krāsā, ekrāna elementi tiks fiksēti pie režģa. To var
deaktivizēt, noklikšķinot uz ikonas.

Align to grid (Līdzināt pie režģa): šī funkcija ļauj ekrāna elementus līdzināt pie režģa.

Ekrāna elementu līdzināšana.

Līdzināt pa kreisi, līdzināt pa labi, līdzināt uz augšu, līdzināt uz apakšu.

Līdzināšana tiek veikta attiecībā pret pirmo atlasīto lodziņu.

Piemērs: līdzināšana uz augšu

Atlasiet pirmo lodziņu 

Atlasiet otro lodziņu ar Ctrl un noklikšķiniet uz otrā lodziņa

Noklikšķiniet uz ikonas "līdzināt uz augšu" (align top) 
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 Rezultāts:

Līdzināšana blakus vai viens virs otra.

Piemērs: līdzināšana blakus viens otram.

Atlasiet pirmo lodziņu un atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl .

Noklikšķiniet uz ikonas  , lai novietotu 2 lodziņus vienu otram blakus.
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Rezultāts: 2 lodziņi ir novietoti viens otram blakus.

Vienāds lielums

Šī opcija ļauj izveidot vienāda lieluma ekrāna elementus.

Pirmais atlasītais lodziņš noteiks otra atlasītā lodziņa lielumu.

Atlasiet pirmo lodziņu, kuram ir vēlamais lielums.

Atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl.
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Noklikšķiniet uz ikonas 

Rezultāts: Otrais lodziņš ir tāda paša lieluma kā pirmais lodziņš.

 

4. Darbvirsmas dzēšana

Monitora maiņa bieži ir iemesls, lai dzēstu iepriekš izveidoto darbvirsmu ar citu ekrāna konfigurāciju.

Lai dzēstu darbvirsmu, izpildiet šādas darbības

1. Display>Desktop Panels>Save desktop as ...
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2. Sarakstā atlasiet darbvirsmu, kuru vēlaties dzēst. Šajā piemērā mēs izvēlamies darbvirsmu "test".

3. Noklikšķiniet uz Delete (Dzēst) pogas.

Pārliecinieties, ka darbvirsma, kuru vēlaties dzēst, nav aktīva.

7.2 Darbs ar attēliem

Šajā sadaļā jūs uzzināsiet, kādas darbības varat veikt ar attēlu, lai atbalstītu diagnostiku, ārstēšanas plānošanu un
turpmāko uzraudzību.

Mēs sāksim ar pamata darbībām. Šis ir lielisks sākumpunkts, ja tikko esat sākuši lietot Mediadent.
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Pēc tam, ja vēlaties, jūs varat pievērsieties konkrētām tēmām.

Lielisks pārskats:

1. Pamata darbības ar attēliem (Section 5.3)

Sīkāka informācija par darbu ar dažādām funkcijām

2. Darbs ar pelēko toņu korekciju (Section 7.2.1)

3. Darbs ar pseidokrāsām (Section 7.2.2)

4. Darbs ar tālummaiņas logu (Section 7.2.4)

5. Darbs ar anotācijām (Section 7.2.3)

6. Darbs ar interešu reģioniem (Section 7.2.5)

Papildu darbības ar attēliem:

7. Darbs ar optimizācijas funkciju (Section 7.2.7)

8. Darbs ar filtriem (Section 7.2.6)

9. Darbs ar filtru logu (Section 7.2.9)

7.2.1 Darbs ar pelēko toņu korekciju

Pelēko toņu korekcijas funkcija ir ļoti efektīva funkcija programmā Mediadent.

Tā ļaus jums uzlabot attēla kvalitāti ar vienu peles klikšķi (automātiska pelēko toņu korekcija, kas
aprakstīta attiecīgajā sadaļā).
Tā ļaus izmainīt attēlus, kas ir sliktākas kvalitātes, pārāk gaiši vai pārāk tumši.

Pelēko toņu korekcijas funkcija ļaus jums izfiltrēt pelēkos toņus, kas nav būtiski.

Histogramma parāda attēla pelēko toņu sadalījumu.

Piemēram:Ja attēls ir pārāk spilgts, redzēsiet, ka histogrammā diagrammas labajā pusē parādās smailes.

Ekrānuzņēmumā redzams, ka labajā pusē ir smailes, kas norāda, ka attēls ir pārāk gaišs.

Aktivizējot pelēko toņu korekcijas funkciju, pelēkie toņi histogrammas kreisajā pusē nav būtiski, un tos var
atmest.

Šajā piemērā attēls ir ļoti gaišs, jo ekspozīcijas laiks ir pārāk īss.
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Lai iegūtu labāku attēla kvalitāti, mēs izmantosim pelēko
toņu korekcijas lineālu.

Pelēko toņu korekcijas lineāls un
histogramma darbojas kopā.

Šajā sadaļā mēs aplūkosim šādas tēmas: 

1. Pelēko toņu korekcijas slīdņa izmantošana

Šajā piemērā mēs bīdīsim pelēko toņu korekcijas lineālu pa labi, jo histogramma norāda, ka ir būtiski pelēkie
toņi.

Vispirms novietojiet peli pēc iespējas tālāk kreisajā slīdņa stūrī.

Lai izmantotu slīdni, NOSPIEDIET un TURIET ​ kreiso peles pogu, vienlaikus velkot slīdni pa labi.

Redzēsiet, kā attēls mainās kustības laikā.
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2. Automātiskās pelēko toņu korekcijas izmantošana

Mēs esam jums vēl vairāk atvieglojuši darbu ar automātiskās pelēko toņu korekcijas funkciju.

Nospiediet ikonu pelēko toņu korekcijas lineāla labajā pusē, un Mediadentautomātiski izfiltrēs visbūtiskākos
pelēkos toņus.

3. Attēla atiestatīšana

Izmaiņas var atiestatīt, noklikšķinot uz mazās ikonas, kas atrodas pelēko toņu korekcijas lineāla kreisajā pusē.

Jūs redzēsiet, ka attēls atgriežas sākotnējā stāvoklī.

4. Pārveidotā attēla saglabāšana

Kad attēls ir pārveidots, izmantojot pelēko toņu korekcijas funkciju, varat to saglabāt.

1. Noklikšķiniet uz ikonas Saglabāt (Save) .

2. Saglabāt kā jaunu attēlu Izvēlieties JĀ, ja vēlaties saglabāt attēla sākotnējo
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versiju.

Izvēlieties NĒ, ja vēlaties aizstāt sākotnējo versiju.

Mēs izvēlēsimies saglabāt attēlu kā jaunu attēlu. Tas
nozīmē, ka tiks izveidots jauns fails.

3. Nosaukuma piešķiršana failam Ja izvēlējāties JĀ, jums tiks lūgts norādīt nosaukumu.

4. Noklikšķiniet uz Save pogas Attēls parādīsies attēlu bibliotēkā.

Šajā ekrānuzņēmumā ir parādīta atšķirība starp 2 attēliem. Kreisais attēls ir pārveidotais attēls ar pelēko toņu
korekcijas funkciju, bet labais attēls ir sākotnējais attēls.  

 

 

7.2.2 Darbs ar pseidokrāsām

Pseidokrāsas var izmantot, ja vēlaties ļoti detalizēti analizēt pacientu attēlus.

Tas palīdz vizualizēt, piemēram, plaisas zobā, jo jūs redzēsiet zoba plaisu atšķirīgi iekrāsotu.

Izmantojot pseidokrāsas, pelēkie toņi tiek pārveidoti par pseidokrāsām, lai jūs redzētu blīvuma atšķirības
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Lai izmantotu pseidokrāsas, veiciet šādas darbības.

Darbība Paskaidrojums

1. Atlasiet attēlu skatvietā Attēls skatvietā.

2. Izmantojiet pseidokrāsu slīdni Bīdot slīdni pa labi, tiek
iekrāsoti pelēkie toņi
histogrammas kreisajā
pusē.
Bīdot slīdni pa kreisi, tiek
iekrāsoti pelēkie toņi
histogrammas labajā pusē.

3. Slīdņa bīdīšana pa labi Šajā piemērā mēs slīdni
bīdīsim pa labi.

4. Rezultāts Redzēsiet pelēkos toņus,
kas pārveidoti
pseidokrāsās.

5. Lai atiestatītu, noklikšķiniet uz mazās ikonas
slīdņa kreisajā pusē.

Tas atjaunos attēla
sākotnējo stāvokli.
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7.2.3 Darbs ar anotācijām

Anotācijas var būt svarīgs analīzes rīks.

Pievienojot anotācijas, varat sniegt pacientiem papildu informāciju vai norādīt kolēģiem uz problēmzonām.

Svarīgi ir saprast, ka anotācijas atrodas slānī virs jūsu attēla. Tas neietekmēs sākotnējo attēlu.

Varat pievienot dažāda veida anotācijas:

- Vienkāršas anotācijas (cilne Anotācijas)

- mērījumu anotācijas (cilne Mērījumi)

- Implanti (atsevišķs modulis)

Anotācijas var saglabāt, izdrukāt un nosūtīt pa e-pastu.

 

Jaunākajā programmatūras versijā anotāciju rīklodziņš ir pieejams vienmēr.

Tā atrodas blakus skatvietai labajā pusē. Jums ir iespēja mainīt veidu, kādā tiek parādīts anotāciju rīklodziņš.

Ja anotāciju lodziņš nav pareizi novietots uz ekrāna, izlasiet sadaļu Kā pārvietot tālummaiņas logu (Section 8.2.8) un
uzziniet, kā pārvietot anotāciju lodziņu.

Anotāciju dialoglodziņa darbības maiņa
 Dodieties uz Options > Setup

Vispārīgajos iestatījumos (General settings) izvēlieties cilni Display Settings > Viewport Settings

Loziņā: Annotations. Choose the way of working jums ir iespēja vienmēr rādīt anotāciju rīklodziņu vai pārslēgt (tas nozīmē manuāli
izvēlēties aktivizēt anotāciju rīklodziņu).
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Anotāciju izmantošana

Lai aktivizētu ​ anotācijas, noklikšķiniet uz ikonas   ikonu kopā.

Kad esat saglabājuši attēlu ar anotācijām, redzēsiet mazu, zaļu joslu virs attēla.

1. Pārskats par anotāciju dialoglodziņu

Šajā tēmā ir sniegts vispārējs pārskats par dažādiem Anotāciju dialoglodziņa elementiem.
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Anotāciju un mērījumu cilne: Tā pēc noklusējuma tiek atvērta, kad aktivizējat anotācijas. Tā ļaus jums pievienot
attēliem anotācijas, piemēram, rādītājus (Pointer), ar roku zīmētus zīmējumus (Freehand), elipses (Ellipse), tekstu (Text)
un piezīmes (Notes).

Šajā cilnē varēsiet dzēst visas    anotācijas un mainīt to lielumu   un krāsu   .

Izvēles modulis Implanti (Implants). Ja šī moduļa nav, cilne nebūs redzama. Ja vēlaties uzzināt vairāk par implantu
moduļa iespējām, izlasiet sadaļu "Implantu modulis". Ja vēlaties uzzināt, kā iegādāties implantu moduli, lūdzu, sazinieties
ar mums.

Cilne Kalibrēt (Calibrate): ar šo cilni varēsiet kalibrēt attēlu. Lai uzzinātu vairāk, izlasiet sadaļu "Kā kalibrēt attēlu".

Cilne Analizēšana (Analytics) (izvēles): Noklikšķinot uz šīs cilnes, varat piekļūt kariesa noteikšanas rīklodziņam

Atlases rīks: noklikšķiniet uz šīs pogas pirms anotācijas atlases.

Cilne Mērījumi (Measure): Šajā tālāk aprakstītajā cilnē varēsiet pievienot cita veida anotācijas.

Vienkāršas anotācijas: Šīs anotācijas nav saistītas ar attēla lielumu.

Dzēst visu (Delete All): Noklikšķinot uz šīs pogas, tiks dzēstas visas anotācijas, kas veiktas cilnē Anotācijas.

Lielums (Size): Palielina atlasīto anotāciju lielumu.

Rīki (Tools): Izmanto, lai aprēķinātu uzzīmēta taisnstūra pelēkās krāsas vērtības.

2. Kā izmantot anotācijas cilnē Anotācijas

Š
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Šajā sadaļā ir izskaidrotas anotācijas, ko var izmantot noklusējuma cilnē Anotācijas.

Šīs anotācijas ir brīvas un nav relatīvas attiecībā pret attēlu (tāpēc anotāciju izmērs nav relatīvs attēlam). To var izmantot,
piemēram, lai ātri parādītu pacientam problēmzonu.

Šajā cilnē ir norādīti anotāciju pamata izmantošanas veidi.

Darbība Paskaidrojums

Ielādējiet attēlu skatvietā. Pārliecinieties, ka attēls ir ielādēts skatvietā un ka skatvieta ir
atlasīta.

Aktivizējiet Anotācijas, izmantojot ikonu. Kad cilne Anotācijas ir aktivizēta, redzēsiet, ka ikona ir pelēkota.

1. Rādītāja pievienošana attēlam

Noklikšķiniet uz pogas Pointer (Rādītājs), lai pievienotu
rādītāju.

.

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
zīmējot rādītāju.

Punkts, kurā sākat zīmēt rādītāju, ir rādītāja vai bultiņas
gals.

Velciet lodziņu, vienlaikus nospiežot un turot nospiestu
peles KREISO pogu.

2. Ar roku zīmēta zīmējuma pievienošana attēlam
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Noklikšķiniet uz pogas Freehand (Zīmējums) .

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
zīmējot brīvi izvēlētu figūru.

Zīmējiet figūru, vienlaikus nospiežot un turot nospiestu
kreiso peles pogu.

3. Elipses pievienošana attēlam

Noklikšķiniet uz pogas Ellipse (Elipse) .

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
zīmējot elipsi.

 

Zīmējiet elipsi, vienlaikus nospiežot un turot
nospiestukreiso peles pogu.

4. Teksta pievienošana attēlam

Noklikšķiniet uz pogas Text (Teksts) .

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
zīmējot tekstlodziņu. 

Ierakstiet tekstu tekstlodziņā.

Zīmējiet tekstlodziņu, vienlaikus nospiežot un turot
nospiestukreiso peles pogu.

Parādīsies tekstlodziņš, un jūs varēsiet tajā ierakstīt tekstu.

5. Piezīmes pievienošana attēlam

Noklikšķiniet uz pogas Note (Piezīme) Piezīmes izmantošana ir līdzīga līmlapiņas pievienošanai uz
attēla.

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
zīmējot piezīmju lodziņu.

Ierakstiet tekstu piezīmju lodziņā. Šajā piemērā mēs
ierakstījām vārdu "Note".

Zīmējiet piezīmju lodziņu, vienlaikus nospiežot un turot
nospiestu kreiso peles pogu.

Parādīsies piezīmju lodziņš, un jūs varēsiet tajā ierakstīt tekstu.

6. Anotāciju lieluma mainīšana

Atlasiet anotāciju (elipsi), noklikšķinot uz pogas Select
(Atlasīt) (pārliecinieties, ka poga Select ir izcelta) un pēc tam
uz apmaleselipsei. 

Šajā piemērā mēs mainīsim elipses lielumu.

Tādus pašus soļus var izmantot arī citām anotācijām.

Nospiežotpogu Select un virzoties anotācijas apmales
virzienā, pamanīsiet, ka kursors maina formu. Šajā
brīdī varat noklikšķināt ar kreiso peles pogu, lai
atlasītu anotāciju.

Atlasot figūru, 4 stūros pamanīsiet mazus taisnstūrus.

Tas nozīmē, ka figūra ir pareizi atlasīta.

Noklikšķiniet uz lieluma pogas labās bultiņas, lai
palielinātu elipses apmali.

Šajā piemērā mēs aptuveni 10 reizes noklikšķinājām uz lieluma
pogas labās bultiņas, lai iegūtu rezultātu.

7. Anotāciju krāsas mainīšana

Atlasiet anotāciju (elipsi), noklikšķinot uz pogas Select
(Atlasīt) (pārliecinieties, ka poga Select ir izcelta) un pēc tam
uz elipses.

Šajā piemērā mēs mainīsim elipses krāsu.

Tādus pašus soļus var izmantot arī citām anotācijām.

Atlasot figūru, 4 stūros pamanīsiet mazus taisnstūrus. Tas
nozīmē, ka figūra ir pareizi atlasīta.
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Noklikšķiniet uz vienas no krāsu ikonām, lai mainītu krāsu Šajā piemērā mēs mainīsim krāsu uz sarkanu.

Pēc noklusējuma to var mainīt uz sarkanu, zaļu, zilu.

Noklikšķiniet uz ikonas, lai izvēlētos citu krāsu. Ja jūs neapmierina krāsa, varat noklikšķināt uz ikonas un
izvēlēties citu krāsu.

Tiek parādīts šis dialoglodziņš, izvēlieties vienu no krāsām.

Noklikšķiniet uz Define Custom Colors>> pogas, lai
pielāgotu krāsas.

Ja ar to nepietiek, varat arī definēt pielāgotas krāsas.

Noklikšķiniet ar peli uz krāsainā apgabala un Add to Custom
colors.

8. Anotāciju dzēšana

Konkrētas anotācijas dzēšana

Atlasiet anotāciju, kuru vēlaties dzēst

Nospiediet pogu Delete uz tastatūras.

Lai pārliecinātos, ka ir atlasīta pareizā anotācija, stūros ap
anotāciju jābūt redzamiem maziem taisnstūriem.

Visu anotāciju dzēšana

Noklikšķiniet uz ikonas Delete All, lai izdzēstu visas
anotācijas Ņemiet vērā, ka ar pogu Delete All tiks dzēstas tikai

anotācijas, kas izveidotas cilnē Anotācijas.

Ja pievienojāt anotācijas, izmantojot cilni Mērījumi
(Measure), tās netiks dzēstas. Lai dzēstu šīs anotācijas,
jāizvēlas cilne Mērījumi (Measure) un jānospiež poga
Delete All.

3. Kā izmantot mērījumu anotācijas cilnē Mērījumi (Measure)

Kad izmantojat cilnes Mērījumi anotācijas, attēls ir jākalibrē. Jūs pamanīsiet, ka attēls NAV kalibrēts, kad uzzīmēsiet
anotāciju (no cilnes Measure (Mērījumi)) un redzēsiet mērījumu pikseļos, nevis mm. Lai iegūtu vairāk informācijas par
attēla kalibrēšanu, izlasiet sadaļu "Kā kalibrēt attēlu".

Darbība Paskaidrojums

1. Ielādējiet attēlu skatvietā. .

Aktivizējiet Anotācijas, izmantojot ikonu. .

2. Līnijas zīmēšana, izmantojot cilni Measure (Mērījumi)
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Izvēlieties cilni Measure (Mērījumi) dialoglodziņā Annot. and
Measure (Anotācijas un mērījumi).

Lai mainītu parādītā teksta, piemēram, mērījumu, fonta
lielumu (pārāk mazs), atlasiet objektu un izmantojiet mazās
bultiņas.

Noklikšķiniet uz Line (Līnija) pogas .

Nospiediet un turiet nospiestu ​ KREISO peles pogu,
vienlaikus zīmējot līniju uz attēla.

Zīmējot līniju, ir svarīgi nospiest un turēt nospiestukreiso
peles pogu.

Tiklīdz atlaidīsiet peles kreiso pogu, līnija būs uzzīmēta.

2.1. Darbības ar līniju

Nospiediet un turiet ​ KREISO peles pogu, pārvietojot
līnijas turus.

Satverot līnijas turus (mazos taisnstūrīšus), varat pagarināt vai
saīsināt līniju.

Varat arī mainīt līnijas orientāciju.

Pārvietojiet līnijas turus (mazos taisnstūrīšus) no kreisās uz labo
pusi, lai saīsinātu vai pagarinātu līniju.

Pārvietojiet tos uz augšu un uz leju, lai mainītu līnijas orientāciju.

3. Taisnstūra zīmēšana
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Noklikšķiniet uz Rectangle (Taisnstūris) pogas Jums ir iespēja uz attēla uzzīmēt taisnstūri, lai pievērstu uzmanību
noteiktai vietai.

Noklikšķiniet ​ KREISO peles pogu taisnstūra kreisajā
stūrī. Kad esat novietojuši peles rādītāju uz labā stūra,
noklikšķiniet vēlreiz, un taisnstūris tiek uzzīmēts
automātiski.

Turus var izmantot tāpat kā līnijas.

Lai mainītu taisnstūra lielumu, velciet turus uz āru, un
taisnstūris tiks palielināts, bet velkot turus uz iekšu, tas tiks
samazināts.

Jūs redzat arī taisnstūra izmērus.

3.1. Darbības ar taisnstūri

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus
velkot turus, lai mainītu taisnstūra lielumu uz vēlamo.

Taisnstūra stūros redzēsiet turus (mazus taisnstūrīšus). Taisnstūri
var padarīt mazāku vai lielāku.

4. Apļa zīmēšana

Noklikšķiniet uz pogas Circle 3 pt. (3 punktu aplis). Lai uzzīmētu apli programmā Mediadent, ir jānorāda 3 punkti,
kas veido apļa lielumu. (Tāpēc arī pogai ir šāds nosaukums: Circle
3pt.).

Ja vēlaties pievērst uzmanību noteiktai attēla daļai, vienkārši
iezīmējiet šo apgabalu ar 3 punktiem, un automātiski tiks
uzzīmēts aplis.

Lai iezīmētu 3 punktus, vienkārši ar peles kreiso taustiņu
3 reizes noklikšķiniet ap apgabalu, uz kuru vēlaties
vērst uzmanību. Aplis tiek uzzīmēts automātiski.

Jūs redzēsiet, ka aplis tiek uzzīmēts automātiski pēc 3. punkta
atzīmēšanas.

Tāpat kā iepriekšējo figūru gadījumā, varat izmantot turus, lai
mainītu apļa lielumu.

Nospiediet un turiet ​ KREISO peles pogu, vienlaikus mainot
lielumu apļa lielumu ar turiem.

5. 3 punktu leņķa zīmēšana

Noklikšķiniet uz pogas Angle 3 pt. ( 3 punktu leņķis) Lai uzzīmētu leņķi, ir nepieciešami 3 punkti: pirmās līnijas
sākuma punkts, virsotne un otrās līnijas beigu punkts.

Norādiet pirmās līnijas sākuma punktu, noklikšķinot ar
peles KREISO pogu. Tagad esat nofiksējuši peles rādītāju un
varat pāriet uz beigu punktu vai virsotni.

Noklikšķiniet ar peles KREISO pogu, lai norādītu leņķa
virsotni.

Tagad varat pārvietot peli uz otrās līnijasbeigu punktu.
Noklikšķiniet, lai fiksētu šo punktu, un leņķis tiks
uzzīmēts.

Lai uzzīmētu leņķi, ir jānoklikšķina tikai 3 reizes:

Pirmo reizi uz leņķa sākuma punkta, otro reizi uz virsotnes un
trešo reizi uz beigu punkta.

Leņķis tiek aprēķināts automātiski.

Tāpat kā iepriekšējos piemēros, jūs varat izmantot turus, lai
mainītu sākuma punktu, virsotnes punktu un beigu punktu.

Leņķis tiek pārrēķināts automātiski.

6. 4 punktu leņķa zīmēšana

Noklikšķiniet uz pogas Angle 4 pt. ( 4 punktu leņķis) Analīzes procesa laikā ir noderīgi spēt aprēķināt leņķi starp 2
zobiem.

Programmā Mediadent varat uzzīmēt 4 punktu leņķi.

Vajadzīgi 4 punkti - pirmās līnijas sākuma un beigu punkts un
otrās līnijas sākuma un beigu punkts.

Leņķis tiek aprēķināts automātiski.

Noklikšķiniet uz pirmā punkta (peles rādītājs ir fiksēts),
tagad varat pārvietot peli uz pirmās līnijas beigu punktu.

Divreiz noklikšķiniet ar peles KREISO pogu: vienreiz līnijas
sākumā un otrreiz līnijas beigās.

Pārvietojiet peli uz otrās līnijas pirmo punktu un
noklikšķiniet ar peles KREISO pogu.

Pārvietojiet peli uz otrās līnijas beigu punktu un
noklikšķiniet ar peles KREISO pogu.

Pēc tam, kad būsiet noklikšķinājuši uz ceturtā punkta, tiks
aprēķināts leņķis starp abām līnijām.
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7. Lauztas līnijas zīmēšana

Noklikšķiniet uz Polyline (Lauzta līnija) pogas Lauzta līnija ir savienota nogriežņu virkne, un to bieži izmanto, lai
analizētu zoba sakņu kanālu.

Jūs varēsiet iegūt sakņu kanāla mērījumus.

Noklikšķiniet uz lauztās līnijas pirmā punkta

Noklikšķiniet ar peles KREISO pogu, lai izveidotu nogriezni.

Katru reizi, kad noklikšķināsiet ar peles KREISO pogu, jūs būsiet
izveidojuši punktu (nogriezni) uz lauztās līnijas un iegūsiet
mērījumu.

Jūs pamanīsiet, ka līnija kļūst SARKANA, kad pirmo reizi
noklikšķināt ar peles KREISO pogu. Tas nozīmē, ka esat izveidojuši
pirmo nogriezni.

Lai pabeigtu lauzto līniju, veiciet dubultklikšķi ar
KREISO peles pogu.

Redzēsiet lauztās līnijas un izveidotā punkta kopējo mērījumu.

8. Daudzstūra zīmēšana

Noklikšķiniet uz Polygon (Daudzstūris) pogas Līdzīgi kā ar lauzto līniju, jūs varēsiet izmantot daudzstūri, lai
aprēķinātu figūras virsmu.

Tas var būt noderīgi, lai aprēķinātu konkrētas problēmzonas
virsmu.

Noklikšķiniet ar peles KREISO pogu uz zonas, kuru vēlaties
izmērīt, sākuma punkta.

Kamēr nenoklikšķināsiet, lai pievienotu punktu, līnija paliks
melna.

Katru reizi, kad noklikšķināsiet ar peles KREISO pogu, daudzstūrī
tiks izveidots punkts.

Varat pievienot punktus apgabalam, vienkārši
noklikšķinot ar peles kreiso pogu.

Šeit esam izveidojuši 4 punktus daudzstūrī.

Lai pabeigtu daudzstūri, veiciet dubultklikšķi ar peles
kreiso pogu.

Jums nav jāaizver daudzstūris, jo, veicot dubultklikšķi, daudzstūris
tiek aizvērts automātiski.

Automātiski tiek izmērīta virsma.

9. Nogriežņu attiecības zīmēšana

Noklikšķiniet uz Ratio (Attiecība) pogas Jums ir iespēja uzzīmēt 2 līnijas nogriežņus un ļaut Mediadent
aprēķināt attiecību starp šiem diviem nogriežņiem.

Attiecība tiek aprēķināta, ņemot pirmā nogriežņa garumu un dalot
to ar otrā nogriežņa garumu.

Noklikšķiniet ar peles KREISO pogu uz attēla, lai norādītu
pirmā nogriežņa sākuma punktu.

Noklikšķiniet ar peles KREISO pogu, lai norādītu pirmā
nogriežņa beigu punktu.

Pēc tam, kad esat noklikšķinājuši ar KREISO peles pogu, lai
norādītu pirmā nogriežņa beigu punktu, jūs pamanīsiet, ka
nogrieznis kļūst SARKANS, kas norāda pirmā nogriežņa beigas.

Pārvietojiet peli uz otrā nogriežņa sākuma punktu un noklikšķiniet
ar peles KREISO pogu.

Pārvietojiet peli uz punktu attēlā, kurā vēlaties norādīt otrā
nogriežņasākuma punktu, un noklikšķiniet ar peles
KREISO pogu.

Pārvietojiet peli uz punktu attēlā, kurā vēlaties norādīt otrā
nogriežņabeigu punktu, un noklikšķiniet ar peles
KREISO pogu.

Mēs vēlamies aprēķināt attiecību starp 2 nogriežņiem, kas varētu
būt zobu garums.

Kad būsiet noklikšķinājuši uz pēdējā nogriežņa beigu punkta,
redzēsiet, ka līnijas kļūst SARKANAS un tiek aprēķināta attiecība.

10. Slīpuma zīmēšana

Noklikšķiniet uz Slope (Slīpums) pogas Mediadent aprēķina slīpumu starp diviem nogriežņiem.

Noklikšķiniet ar peles KREISO pogu, lai norādītu pirmā Kamēr līnija ir melna, varat pārvietot peles rādītāju.
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nogriežņa sākuma punktu.

Pārvietojiet peli uz beigu punktu un noklikšķiniet otrreiz ar
peles KREISO pogu.

Pēc tam, kad ar peles KREISO pogu būsiet noklikšķinājuši uz
beigu punkta, tiks aprēķināts slīpums. 

Jūs pamanīsiet, ka slīpums ir SARKANS, norādot, ka ir veikts
aprēķins.

11. Paralēlu līniju zīmēšana

Noklikšķiniet uz Parallel (Paralēla līnija) pogas Var būt noderīgi zīmēt paralēlas līnijas attēlā.

Noklikšķiniet ar peles KREISO pogu, lai norādītu pirmās
līnijas sākuma punktu.

                       
Pārvietojiet peli uz beigu punktu un noklikšķiniet otrreiz ar
peles KREISO pogu.

Kad otro reizi noklikšķināsiet ar peles KREISO pogu, paralēlās
līnijas tiks uzzīmētas automātiski.

Mērījumos redzamo tekstu var viegli mainīt, ar peles kreiso taustiņu noklikšķinot uz teksta un velkot to uz vajadzīgo vietu

4. Anotāciju drukāšana

Lai izdrukātu anotācijas, tas jānorāda drukāšanas dialoglodziņā.

1. Mediadent izvēlnē izvēlieties File>Print -vai- Noklikšķiniet uz  Print (Drukāt) ikonas.

2. Ielādējiet attēlu drukāšanai.

3. Atzīmējiet lodziņu Drukāt anotācijas dialoglodziņā Print (Drukāt).

Vairāk par attēla drukāšanas iespējām varat uzzināt sadaļā "Attēlu drukāšana" (Section 5.5). 

7.2.4 Darbs ar tālummaiņas logu

Tālummaiņas logs ļaus veikt ļoti detalizētu attēlu analīzi. Bieži vien ir nepieciešams iedziļināties ļoti detalizēti, lai
atklātu plaisas un audu problēmas.

Tālummaiņas logs ļaus jums:

1. Palielināt jeb tuvināt konkrētu attēla daļu.
2. Lietot attēlam dažādus filtrus:

Invert
HistoEqualize
Emboss_NE
Gamma Correction

 Šajā sadaļā mēs izskaidrosim, kā aktivizēt tālummaiņas logu un kā var lietot filtru.

1. Darbs ar palielināšanas jeb tālummaiņas funkciju

Veiciet šādas darbības, lai izmantotu tālummaiņas logu:

Darbība Paskaidrojums

1. Atlasiet attēlu un ielādējiet to skatvietā  .

2. Noklikšķiniet uz ikonas tālummaiņas logs (ZOOM Window)

-vai-

.
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Mediadent izvēlnē izvēlieties Display > Desktop Panels > Zoom Window

Blakus skatvietai
tiek atvērts papildu
ekrāns.

Ekrānā redzēsiet
palielinājumu
vietai, kur skatvietā
ir novietots peles
kursors.

Šis ekrāns darbojas
kā palielināmais
stikls.

Jūs detalizēti
redzēsiet audus un
zobu struktūru.

Pārvietojot peli uz
vēlamo vietu
skatvietā esošajā
attēlā, jūs
tālummaiņas logā
varēsiet analizēt
konkrēto attēla
apgabalu.

Ir 2 veidi, kā tuvināt apgabalu:

Vispirms pārvietojiet peli uz tālummaiņas logu.

1.Ja jums ir pele ar ritenīti:

Ritiniet peles ritenīti UZ AUGŠU, lai palielinātu attiecīgā apgabala
palielinājumu.
Ritiniet peles ritenītiUZ LEJU, un jūs samazināsiet palielinājumu.
(Tas ir atkarīgs no tā, kā ir iestatīts peles ritenītis).

2. Izmantojiet lineālu tālummaiņas loga augšpusē un pabīdiet to pa labi, lai iegūtu lielāku
palielinājumu.

Ja tālummaiņa
nedarbojas ar
peles ritenīti,
varat izmantot
tālummaiņas
loga augšpusē
esošo
tālummaiņas
lineālu (2.
metode).

Lai palielinātu
vai samazinātu
palielinājumu,
varat arī 
 izmantot
bultiņu "  uz
augšu" vai "uz
leju".
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2. Filtra lietošana tālummaiņas logam

Ja vēlaties lietot filtru, noklikšķiniet uz attiecīgajām ikonām ekrāna apakšā. Jebkurā laikā varat pārslēgties no viena
filtra uz citu.

Atgriezties pie parastā izskata Pirmā ikona atiestatīs attēlu.

Invert Ar šo attēlu maina uz pretējo.
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HistoEqualize .
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Emboss_NE .

Šo filtru var pielāgot,
izmantojot tastatūras
taustiņus "uz augšu" un "uz
leju".

Gamma Correction . C

Š
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Šo filtru var pielāgot,
izmantojot tastatūras
taustiņus " uz augšu " un "uz
leju".

7.2.5 Darbs ar interešu reģionu

Līdzās tālummaiņas logam (Section 7.2.4) ļoti praktiska funkcija ir Region of Interest (ROI) (Interešu
reģions), kas noder, ja vēlaties detalizētāk analizēt attēla daļas.

Tā ļauj IZGRIEZT daļu no attēla un analizēt to, piemēram, citā skatvietā.

Visas darbības, ko veicat ar attēlu, ir iespējamas arī ROI.

Šajā sadaļā uzzināsiet, kā izveidot ROI un kā analizēt ROI atsevišķā skatvietā. Uzzināsiet arī, kā saglabāt ROI.

Lai izveidotu interešu reģionu, izpildiet šādas darbības:

Darbība Paskaidrojums

1. Ielādējiet attēlu skatvietā Ielādējiet attēlu, kuru vēlaties analizēt sīkāk.

2. Noklikšķiniet uz ROI ikonas. Izmantojiet ROI ikonu, lai izgrieztu fragmentu
no attēla, kuru vēlaties analizēt sīkāk.

3. Zīmējiet daļu, kuru vēlaties pārbaudīt sīkāk. Nospiediet un turiet ​ KREISO peles pogu,
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vienlaikus zīmējot interešu reģionu (ROI)

Pēc noklusējuma tiek izgriezts taisnstūris.

Izgriezto attēla daļu var izmantot turpmākai
analīzei.

4. Ja vēlaties analizēt šo attēla daļu šajā skatvietā,
vienkārši noklikšķiniet uz ROI ikonas atkal.

Ievērojiet, ka, otrreiz noklikšķinot uz ROI ikonas,
tai ir tumšāka krāsa. Tas nozīmē, ka esat gatavi
analizēt šo attēla daļu.

Rezultātā attēls skatvietā tiek aizstāts ar ROI
(izgriezto daļu).

Ja vēlaties atjaunot attēla sākotnējo
versiju, noklikšķiniet uz Reload
(Pārlādēt) ikonas, un sākotnējais attēls

parādīsies skatvietā.

Ja nevēlaties, lai skatvieta tiktu nomainīta, un vēlaties analizēt ROI citā skatvietā, izpildiet tālāk norādītās
darbības:

1. Atkārtojiet 1. līdz 3. darbību

2. PIRMS noklikšķiniet uz ROI ikonas, izvēlieties citu
skatvietu

3. Noklikšķiniet uz ROI ikonas

Jūs pamanīsiet, ka ROI (izgrieztā daļa) ir ielādēta
otrā skatvietā.

Tagad varat veikt jebkuras darbības ar attēlu,
piemēram, pelēko toņu korekciju (Section
7.2.1), pseidokrāsošanu (Section 7.2.2),
mainīt spilgtumu un kontrastu utt.

Lai SAGLABĀTU ROI (attēla daļu):

1. Atlasiet Skatvietu ar ROI

2. Noklikšķiniet uz Save (Saglabāt) ikonas.

.
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Piešķiriet attēlam nosaukumu.

Attēls parādīsies attēlu bibliotēkā.

 

Varat izvēlēties, kā izgriezt attēla daļu: taisnstūra vai ar roku zīmētas figūras veidā.

Lai izvēlētos citu citu veidu: Noklikšķiniet un turiet ikonu, un jūs redzēsiet, ka parādīsies citas
ikonas; izvēlieties freehand (ar roku zīmēta figūra) vai rectangular (taisnstūris).

Pirmā ikona ir taisnstūris, bet otrā ir ar roku zīmēta figūra. Izmantojot figūras zīmēšanu ar roku,
varat uzzīmēt apgabalu, kuru vēlaties analizēt.

7.2.6 Darbs ar filtriem

Jums ir iespēja pielāgot attēlu, izmantojot dažādus filtrus programmā Mediadent.

Šajā sadaļā uzzināsiet par dažādiem filtriem, kurus varat lietot attēliem programmā Mediadent.  

Lai aktivizētu filtra dialoglodziņu, noklikšķiniet uz ikonas  

Parādīsies dialoglodziņš Filtrs ar dažādām opcijām, ko varat izmantot, lai pārveidotu attēlu.
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Lai iegūtu optimālu rezultātu, varat to izmantot kopā ar filtru skriptu. Tas ļaus efektīvi strādāt ar filtriem. Izlasiet
sadaļu Kā izmantot filtru skriptu (Section 7.2.8)

Lai palaistu filtru skriptu, ielādējiet attēlu skatvietā un izvēlieties Ctrl-f. Tiks atvērts filtru skripts. Tagad varat
lietot dažādus filtrus.

Šī ir uzlabota funkcija. Ja esat veikuši izmaiņas attēlā, izmantojot filtra opcijas, jūs vienmēr varat pārlādēt

attēlu, noklikšķinot uz šādas ikonas: 

Dialoglodziņa opcija Paskaidrojums

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

99

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Histogram Contrast/Histogram Equalize izmantošana

Ja skenētais attēls ir tumšāks par oriģinālu un vēlaties
līdzsvarot vērtības, lai iegūtu gaišāku attēlu, varat izmantot
funkciju Histogram Equalize (Histogrammas
izlīdzināšana). Komanda Equalize (Izlīdzināt) pārdala
attēla pikseļu spilgtuma vērtības tā, lai tās vienmērīgāk
atspoguļotu visu spilgtuma līmeņu diapazonu. Izvēloties šo
komandu, programmatūra atrod attēla gaišākās un
tumšākās vērtības un izlīdzina visas spilgtuma vērtības
tā, lai tumšākā vērtība būtu melna, bet gaišākā - balta.

Kopā ar Histogram Contrast (Histogrammas
kontrasts), kas neietekmē attēla krāsu līdzsvaru, varat
redzēt spilgtuma salīdzinājumus pirms un pēc.

Stretch Intensity izmantošana

Komanda Stretch intensity (Izstiept intensitāti)
automātiski veic darbību, kas ekvivalenta slīdņa Levels
(Līmeņi) regulēšanai. Šīs funkcijas automātiski nosaka
gaišākos un tumšākos pikseļus katrā kanālā kā baltus
un melnus, pēc tam proporcionāli pārdalot starpposma
pikseļu vērtības.

Kopumā funkcija Auto dod labus rezultātus, ja
nepieciešams vienkārši pielāgot kontrastu attēlam ar
vidēju pikseļu vērtību sadalījumu. Tomēr šī funkcija
nenodrošina precīzāku kontroli, ko var panākt, manuāli
pielāgojot Levels (Līmeņi) vai Curves (Līknes).

Gamma Correction izmantošana

Šo funkciju izmanto, lai pielāgotu to, kā attēli tiek
parādīti monitorā vai izdrukāti.

Var veikt nelielas krāsu korekcijas atkarībā no tā, kādu
monitoru izmantojat.

Gamma Correction (Gamma korekcija) ir monitora
pielāgošanas un programmatūras krāsu konversijas
iestatījumu pielāgošanas process, lai kompensētu faktorus,
kas ietekmē gan ekrānā redzamo attēlu, gan tā
pārveidošanu par izdruku.

Sharpen izmantošana

Neskaidru attēlu uzlabošanai varat izmantot filtru
Sharpen (Asuma palielināšana).

Funkcija Sharpen fokusē neskaidrus attēlus, palielinot
blakus esošo pikseļu kontrastu. Šie filtri ietver
Sharpen un Focus filtrus, kas abi atrod attēla apgabalus,
kuros notiek būtiskas krāsu izmaiņas (piemēram, malās),
un palielina to asumu.
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Spatial filters (Telpiskie filtri)

Šīs funkcijas nodrošina paplašinātas filtrēšanas iespējas.

Nospiediet peles LABO pogu, lai atvērtu paplašināto filtru
sarakstu.

Gaussian Blur izmantošana

Lai no attēla noņemtu problemātiskas zonas, piemēram,
elektronu troksni, putekļus un skrāpējumus, var
izmantot trokšņu samazināšanu.

Gaussian blur (Gausa aizmiglojums) sniedz labākus
rezultātus, pateicoties uzlabotai formulai, taču šis filtrs
darbojas lēnāk.

Unsharp Mask izmantošana

Šis filtrs var būt noderīgs attēliem, kurus vēlaties
izdrukāt vai skatīt tiešsaistē.

Unsharp mask jeb fokusēšana ir tradicionāla filmu
kompozīcijas tehnika, ko izmanto, lai padarītu asākas
attēla malas. Filtrs Unsharp Mask koriģē attēla
izplūšanu, kas rodas fotografēšanas, skenēšanas,
pārģenerēšanas vai drukāšanas laikā.

Unsharp Mask atrod pikseļus, kas atšķiras no apkārtējiem
pikseļiem, un palielina pikseļa kontrastu par jūsu norādīto
daudzumu. Turklāt jūs norādāt reģiona rādiusu, ar kuru
tiek salīdzināts katrs pikselis.

Filtra Unsharp Mask ietekme ir daudz izteiktāka uz ekrāna
nekā augstas izšķirtspējas izdrukā. Ja jūsu paredzētais
galaprodukts ir izdruka, eksperimentējiet, lai noteiktu,
kādi iestatījumi ir vispiemērotākie jūsu attēlam.

Labākais iestatījums fokusēšanai:

Augstas izšķirtspējas attēls (3000 pikseļu H vai
V):
Rādiuss: 16
Koeficients (Fract): 6
Samaziniet rādiusu, ja attēls ir mazāks (mazāk
pikseļu).
Samaziniet koeficientu (Fract), ja filtrs ir pārāk
spēcīgi izteikts.

Ja iegūtajiem attēliem vienmēr ir jāveic vienādas korekcijas, var būt noderīgi izmantot opciju Optimize
(Optimizēt). Tā pēc noklusējuma piemēros vēlamos filtrus, izvēloties noteiktu Optimize (Optimizēt) skaitli.

Izlasiet sadaļu "Darbs ar optimizācijas funkciju" (Section 7.2.7).

7.2.7 Darbs ar optimizācijas funkciju

Optimizācijas funkcija ir uzlabota funkcija, kas ļauj standartizēt attēlam lietojamos filtrus (maskas u.c.).

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

101

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Reāllaika filtri Mediadent var uzreiz nodrošināt uzlabotu attēla kvalitāti un var atvieglot diagnostiku, ārstēšanas
plānošanu un turpmāko uzraudzību.

Bieži vien pēc attēlu iegūšanas ir nepieciešamas papildu darbības, lai nodrošinātu detalizētai analīzei
nepieciešamo skaidrību. Šīs darbības var automatizēt, izmantojot optimizācijas profilu.

Piemēram, jums ir iespēja noteikt, kurus filtrus pēc noklusējuma lietosiet, iegūstot attēlu. 

Mediadent varat konfigurēt 5 optimizācijas profilus.

Jūs varēsiet piesaistīt noteiktu optimizācijas profilu konkrētai attēlu iegūšanas ierīcei. Vairāk par to lasiet
sadaļā Optimizācijas modulis (Section 11.1).

Darbība Paskaidrojums

1. 1. optimizācijas profila lietošana

Noklikšķiniet uz ikonas ikonu kopā, un attēlam tiks
lietots 1. optimizācijasprofils.

Pēc noklusējuma ikonu kopā ir pieejams 1.
optimizācijas profils.

Noklikšķinot uz ikonas, attēlam tiks lietoti vairāki
1. optimizācijas profilā konfigurētie filtri un/vai
darbības.

2. Cita optimizācijas filtra lietošana

Nospiediet un turiet  ​ kreiso peles pogu uz ikonas
Optimizācija ikonu kopā. 

Atlasiet optimizācijas profilu, kuru vēlaties lietot
attēlam.

Ikona Optimizācija tiks izvērsta, un parādīsies 5
ikonas.

Jums būs pieejamas 5 ikonas (no 1 līdz 5), kas
apzīmē 5 optimizācijas profilus, kurus varat
lietot attēlam.

Kā piemēru testēšanai izvēlieties 5. optimizācijas
profilu.

Ja jūs neapmierina optimizācijas rezultāts, jums ir iespēja atkārtoti ielādēt sākotnējo attēlu, noklikšķinot

uz ikonas atkārtoti ielādēt (re-load) ikonu kopā.

7.2.8 Kā izmantot filtru skriptu

Filtru skripts ir Mediadentv8 versijas funkcija. Šī opcija ļauj skatīt filtrus, kas tiek izmantoti atlasītajam attēlam.
Lai uzlabotu attēla kvalitāti, dažkārt attēlam tiek lietoti filtri. Filtru skripta monitors palīdzēs jums pārvaldīt
dažādus filtrus. Jūs varēsiet ātri lietot dažādus filtrus un mainīt to secību.

Tā ir svarīga opcija, lai, strādājot ar filtriem, varētu izmēģināt dažādas iespējas, jo tā ļauj ātri aktivizēt vai
deaktivizēt konkrētus filtrus. Jūs uzreiz redzat rezultātu, ko rada lietotie filtri.

Šajā programmas versijā filtru skripts tiek saglabāts no attēla atsevišķā failā un tiek lietots katru reizi, kad attēls tiek
ielādēts. Tas nodrošina lielāku elastību filtru izmantošanā.

Lai aktivizētu filtru skriptu, ielādējiet attēlu skatvietā un izvēlieties

Display > Set current viewport to > Show filter script
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vai 

Ctrl F

Pēc opcijas aktivizēšanas tiks parādīts šāds ekrāns:

 

Nr. Paskaidrojums

Filtru skripts: šajā cilnē tiek parādīti lietotie filtri. Jūs varēsiet pārvaldīt filtrus, mainīt kārtību, kādā
filtri tiks lietoti, noņemt filtru no skripta, aktivizēt vai deaktivizēt filtrus.

RAW Mih dati: attēls Mediadentsastāv no 3 failiem (.dic, .bmp un .mih). .mih failā ir attēla metadati,
piemēram, lietotie filtri, pacienta vārds u.c.  Šajā cilnē redzēsiet attēlam lietotos filtrus. Šī opcija ir
eksperta līmeņa opcija.

Šis ir attēlam lietoto filtru saraksts. Sīkāka informācija par filtra kodiem ir atrodama tēmā "Filtra
kodi".

Lietoto filtru secības maiņa var būtiski ietekmēt attēla kvalitāti. Ar šo ikonu var pārvietot atlasīto
filtru uz augšu.

Ar šo ikonu var pārvietot atlasīto filtru uz augšu.
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Ar šo ikonu atlasītais filtrs tiek noņemts no filtru skripta.

Izmēģinot dažādus filtrus, ar šo ikonu ir viegli deaktivizēt filtru.

Ar šo ikonu var aktivizēt konkrētu filtru.

Ar šo ikonu tiek parādīts attēla sākotnējais skripts. Dažiem attēliem ir pievienots filtru skripts.
Izmantojot šo opciju, varat redzēt sākotnējo filtru skriptu.

Lietot reāllaika vērtības filtru skriptam: šī opcija ļauj lietot kontrastam, intensitātei un pelēko toņu
korekcijai veiktās izmaiņas.

Šī ikona aktivizē logu, kurā tiek parādīts pieejamo filtru skaits, kurus var lietot attēliem.

Plašāku informāciju par dažādiem filtriem, kurus var izmantot, skatiet sadaļā Darbs ar filtriem (Section
7.2.6).

Attēla histogrammā kontrasta, intensitātes un pelēko toņu korekcijas opcijas tiek lietotas tikai attēla
attēlošanai (sk. sadaļu Darbs ar pelēko toņu korekciju (Section 7.2.1)). Lai lietotu šīs modifikācijas filtru
skriptam, jāizmanto opcija 'Apply real-time values to filter script' (Lietot reāllaika vērtības filtru
skriptam).

Šajā piemērā mēs mainīsim kontrastu, intensitāti un lietosim pelēko toņu korekciju.

Darbība Paskaidrojums

1. Veiciet kontrasta, intensitātes un pelēko toņu korekcijas izmaiņas Kā redzat, esam
izmainījuši intensitāti:
6, kontrastu -70 un
pelēko toņu korekciju
w:84-253.

Lai uzzinātu vairāk par to,
kā manipulēt ar
attēliem, izlasiet sadaļas:

Darbs ar attēliem
(Section 5.3)

Darbs ar pelēko toņu
korekciju (Section
7.2.1)

2. Izvēlieties lietot reāllaika vērtības filtru skriptam. Ja jūs apmierina
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kontrasta, intensitātes un
pelēko toņu korekcijas
izmaiņas, varat tās lietot
filtru skriptam.

3. Rezultāts : izmaiņas tiek pievienotas filtra skriptam. Kā redzat, skriptam ir
pievienota rinda
INTCONWINDOWING
006,-070,084,253.

Filtru skripts ir svarīgs rīks, kas nodrošina lietoto filtru redzamību. Tas palīdzēs speciālistiem uzlabot attēla kvalitāti.

Tā kā filtru skripts ir atsevišķs fails, tagad ir viegli atsaukt dažādus filtrus vai atcelt to atsaukšanu. 

Filtra kodi

 Filtra kodi ir veids, kā norādīt, no kurienes nāk filtra rinda. Filtru var pievienot manuāli vai arī tas var būt no pašas
ierīces. Optimizācijas modulī varat pievienot arī filtrus.

Filtra kodu
saraksts

(00)

Šis kods norāda, ka filtrs ir pievienots manuāli, izmantojot filtra ikonu.   Sīkāku
informāciju par iespējām lasiet sadaļā: Darbs ar filtriem (Section 7.2.6)

(42) Šis ir iekšējais filtrs, kas pievienots rentgena iekārtas opcijās.

(41) Šis filtrs tika konfigurēts optimizācijas modulī un tad lietots attēlam.
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(65)

Šis ir filtrs, kas pievienots, izmantojot optimizācijas ikonu 

7.2.9 Darbs ar filtru logu

Reāllaika filtri Mediadent var uzreiz nodrošināt uzlabotu attēla kvalitāti un var atvieglot diagnostiku, ārstēšanas
plānošanu un turpmāko uzraudzību.
Filtru logs sniedz vizuālu pārskatu par dažādajiem jūsu attēliem lietotajiem filtriem. Tas ir lielisks vizuāls
palīglīdzeklis, kas palīdzēs jums izvēlēties sev piemērotāko attēla kvalitāti.

Kad esat izvēlējušies, varat to lietot attēlam.

Nākotnē varat arī iestatīt šo kvalitāti (filtrus) kā noklusējumu.

Filtru logs ir pieejams attēla iegūšanas laikā vai pēc tam, vienkārši noklikšķinot uz ikonas.

1. Pārskats par filtru loga ekrānu

Šeit atradīsiet dažādas filtru loga ekrāna funkcijas.

Nr. Paskaidrojums

Šajā piemērā parādīts, ka attēlam lietoti 6 filtri.

Dažādo lietoto filtru nosaukumi: Optimize 1, Optimize 2, Endo ... Šie filtri ir definēti iestatījumā
"Optimize". Sk. sadaļu Optimizācijas modulis (Section 11.1)

Noklikšķinot uz ikonas     , atlasiet filtrus, kurus vienmēr vēlaties redzēt pirmajā ekrānā. Tas ir
praktiski, ja jums ir liels skaits filtru. Šādi varat izvēlēties iecienītākos filtrus. Pēc izvēles redzēsiet šo

ikonu 

Š
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Vienā ekrānā redzamo filtru skaitu var konfigurēt. Šajā piemērā ir piedāvāti 6 filtri. Ekrānā var būt no
2 līdz 10 filtriem.

Kad esat izvēlējušies filtru, kas nodrošina vislabāko attēla kvalitāti, varat šo filtru lietot attēlam.

Noklikšķiniet uz bultiņas, lai parādītu nākamo filtru sēriju.

Noklikšķiniet uz ikonas, un atlasītais attēls tiks parādīts pilnekrāna režīmā. Vēlreiz noklikšķiniet uz
ikonas un atgriezieties sākotnējā ekrānā.

"Show default device filter on every page" (Parādīt noklusējuma ierīces filtru katrā lapā).  To var ieslēgt
vai izslēgt.

Papildu informācija par attēlu. Ar kādu ierīci ir uzņemts attēls (modulis un ierīce). Pāreja uz attēlu ar
izvēlēto filtru. "Show the filter editor" (Parādīt filtru redaktoru) = tiks parādīts filtru skripts (sk. sadaļu
Kā izmantot filtru skriptu (Section 7.2.8)). 

2. Filtru loga ekrāna izmantošana attēlu iegūšanas režīmā

Lai izmantotu filtru loga ekrānu attēlu iegūšanas režīmā, varat veikt šādas darbības.

Ikona Paskaidrojums

Sagatavojiet
rentgena
ierīci, lai
varētu uzņemt
attēlu.
Noklikšķiniet
uz attēlu
iegūšanas
ikonas.

Uzņemiet
attēlu.
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Ir pieejama
ikona Filter
window
(Filtru logs).
Pēc
atlasīšanas
tiks atvērts
Filtru logs ar
vairāku filtru
pārskatu.

Izvēlieties
vēlamo filtru
un lietojiet to
attēlam.

Filtru logu var aktivizēt jebkuram atlasītajam attēlam. Vienkārši ielādējiet attēlu skatvietā un izvēlieties

filtru loga ikonu. 

7.3 Darbs ar zobu shēmu
 

7.3.1 Darbs ar zobu shēmu

Pēc tam, kad esat izvēlējušies veikt attēla iegūšanu,     statusu parāda kopā ar zobu shēmu.

Šajā ekrānā norādiet, kuram zobam vai zobiem uzņemsiet attēlu.

Šajā sadaļā tiks izskaidroti šādi jautājumi:

1. Pārskats par ekrānu

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

108

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Attēlu iegūšanas ekrāna izēlne. Sk. arī sadaļu Pārskats par attēlu iegūšanas izvēlni (on-line
documentation).

Pieaugušā zobu shēma vai statuss.

Bērna zobu shēma vai statuss.

Šajā nelielajā dialoglodziņā shēmas vidū ir redzams atlasītais zobs vai zobi, sensors un orientācija. Sk.
arīDarbības ar sensoru un orientāciju (Section 7.3.2).

Interproksimālās radiogrammas ("Bitewing") atlasītājs sniedz iespēju izvēlēties interproksimālo
radiogrammu.

Skatvieta, kurā tiks ielādēts attēls.

Attēlu bibliotēka, kurā tiks saglabāti pacienta attēli.

Ar pogu "Grab" tiks veikta attēlu iegūšana.

Ar pogu "Exit" tiks iziets no attēlu iegūšanas moduļa un jums tiks piedāvāts saglabāt attēlus. Sk. arī Attēla
saglabāšana (Section 5.4).

Šī ir statusa rinda, kurā tiek parādīts attēla nosaukums un arī tas, vai ierīce ir gatava ekspozīcijai.Ja
rodas problēmas, skatiet sadaļuProblēmu novēršana (Section 9).

Ar mazo bultiņu var piekļūt izvēlnei, kurā var mainīt attēlu parādīšanas secību. Sk. arī Attēlu secības
maiņa (on-line documentation).

2. Atlasiet zobu, zobus vai interproksimālo radiogrammu

Pirms jūs ar "Grab" uzņemat attēlu, ir svarīgi piesaistīt zobu, zobus vai interproksimālo radiogrammu attēlam.
Tas palīdzēs jums labāk organizēt attēlu bibliotēku.
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Darbība Paskaidrojums

1 zoba atlasīšana

Atlasiet zobu (Noklikšķiniet uz zoba ar peles kreiso
pogu) statusā.

Redzēsiet, ka atlasītais zobs tagad ir tumši pelēks.

Dialoglodziņā redzēsiet, ka ir atlasīts 16. zobs .

Tagad jums ir iespēja izmainīt sensoru un orientāciju.

Sk. arī Darbības ar sensoru un orientāciju.

Izvēloties zobu, pozicionēšanas palīgs sniegs jums vizuālu
palīdzību, kā pozicionēt intraorālo sensoru pacienta
mutē. Sk. Darbs ar pozicionēšanas palīgu (Section
7.3.3).

Vairāku zobu atlasīšana

Atlasiet zobu blakus iepriekš atlasītajam zobam.

Atkārtojiet šo procesu, līdz esat atlasījuši vajadzīgo
zobu skaitu.

4 secīgus zobus, noklikšķinot uz katra zoba.

Varat arī noklikšķināt uz pirmā zoba un pēdējā zoba -
automātiski tiks atlasīti starp tiem esošie zobi.
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Interproksimālās radiogrammas atlasīšana

Izvēlieties vienu no interproksimālajām radiogrammām,
noklikšķinot uz Bitewing joslām. 

Noklikšķinot uz joslām, redzēsiet atlasītos zobus.

7.3.2 Darbības ar sensoru un orientāciju

Veicot attēlu iegūšanu ar zobu shēmas vai statusa palīdzību, jums ir iespēja mainīt sensora orientāciju.

Noklikšķiniet uz sensora pogām, lai mainītu sensora orientāciju. Spīdošā opcija ir aktīvais iestatījums.
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Varat arī apvērst attēlu no kreisās puses uz labo     vai no augšas uz leju.  

Veiktās izmaiņas sensora orientācijā tiks saglabātas nākamajai reizei.

7.3.3 Darbs ar pozicionēšanas palīgu

Pozicionēšanas palīgs piedāvā vizuālu palīdzību intraorālā sensora pozicionēšanā. 

Jaunais palīgs ir integrēts zobu shēmā, tāpēc atkarībā no zobu atlases jums tiks piedāvāts attēls, kā pozicionēt
sensoru pacienta mutē.

Jums ir arī iespēja noskatīties īsu instruktāžas video.

Pozicionēšanas palīgs pašlaik vēl tiek izstrādāts un vēl nav pabeigts.

Mūsu mērķis ir, lai katrai zobu atlasei būtu dažādi piemēri.

 Šajā piemērā esam izvēlējušies 13. zobu, un pozicionēšanas palīgs jums parādīs, kā izmantot turētāja komplektu
un kā pozicionēt sensoru pacienta mutē. 

Ja tiek izvēlēts 18. zobs, parādīsies cits attēls, kurā parādīts, kā izvietot sensoru šim zobam.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

112

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Jums ir iespēja skatīt pozicionēšanas palīgu pilnekrāna režīmā. Noklikšķiniet uz mazās ikonas pozicionēšanas
palīga labajā augšējā stūrī.

7.4 Darbs ar statusa paneli

Kas ir statusa panelis

Šajā tēmā mēs izskaidrosim pamatus alternatīvam veidam, kā strādāt ar attēliem.

Statusa panelis kopā ar attēlu bibliotēku ir veids, kā organizēt jūsu attēlus.

Attēlus var glabāt, mainīt vai dzēst statusa panelī vai attēlu bibliotēkā.

Statusa paneli var izmantot arī attēlu iegūšanas režīmā. Attēli tiks uzņemti lodziņos.
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Atšķirības starp attēlu bibliotēku un statusa paneli

Attēlu bibliotēka ir galvenais konteiners, kurā tiek glabāti attēli. Veiktās darbības ar Attēlu bibliotēkā
esošajiem attēliem ir pastāvīgas. Tas nozīmē, ka, izdzēšot attēlu Attēlu bibliotēkā, tiks izdzēsts arī attēls
Statusa panelī. Attēla noņemšana no statusa paneļa neizraisa attēla dzēšanu.

Darbam ar statusa paneli ir vairākas priekšrocības:

Jums ir iespēja automatizēt attēlu uzņemšanas procesu. Dažās zobārstu praksēs ir ieviesta
noteikta attēlu uzņemšanas procedūra. Piemēram, dažos gadījumos ir vispārpieņemta prakse,
ka tiek uzņemti pilnas mutes attēli. Šādā gadījumā ir ļoti ērti, ja to var automatizēt.
Vēl viena statusa paneļa izmantošanas priekšrocība ir tā, ka varat automātiski saistīt zobu vai
zobus ar attēlu. Attēla nosaukums atspoguļos zobu vai zobu piesaisti.
Statusa panelī var noteikt arī secību, kādā tiek uzņemti attēli.
Ja uzņemat intraorālos attēlus, ir iespējams arī mainīt attēla orientāciju (pagriezt par 90° vai
apvērst horizontāli vai vertikāli) statusa paneļa lodziņā neatkarīgi no sākotnējā attēla.

7.4.1 Darbs ar statusa paneli un attēlu bibliotēku

Šajā sadaļā mēs izskaidrosim, kā jūs varat izmantot statusa paneli. Sniegsim pārskatu par ekrāna elementiem
un izskaidrosim statusa paneļa vadīklas un apakšizvēlni.

Mēs arī parādīsim, kā var pārvietot attēlus no attēlu bibliotēkas uz statusa paneļa lodziņiem.

1. Kā aktivizēt statusa paneli

Ir 2 veidi, kā aktivizēt statusa paneli 

Darbība Paskaidrojums

Mediadent izvēlnē izvēlieties

Display > Desktop Panels >

Ja neesat pārliecināti, kādā veidā statusa panelis var jums palīdzēt, varat
izlasīt šo sadaļu: Statusa panelis.
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Mount View

-vai-

Ikonu kopā izvēlieties ikonu

Statusa panelis parādīsies uz darbvirsmas, un jūs varēsiet apskatīt dažādos attēlus statusa panelī.

2. Pārskats par statusa paneļa ekrānu

Pacientu identifikācija

Statusa paneļa vadīklas. Jums būs iespēja sākt/pārtraukt secību, dzēst attēlus no statusa paneļa
lodziņiem, filtrēt attēlus un piekļūt statusa paneļa apakšizvēlnei. Uzziniet vairāk par statusa paneļa
vadīklām tēmā: Pārskats par statusa paneļa vadīklām.

Attēlu konteinera konfigurators: Šajā taisnstūrveida lodziņā ir 32 mazi lodziņi (jeb kvadrātiņi).
Katrs mazais lodziņš ir statusa paneļa lodziņš, kurā jūs ievelkat attēlu. Zaļais indikators nozīmē, ka
lodziņš ir aktīvs statusa panelī. Tas tiks izmantots, ja vēlaties izveidot savu statusa paneli. Sk.
tēmu "Kā izveidot statusa paneli" (Section 8.5.1).

Statusa paneļa atlasītājs. Jūs varēsiet atlasīt citu statusa paneli. Pēc noklusējuma ir pieejamas
vairākas statusa paneļa shēmas, piemēram, AAO, kas ir Amerikas Ortodontu asociācijas statusa
panelis. Jūs varēsiet atlasīt citu statusa paneli.

Ekrānā redzēsiet vairākus lodziņus, kuros var parādīties attēli. Kā aktivizēt šos lodziņus un mainīt to
konfigurāciju, lasiet sadaļā "Kā izveidot statusa paneli" (Section 8.5.1).

Š Š
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Šī izvelkamā izvēlne ļauj izveidot secību. Šo secību izmanto, iegūstot attēlus statusa panelī. Sk. tēmu
Darbs ar statusa paneli attēlu iegūšanas režīmā (Section 7.4.2)).

3. Pārskats par statusa paneļa vadīklām

Dialoglodziņa augšējā labajā stūrī atrodas statusa paneļa vadīklas.

Secības sākšana/apturēšana

Ikona Start/Stop ļauj uz laiku apturēt secību attēlu uzņemšanas laikā.
To izmanto, kad izmantojat statusa paneli attēlu iegūšanas režīmā. Lai
uzzinātu vairāk par to, kā izmantot statusa paneli attēlu iegūšanas
režīmā, izlasiet sadaļu: Darbs ar statusa paneli attēlu iegūšanas
režīmā (Section 7.4.2)).

Dzēšana

Šī ikona tiek izmantota tāpat kā attēlu bibliotēkā. Velkot attēlu uz
ikonas Dzēst (Delete), attēls tiks dzēsts. Sk. tēmu "Darbs ar attēlu
bibliotēku" (Section 7.5.4).

Filtrēšana

Šī ikona ļauj filtrēt dažādus attēlus, piemēram, attēlus, kas uzņemti
noteiktā datumā. Tā ļauj meklēt attēlus un atlasīt atbilstošos attēlus,
pamatojoties uz datumu, kategoriju, lietotāju, veidu un
atslēgvārdiem. Ikonas lietošana ir aprakstīta tēmā "Attēlu
meklēšana" (Section 8.3.3).

Apakšizvēlne

Lai parādītu statusa paneļa apakšizvēlni, noklikšķiniet uz mazās
bultiņas statusa paneļa dialoglodziņa labajā augšējā stūrī.

Šīs izvēlnes opcijas tiek izmantotas, ja vēlaties izveidot savu statusa
paneli.

Šo opciju skaidrojums ir sniegts tēmā: "Kā izveidot statusa paneli"
(Section 8.5.1).

4. Attēla pārvietošana no attēlu bibliotēkas uz statusa paneļa lodziņu

Jums ir iespēja pārvietot attēlu no attēlu bibliotēkas uz kādu no statusa paneļa lodziņiem.

Darbība Paskaidrojums

Display > Desktop Panels > Mount View

vai

Ja jūsu darbvirsmā nav statusa paneļa
ekrāna, vispirms jāaktivizē statusa panelis,
izmantojot izvēlni vai ikonu, kas atrodama
ikonu kopā.
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Atlasiet attēlu Attēlu bibliotēkā un
velciet un turiet kreiso peles pogu un
norādiet uz vēlamo statusa paneļa lodziņu.
Atlaižot peli, attēls parādīsies statusa
paneļa lodziņā.

Atkārtojot šo procesu ar citiem attēliem,
jums ir iespēja vilkt un nomest vairāk nekā
1 attēlu tajā pašā statusa paneļa lodziņā.

Noklikšķinot uz mazajām bultiņām, jūs
varēsiet aplūkot dažādus attēlus, kas
piesaistīti konkrētajam statusa paneļa
lodziņam.

Vēl viena norāde ir + zīme blakus zoba
numuram. Tā ir norāde, ka šim statusa
paneļa lauciņam ir piesaistīti vairāki attēli.

5. Darbības ar attēliem statusa lodziņā

Kad attēls ir ievietots statusa lodziņā, ar šiem attēliem ir iespējams veikt vairākas darbības. Attēlu var pagriezt,
noņemt attēlu no statusa lodziņa, apvērst horizontāli vai vertikāli un mainīt attēla rekvizītus.

Darbība Paskaidrojums

Atlasiet attēlu statusa lodziņā Noklikšķiniet uz attēla statusa lodziņā, lai to atlasītu. Jūs
pamanīsiet, ka attēls ir atlasīts, jo fona krāsa ir mainījusies.

Noklikšķiniet ar labo peles pogu uz atlasītā
attēla.

Parādīsies izvēlne                     Šajā izvēlnē varēsiet veikt darbības ar attēliem.
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No šīs izvēlnes varat arī nosūtīt attēlu pa e- pastu un
atvērt failu Windows failu pārlūkā tālākai izpētei.

                   
Uzziniet, kā statusa panelis var jums palīdzēt ietaupīt laiku attēlu iegūšanas režīmā: izlasiet sadaļu:
Darbs ar statusa paneli attēlu iegūšanas režīmā (Section 7.4.2).

Varbūt vēlaties izveidot savu statusa paneli? Izlasiet sadaļu: "Kā izveidot statusa paneli" (Section
8.5.1).

7.4.2 Darbs ar statusa paneli attēlu iegūšanas režīmā

Vislielākās priekšrocības darbā ar statusa paneli ir tad, ja to izmanto attēlu iegūšanas režīmā.

Attēlu iegūšanas režīmā jūs varēsiet automātiski uzņemt attēlus noteiktā secībā, automātiski piesaistīt attēlam zobus vai
zobu.

Jo īpaši lielās zobārstniecībās, kuros ir vairāk ārstu, tas ļaus standartizēt attēlu uzņemšanas veidu.

Katrs ārsts varēs izmantot vienu un to pašu statusa paneli, lai katram pacientam tiktu uzņemts standarta attēlu komplekts.

Šajā sadaļā mēs izskaidrosim, kā jūs varat izmantot statusa paneli attēlu iegūšanas režīmā, kā arī to, kā izvēlēties citu
statusa paneli un to izmantot.

 Turpmākajos soļos ir izskaidrots, kā aktivizēt statusa paneli attēlu iegūšanas režīmā un kā to izmantot 3 attēlu
uzņemšanai.

Atcerieties, ka statusa paneļa attēlu iegūšanas ekrāna ekrānuzņēmumi var atšķirties no jūsu darba vides. Lai izpildītu
šos soļus, Mediadent izvēlnē izvēlieties Demo Sensor. Options>X-Ray Acquisition>X-Ray Demo Sensor.

Darbība Paskaidrojums

 Mediadent izvēlnē izvēlieties File > Acquire FMX Ja vēlaties
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-vai-

Ikonu kopā noklikšķiniet uz ikonas.

izmantot statusa
paneli attēlu
iegūšanas režīmā,
varat izmantot
Mediadentizvēlni
vai izvēlēties
ikonu, kas
atrodama ikonu
kopā.

FMX ir
saīsinājums no
"Full Mount X-
ray".

1. Pārskats par attēlu iegūšanas ekrānu

Attēlu iegūšanas dialoglodziņā ir 3 daļas:

zobu shēma

skatvieta

statusa panelis

Statusa panelī redzēsiet dažādus statusa paneļa lodziņus ar lieliem un maziem skaitļiem tajos.

Lielie skaitļi ir secība, kādā tiks uzņemti attēli. Mazie skaitļi ir zobu shēmā sagatavotā zoba
piesaiste.

.

2. Cita statusa paneļa izvēlēšanās
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Jūs varat
pārbaudīt vai
izvēlēties citu
statusa paneli.
Izvēlētais statusa
panelis noteiks
secību un zoba
piesaisti.

Kad esat
izvēlējušies
statusa
paneli un
uzsākuši
attēlu
iegūšanas
procesu,
secību vai
zoba
piesaisti
vairs
nevar
mainīt.

Programmatūrā neko nemainot, attēli automātiski parādīsies lodziņos pareizā secībā.
Jums būs nepieciešams tikai pareizi pozicionēt attēlu iegūšanas ierīci..

Pozicionējiet
attēlu iegūšanas
ierīci un
noklikšķiniet uz
"Grab" pogas.

Jūs redzēsiet, ka
1. lodziņā
parādās attēls.

Šim attēlam
piesaistītais zoba
numurs ir 12-
22.

Noklikšķiniet uz
"Grab" pogas.
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Attēls automātiski
parādīsies
lodziņā nr. 2.
Piesaistītais zobs
ir zobs Nr. 42-
32.

Attēli tiks
saglabāti
attēlu
bibliotēkā.
Ievērojiet, ka
attēlu
nosaukumi
ir zobi, kas
tika
piesaistīti
statusa
paneļa
lodziņos.

Kad
aktivizēsiet
statusa
paneli,
statusa
panelī
redzēsiet
attēlus.

3. Automātiska zoba/zobu piesaiste, izejot no attēlu iegūšanas ekrāna

Izejot no šī ekrāna, jūs
varēsiet saglabāt attēlus.
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Jums ir iespēja Saglabāt
visus attēlus.

Ja jūs neapmierina ar attēla kvalitāte un vēlaties atkārtoti iegūt attēlu tajā pašā statusa paneļa lodziņā, jums ir iespēja
APTURĒT secību.

Noklikšķiniet uz Stop ikonas,   lai apturētu secību un atkārtoti iegūtu attēlu.

Ja vēlaties turpināt, noklikšķiniet uz Stop ikonas, un, iegūstot nākamo attēlu, tas parādīsies nākamajā statusa paneļa
lodziņā.

Pārliecinieties, ka, iegūstot jaunu attēlu tajā pašā statusa montāžas lodziņā, programmatūrā netiek parādīts
brīdinājuma ziņojums. Ja vienā statusa montāžas lodziņā vēlaties iegūt vairākus attēlus un tiek parādīts brīdinājuma
ziņojums, sazinieties ar izplatītāja atbalsta dienestu.

7.4.3 Darbs ar pilnekrāna statusa paneli

Veicot izmaiņas pilnekrāna statusa panelī, vispirms atjaunojiet statusu pilnekrāna statusa panelī.
Neaizmirstiet saglabāt sākotnējo iestatījumu failu pirms izmaiņu apskates pilnekrāna statusa panelī.

Viena no priekšrocībām, strādājot ar statusa paneli, ir iespēja izmantot pilnekrāna statusa paneli. Šī opcija
parādīs statusa panelī esošos attēlus, un to var izmantot, lai apspriestu ārstēšanas plānus.

Šīs opcijas priekšrocības:

Strukturētā veidā kopīgojiet attēlus ar pacientiem un citiem zobārstiem
Organizējiet attēlus pilnekrāna statusa panelī
Strukturētā veidā saglabājiet pacienta vēsturi attēlu bibliotēkā
Izdrukājiet pilnu statusu un nododiet to pacientam un/vai zobārstam

Pilnekrāna statusa paneļa izkārtojums ir saistīts ar aktīvo statusa paneli. Pārbaudiet aktīvo statusa paneli,

noklikšķinot uz statusa paneļa ikonas 

Tiek parādīts aktīvais statusa panelis.
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Šobrīd jums ir iespēja mainīt statusa paneli vai vilkt un nomest citus attēlus uz statusa paneļa vietturiem. Lai
saprastu, kā darbojas statusa panelis, izlasiet sadaļu Darbs ar statusa paneli (Section 7.4).

Kad esat pārliecināti par izkārtojumu, izvēlieties pilnekrāna statusa paneļa ikonu: 

Atvērsies pilnekrāna statusa paneļa ekrāns. Jūs redzēsiet statusa paneļa vietturus ar attēliem

Šajā ekrānā varēsiet:

Eksportēt izkārtojumu uz pacienta mapi
Eksportēt izkārtojumu uz bitkarti - bitkarti vēlāk var nosūtīt pacientam vai zobārstam
Drukāt
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Šajā konfigurācijas ekrānā jūs varēsiet pārvietot statusa paneļa vietturus uz citu vietu, pievienot sava
uzņēmuma logotipu, pievienot informāciju par pacientu. Pēc tam šī informācija parādīsies izdrukā
vai eksportētajā bitkartē.

1. Darbības ar statusa paneļa vietturi

Ir iespējams pielāgot vietturus un mainīt attēla pozīciju vietturī.

Lai pārvietotu vietturi uz citu vietu, velciet un nometiet vietturi, nospiežot taustiņu CTRL un pārvietojot
vietturi.
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Šajā piemērā mēs pārvietosim statusa paneļa vietturus, lai starp dažādiem attēliem būtu nedaudz vairāk vietas.
Pieņemsim, ka vēlamies vēlāk pievienot informāciju par savu uzņēmumu.
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Statusa vietturu ietvaros jūs varēsiet pārvietot attēlus.

Atlasiet vietturi (noklikšķinot uz viettura).

Nospiediet un turiet peles labo pogu un pārvietojiet attēlu vietturī.

Šajā piemērā esam pārvietojuši attēlus iepriekš minētajos vietturos.
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Varbūt vēlaties palielināt attēlu vietturī.

Lai to izdarītu, ritiniet ar peles ritenīti uz augšu un uz leju. 

Ritināšana UZ AUGŠU padarīs attēlu mazāku.

Ritināšana UZ LEJU padarīs attēlu lielāku.
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Apvienojiet to ar pareizu attēla novietojumu vietturī. Šādā veidā attēls aizpildīs visu vietturi.

2. Uzņēmuma logotipa un informācijas pacientiem pievienošana

Šajā tēmā mēs izskaidrosim, kā pilnekrāna statusa panelim pievienot uzņēmuma logotipu un informāciju
pacientiem.

Priekšrocības:

Pilnekrāna statusa paneļa mērķis ir dalīties ar attēliem ar pacientiem un citiem zobārstiem; pievienojot
uzņēmuma logotipu pilnekrāna statusa panelim, tiks uzlabota jūsu atpazīstamība un pacientiem un zobārstiem
tiks sniegta papildu informācija par jūsu zobārstniecības praksi.

Lai pievienotu savas zobārstniecības prakses logotipu, jums būs jāveic iestatīšana.

Veiciet šādas darbības:

1. Choose Options > Setup

2. Ierakstiet "Full Status Print" meklēšanas lodziņā
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 3. Noklikšķiniet uz moduļa "StatusFullScreen" lodziņa.

4. Tiks atvērta moduļa StatusFullScreen iestatīšana.
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5. Noklikšķiniet uz ikonas, lai atvērtu failu pārlūku un atlasītu failu ar jūsu logotipu.

Izvēlieties "Open", lai atlasītu.
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6. Kad logotips ir ielādēts iestatīšanas ekrānā.

Izvēlieties "Save Changes" un "Exit", lai saglabātu izmaiņas un aizvērtu ekrānu.

7. Pārejiet uz "Pilna ekrāna statusa" izdruku

8. Tagad logotips būs jāpievieno "Pilna ekrāna statusa" izdrukai.

Izvēlieties Options > Presentfile un atlasiet "Print Logo Floater".

Tiks parādīts logotips.
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Pārvietojiet logotipu uz pareizo pozīciju. Izmantojiet taustiņu Ctrl un velciet un nometiet logotipu vēlamajā
vietā.
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Pēc tam šo attēlu var izdrukāt vai eksportēt uz disku vai pacienta mapi.

7.5 Darbs ar attēlu bibliotēku
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7.5.1 Attēla rekvizītu pārskats

Attēla rekvizīti var sniegt interesantu informāciju par attēlu. Tie parādīs dažādas birkas (atslēgvārdi...), kas ir
piesaistītas jūsu attēlam.

Lai labāk izprastu papildu informāciju un atslēgvārdus, ko varat piesaistīt attēlam, izlasiet sadaļu Papildu
informācijas un atslēgvārdu norādīšana (Section 7.5.2).

Ne tikai saglabājot attēlu, jūs varat attēlam piesaistīt papildu informāciju un atslēgvārdus - arī izmantojot
sadaļu Attēla rekvizīti, jūs varat mainīt/papildināt papildu informāciju vai atslēgvārdus.

Šajā sadaļā uzzināsiet, kā parādīt Attēla rekvizītus un kā attēlam var piesaistīt atslēgvārdu.

Darbība Paskaidrojums

1. Dodieties uz attēlu bibliotēku un izvēlieties attēlu. Lai parādītu
attēla rekvizītus,
jums ir jāizvēlas
attēls attēlu
bibliotēkā.

2. Noklikšķiniet ar peles LABO pogu uz attēla. Svarīgi ir
noklikšķināt ar
peles LABO
pogu. Parādīsies
nolaižamā
izvēlne, kurā var
izvēlēties Attēla
rekvizītus (Image
Properties).

3. Izvēlnē izvēlieties Attēla rekvizīti (Image Properties). Lai uzzinātu

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

134

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



vairāk par
dažādajām
opcijām šajā
dialoglodziņā,
izlasiet sadaļu
"Papildu
informācijas
un atslēgvārdu
norādīšana"
(Section 7.5.2).

Dialoglodziņā
Attēla rekvizīti
varat arī mainīt
vērtības vai
pievienot
atslēgvārdus.

Piemērs: Piesaistiet attēlam atslēgvārdu "TEST".

4. Izvēlieties cilni "Atslēgvārdi".

5. Atzīmējiet atslēgvārdu "TEST" .

 

Šajā gadījumā
attēlam
piesaistīsim
atslēgvārdu
"TEST", lai
vēlāk varētu to
izmantot uzziņai.

6. Saglabājiet attēla rekvizītus. .

Jūs varat noteikt, kurus atslēgvārdus var piesaistīt. Par to uzzināsiet sadaļā Displeja iestatījumi (Section
10.5).

7.5.2 Pārskats par konkrētu papildu informāciju un atslēgvārdiem
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Saglabājot attēlu, varat pievienot papildu informāciju.

Papildu informācijas pievienošanas priekšrocība ir tā, ka, meklējot attēlus, jūs varat viegli meklēt/filtrēt pēc
attēlam pievienotās papildu informācijas.

Lai pievienotu papildu informāciju un atslēgvārdus attēliem, veicot saglabāšanu, ir jāatzīmē opcija "Specify
Extra Info & Keywords" (Norādīt papildu informāciju un atslēgvārdus).

Ekrāns tiks paplašināts, un jūs redzēsiet 2 cilnes

Papildu informācija
Atslēgvārdi

1. Papildu informācijas lauks

Jūs varat brīvi izmantot "Extra Info" (Papildu informācija) laukus pēc saviem ieskatiem. Šo lauku interpretācija ir
atkarīga no tā, kā vēlaties klasificēt attēlus. Ja vēlaties meklēt pēc noteiktiem atslēgvārdiem, varat izmantot šos
atslēgvārdus laukos "Extra Info" (Papildu informācija).  
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Cilnē "Extra Info" (Papildu informācija) varat pievienot šādu informāciju:

User (Lietotājs)
Varat izmantot lauku "User"
(Lietotājs), lai norādītu,
piemēram, zobārstu, kurš
uzņēmis attēlu.

Programmas
Mediadentiestatīšanā varat
noteikt lietotāju sarakstu.

Sk. tēmu Mediadent iestatīšana:
Displeja iestatījumi.

Grade (Kategorija) Šo lauku var izmantot kā sava veida
attēlu klasifikāciju. Standarta
kategorijas ir A, B un C.

To var pielāgot, izmantojot
Mediadent iestatīšana: Displeja
iestatījumi.

Image Type (Attēla veids) Šeit varat norādīt attēla veidu.
Instalējot programmu, jau ir pieejami
vairāki sākotnējie iestatījumi.

To var pielāgot, izmantojot
Mediadent iestatīšana: Displeja
iestatījumi.

Teeth (Zobi) Izmantojot šo informācijas lauku, varat
norādīt zobus vai zobu, kas ir saistīti
ar attēlu.

Comments (Komentāri) Brīvs komentāru lauks, ko varat
izmantot, lai pievienotu papildu
informāciju par attēlu.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

137

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



2. Keywords (Atslēgvārdi)

Cilne Keywords (Atslēgvārdi) ļauj pievienot attēlam papildu atslēgvārdus. Šo atslēgvārdu mērķis ir iespēja
meklēt pēc atslēgvārdiem un atrast saistītos attēlus.

Lai pievienotu atslēgvārdu, izpildiet šādas darbības:

1. Ierakstiet atslēgvārdu lodziņā. Šajā piemērā atslēgvārds ir ENDO .

2. Noklikšķiniet , lai apstiprinātu.

Atslēgvārds ENDO tagad ir piesaistīts attēlam.

Tas nozīmē, ka tagad varat meklēt atslēgvārdu ENDO un atrast saistīto attēlu.

Vienmēr SAGLABĀJIET attēlu pēc tam, kad pievienojat papildu informāciju vai atslēgvārdus.

7.5.3 Pārskats par attēlu bibliotēkas mapes vadīklām

Attēlu bibliotēkas mapes vadīklas ļauj ātri veikt vairākas darbības:

- Dzēst attēlus

- Tieši nosūtīt attēlus

- Meklēt konkrētus attēlus bibliotēkā

- Šķirot attēlu bibliotēkā esošos attēlus

Atlasiet attēlu un noklikšķiniet uz dzēšanas (Delete) ikonas.
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Izvēlieties attēlu vai attēlus, kurus vēlaties nosūtīt, un noklikšķiniet uz sūtīšanas (Send) elementa.
Šajā īsajā video ir izskaidrots, kā nosūtīt attēlu tieši no attēlu bibliotēkas: Noklikšķiniet šeit

Izlasiet arī šādu sadaļu: Kā nosūtīt attēlu pa e-pastu (Section 8.6.1)

Vai meklējat konkrētus attēlus attēlu bibliotēkā? Izlasiet sadaļu: Kā meklēt attēlus (Section
8.3.3)

Skatiet attēlus noteiktā secībā. Izlasiet sadaļu: Attēlu secības maiņa (on-line documentation)

7.5.4 Darbs ar attēlu bibliotēku

Šajā sadaļā izskaidrosim attēlu bibliotēkas izmantošanu.

Attēlu bibliotēkā tiks parādīti attēli, kas uzņemti konkrētajam pacientam.

Šeit sniegsim pārskatu par attēlu bibliotēkas elementiem.

1. Attēlu bibliotēkas elementu pārskats

Šī attēlu bibliotēka: 

       

Globālā attēlu bibliotēka

Pacienta attēlu bibliotēka

Uzziniet vairāk par atšķirībām tēmā Globālā un pacienta bibliotēka (Section 12.4)

Arhīva bibliotēka. Vairāk informācijas par arhīva bibliotēkas lietošanu un iestatīšanu lasiet tēmā Kā
arhivēt attēlus programmā Mediadent (Section 7.5.5). 

Apakšdirektoriji vai mapes satur pacientu attēlus. Labākai attēlu organizēšanai varat izveidot jaunas
mapes.

Atkarībā no izvēlētās mapes jūs redzēsiet attiecīgajam pacientam uzņemtos attēlus.

Zobu shēma parādīs, kuri attēli ir uzņemti konkrētajam pacientam. Saglabājot attēlu, jūs varēsiet
piesaistīt zobus vai zobu.

Mapes vai direktorija vadīklas: 

Jūs varēsiet dzēst attēlus, sūtīt attēlus, izmantojot instalēto e-pasta programmu, meklēt attēlus un
šķirot attēlus attēlu bibliotēkā.
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Sīkāku paskaidrojumu meklējiet šajā sadaļā:

Pārskats par attēlu bibliotēkas mapes vadīklām (Section 7.5.3)

Ritjosla: Ja mapē ir vairāk attēlu, nekā var parādīt uz ekrāna, varat ritināt pa labi vai pa kreisi, lai
redzētu attēlus.

 Mazais lineāls uz attēla norāda, ka attēls NAV kalibrēts.

 

2. Pacientu bibliotēkas struktūra

Pacienta direktorijā ir jūsu uzņemtie attēli.

Saknes direktorijs ir numurs, šajā piemērā 1011.

Iekavās redzams attēlu skaits apakšdirektorijā vai mapē. Šajā gadījumā (24) nozīmē, ka šajā mapē ir 24 attēli.

Attēlus apakšmapēs varat iedalīt kategorijās, piemēram, pēc veida.

Šajā piemērā redzami vairāki apakšdirektoriji:

Cosmetic (4): ar 4 attēliem
D.F.O. (5) : ar 5 attēliem
Ortho (8): ar 8 attēliem
other (4): ar 4 attēliem
Pano-Ceph (8): ar 8 attēliem
Video (3): ar 3 attēliem

3. Atlasiet mapi

Noklikšķiniet uz mapes, kuru vēlaties atlasīt.

4. Vairāku attēlu atlase

Lai atlasītu vairākus attēlus, noklikšķiniet uz pirmā attēla un nospiediet taustiņu Shift. Turot nospiestu
taustiņu Shift, atlasiet papildu attēlus.
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4. Attēlu apzīmējumi (krāsainas joslas/līnijas attēlu augšpusē)

Jūs pamanīsiet mazas krāsainas līnijas vai joslas attēla augšpusē.

Katrai krāsai ir sava nozīme. Šajā tabulā ir sniegts dažādu līniju vai joslu skaidrojums.

Maza zaļa līnija attēla augšpusē ir norāde, ka ir anotācijas šim attēlam.

HDX ir attēla nosaukums. Šo nosaukumu piešķirsiet, kad saglabāsiet attēlu.

Maza sarkana līnija attēla augšpusē ir norāde, ka konkrētais attēls ir oriģinālais attēls.

​ Dzeltena līnija norāda, ka attēls ir pārveidots. Ja esat mainījuši attēla kontrastu/spilgtumu,
to norāda dzeltena līnija.

Maza zila līnija attēla augšpusē ir norāde, ka ir pieejama dentofaciālās ortopēdijas analīze
par šo attēlu.

Mazais simbols uz attēla nozīmē, ka attēls NAV kalibrēts. Lai uzzinātu, kā kalibrēt attēlu,
izlasiet šo sadaļu: Kā kalibrēt attēlu (Section 8.4.2).

5. Jauna apakšdirektorija vai apakšmapes izveidošana

Darbība Paskaidrojums

1. Lai izveidotu jaunu apakšdirektoriju, vispirms atlasiet ​ saknes direktoriju,
by noklikšķinot uz tā.

Piemēram:
Noklikšķiniet uz 1011
(24)
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2. Noklikšķiniet ar peles labo pogu uz saknes direktorija, lai atvērtu izvēlni.

3. Izvēlieties Add folder

4. Dodiet apakšdirektorijam nosaukumu. Piemēram: Example

5. Noklikšķiniet uz   , lai apstiprinātu.
.

Jaunais
apakšdirektorijs ir
izveidots un
parādīsies sarakstā.

Jums ir iespēja automātiski izveidot vienādu struktūru visiem pacientiem. Tas nozīmē, ka katram
pacientam būs vienādi apakšdirektoriji. Jūs atradīsiet skaidrojumu par tos sadaļā Mediadent iestatīšana:
Displeja iestatījumi

6. Attēla pārvietošana vai kopēšana uz citu mapi

PĀRVIETOT UN KOPĒT

Noklikšķiniet uz attēla ar peles
kreiso pogu, TURIET UN
VELCIET attēlu uz citu
apakšdirektoriju.

Jūs pārvietosiet attēla kopiju uz
citu apakšdirektoriju, velkot un
nometot attēlu ar peles kreiso
pogu.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

142

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



TIKAI PĀRVIETOT

Noklikšķiniet uz attēla ar peles
kreiso pogu, TURIET, nospiediet
SHIFT taustiņu un VELCIET
attēlu uz citu apakšdirektoriju.

 +

7. Attēlu dzēšana

Ir divi veidi, kā izdzēst attēlu.

Darbība Paskaidrojums

1. Atlasiet attēlu, kuru vēlaties dzēst

2. Velciet un nometiet attēlu uz atkritnes
ikonas attēlu bibliotēkā

3. Izvēlieties OK brīdinājuma dialoglodziņā, lai
apstiprinātu

Attēlu velciet un nometiet, vienlaikus nospiežot un turot
peles KREISO pogu, lai pārvietotu attēlu uz atkritni.

1. Ievietojiet attēlu, kuru vēlaties dzēst, skatvietā

2. Izvēlnē Edit>Delete Image from disk

3. Noklikšķiniet OK , lai apstiprinātu

Tādējādi attēls tiks dzēsts neatgriezeniski.

Jūs varat no tā izvairīties, izvēloties opciju 'Delete files
to recycle bin' ("Dzēst failus uz atkritni") Mediadent
iestatīšanā.

7.5.5 Kā arhivēt attēlus programmā Mediadent

Pamatojoties uz galalietotāju atsauksmēm, attēlu bibliotēkai ir pievienots arhivēšanas rīks. Tas sniegs iespēju
labāk organizēt pacienta attēlu bibliotēku.

Vecus attēlus var nosūtīt uz arhīva mapi pēc jūsu izvēles. Šī mape vienmēr ir pieejama attēlu bibliotēkas mapē.

Šajā tēmā uzzināsiet, kā iestatīt arhīva mapi un kā izmantot arhīva mapi no pacienta attēlu bibliotēkas.
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1. Kā iestatīt arhīva mapi
Mediadent iestatīšanā jūs noteiksiet, kur atrodas arhīva mape.

Šajā nodaļā mēs izskaidrosim, kā iestatīt arhīva mapi un kā noņemt arhīva mapi.

1. Arhīva mapes iestatīšana

Veiciet darbības, lai noteiktu arhīva mapes atrašanās vietu:

1. Izvēlieties Options > Setup

Sadaļā General Settings (Vispārīgie iestatījumi)  izvēlieties cilni Display settings (Displeja

iestatījumi)

Cilnē Display Settings izvēlieties cilni Archive Settings (Arhīva iestatījumi)

 Nosakiet arhīva atrašanās vietu  . Varat izvēlēties vairākas atrašanās vietas.

2. Lai izvēlētos atrašanās vietu, noklikšķiniet uz mapes ikonas   , tiks atvērts failu pārlūks, un jūs varēsiet

izvēlēties arhīva mapi  .
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3. Mape tiek pievienota arhīva mapju sarakstam.

Neaizmirstiet nospiest "Save Changes" pirms iziešanas no iestatīšanas loga.

 2. Arhīva mapes noņemšana

Jūs vienmēr varat noņemt arhīva mapi. Tas nenozīmē, ka arhīva mapē glabātie attēli tiks dzēsti. Tas ir tikai veids,
kā izņemt mapi no pieejamo vietu saraksta.

Tātad attēli joprojām būs pieejami šajā atrašanās vietā, bet lietotājs to vairs nevarēs izvēlēties no
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pieejamo vietu saraksta.

1. Izvēlieties Options > Setup

Sadaļā General Settings (Vispārīgie iestatījumi) izvēlieties cilni Display Settings (Displeja iestatījumi).

Sadaļā Display Settings (Displeja iestatījumi) izvēlieties cilni Archive Settings (Arhīva iestatījumi).

 

2. Atlasiet mapi, kuru vēlaties noņemt, no pieejamo arhīva vietu saraksta . Šajā piemērā mēs izvēlamies
"c:\temp".

3. Noklikšķiniet uz ikonas  , lai noņemtu ierakstu no saraksta.

Neaizmirstiet nospiest "Save Changes" pirms iziešanas no iestatīšanas.

2. Kā nosūtīt attēlu uz arhīva mapi
Attēlu nosūtīšana uz arhīva mapi ir ļoti vienkārša!

Atlasiet 1 vai vairākus attēlus.

Lai atlasītu vairākus attēlus, noklikšķiniet uz pirmā attēla un nospiediet taustiņu Shift. Turot nospiestu taustiņu
Shift, atlasiet papildu attēlus.

Kad esat atlasījuši attēlu vai attēlus, ko vēlaties arhivēt, varat noklikšķināt uz arhivēšanas ikonas.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

146

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Ja esat izveidojuši sarakstu ar vietām, kur attēlus var arhivēt: noklikšķiniet ar peles labo pogu uz

arhivēšanas ikonas un izvēlieties vēlamās vietas .

7.5.6 Attēla noklusējuma nosaukuma norādīšana

Ir iespējams mainīt attēla noklusējuma nosaukumu.

Jūs varēsiet ietaupīt laiku, saglabājot attēlus, ja izvēlēsieties izmantot noklusējuma nosaukumu katrai rentgena
ierīcei.

Piemēram, ja uzņemat panorāmas attēlu, varat izvēlēties, ka attēla noklusējuma nosaukums ir PAN.

Ja uzņemat intraorālo attēlu, varat izvēlēties, ka noklusējuma nosaukums ir IO.

Šajā piemērā mēs izmantosim demonstrācijas (demo) sensoru un piešķirsim tam noklusējuma nosaukumu
"demosensor".

Tas nozīmē, ka katru reizi, kad uzņemat attēlu, attēla saglabāšanai tiks izmantots nosaukums "demosensor.

Turpmākajos soļos redzēsiet, kā to iestatīt.

1. Uzņemiet attēlu (šajā gadījumā mēs izmantosim demonstrācijas sensoru).
2. Noklikšķiniet uz Grab
3. Noklikšķiniet uz Exit
4. Tiek parādīts dialoglodziņš attēla saglabāšanai

Šajā dialoglodziņā redzēsiet opciju:

"Specify Extra info, Keywords and Default name" (Norādīt papildu informāciju,
atslēgvārdus un noklusējuma nosaukumu)
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5. Atlasiet šo opciju 

Kad šī opcija ir aktīva, ir pieejamas 3 opcijas, no kurām varat izvēlēties

- Extra info (Papildu informācija) un Keywords (Atslēgvārdi): atklājiet iespējas: Pārskats par
konkrētu papildu informāciju un atslēgvārdiem (Section 7.5.2)

- Default Image name (Noklusējuma attēla nosaukums): noklikšķiniet uz šīs opcijas

 

Šeit varat aizpildīt "Default Image name" (Noklusējuma attēla nosaukums) - pēc tam, kad
esat ievadījuši noklusējuma nosaukumu šai rentgena ierīcei.

Šis nosaukums tiks izmantots, saglabājot attēlu, kas uzņemts ar šo rentgena ierīci. 
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Šajā piemērā kā noklusējuma nosaukumu mēs esam izvēlējušies "demosensor".

Daži piemēri: "PAN" panorāmas attēliem, "CEPH" cefalometriskajiem attēliem, "IO" intraorālajiem attēliem" utt.

Lai apstiprinātu šo opciju, izvēlieties Save (Saglabāt). 

Rezultātā ikreiz, kad uzņemsiet attēlu ar demonstrācijas (Demo) sensoru, tiks izmantots noklusējuma nosaukums
"demosensor".

7.6 Darbs ar Mediadent moduļiem
 

7.6.1 Darbs ar Reporter moduli

Reporter modulis ir papildu modulis, kas ļauj jums izveidot standarta vēstules, kuras var izmantot, lai nosūtītu informāciju
pacientiem, ārstiem, slimnīcām u.c.

Šis modulis tiek tirgots atsevišķi. Lai iegūtu vairāk informācijas par šo moduli, vienmēr varat sazināties ar mums (Section 13).

Priekšrocības, ko sniedz darbs ar Reporter moduli:

- Tas ir praktisks modulis, jo piedāvā standarta teksta apstrādes iespējas, neatstājot Mediadent.

- Visa saistītā sarakste tiek saglabāta pacienta lietā. Tas atvieglo pacienta vēstures izsekošanu. Daži sarakstes piemēri ir nosūtījuma
vēstules, dokumenti apdrošināšanai, uzaicinājumi uz konsultācijām u.c.

- Programmā Mediadent izveidotajā standarta dokumentā ir fiksēts teksts, ko var atkārtoti izmantot visiem pacientiem. Standarta
dokumentā var būt jūsu logotips, adrese un standarta teksts, kas ir specifisks šim dokumentam. Šo standarta dokumentu programmā
Mediadent sauc par veidni. Priekšrocība ir tā, ka jums nav atkārtoti jāraksta fiksētais teksts, bet tikai jāaizpilda mainīgais teksts,
piemēram, pacienta diagnozes. Tajā var būt arī informācija, kas glabājas jūsu pacientu pārvaldības sistēmā, piemēram, pacienta vārds,
dzimšanas datums, adrese utt.

Vēlāk paskaidrosim, kā šo informāciju var iekļaut standarta vēstulēs (4. tēma: Kā integrēt veidnēs laukus no pacientu pārvaldības
sistēmas).

Šajā sadaļā palīdzēsim jums labāk izprast Reporter moduli pirmajā tēmā "Pārskats par Reporter moduli". Otrajātēmā uzzināsiet,
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kādas ir pamata funkcijas, strādājot ar Reporter moduli. Trešajā tēmā uzzināsiet, kā izveidot standarta dokumentu jeb veidni Reporter
modulī.

Reporter moduli ielādē, noklikšķinot uz ikonas Reporter  ikonu kopā.

-vai-

Izvēlieties File>Reporter  Mediadent izvēlnē.

Ja ikona spīd, tas nozīmē, ka Reporter modulī jau ir dokumenti par šo pacientu.

1. Pārskats par Reporter moduli

Report modulis piedāvā teksta apstrādes pamatiespējas programmā Mediadent, lai rakstītu vēstules, nosūtījumus u.c.

Izvēlnē ir lielākā daļa funkciju, ko var atrast teksta apstrādes programmā (teksta apstrādes ikonas).

Mēs izskaidrosim aspektus, kas ir unikāli Reporter modulim, bet mēs sīkāk neizskaidrosim teksta procesora pamatfunkcijas.

Ikonu joslā ir tradicionālās teksta apstrādes ikonas, piemēram, fonta veids, fonta lielums, fonta krāsa, treknraksts, slīpraksts,
pasvītrojums u.c., un tipiskās ikonas, kas saistītas ar Reporter moduli.

 Teksta apstrādes ikonas:

 

Reporter moduļa ikonas:

 

 Ekrāna vidusdaļā ir standarta dokuments jeb veidne ar fiksēto tekstu.

 Labajā pusē redzēsiet uzdevumrūti. Šajā rūtī ir saraksts ar standarta dokumentiem jeb veidnēm, no kurām varat izvēlēties.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

150

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Šis ir standarta dokumentu jeb veidņu saraksts.

Veidnes nosaukums, kas tiks izmantots dokumenta nosaukumam.

Ar pogu New (Jauns) tiks izveidots tukšs dokuments. Šo pogu var izmantot, ja
vēlaties izveidot dokumentu, neizmantojot veidni.

Ar pogu Close (Aizvērt) tiks aizvērta uzdevumrūts.

Switch to saved documents (Pārslēgties uz saglabātajiem dokumentiem)
parādīs sarakstu ar dokumentiem, kas jau ir izveidoti šim pacientam.

Ja vēlaties, lai Reporter modulis atvērtos ar konkrētu veidni, varat atlasīt veidni un atzīmēt opciju Open this template as
default (Atvērt šo veidni kā noklusējuma).

2. Pārskats par Reporter moduļa ikonām

Tiek parādīts statusa panelis, kas ļauj dokumentos pievienot attēlus no statusa paneļa.

Tiek parādīta attēlu bibliotēka, kas ļauj dokumentos pievienot attēlus no attēlu bibliotēkas.

Izdrukā dokumentu; šī ikona ir līdzvērtīga Quick print (Ātrā drukāšana) un izdrukā dokumentu standarta printerī.

Nosūta dokumentu kā pielikumu e-pastam. Jums ir nepieciešama e-pasta programma, kas ļauj nosūtīt e-pasta vēstules.

Šī ikona ļauj jums izveidot jaunu dokumentu, par pamatu izmantojot atlasīto veidni.

Šī ikona ļauj atvērt iepriekš izveidotu dokumentu, kas saistīts ar šo pacientu.

Noklikšķinot uz šīs ikonas, jūs saglabājat dokumentu.

Ar šo ikonu iziet no Reporter moduļa.

3. Darbs ar Reporter moduli

Šajā tēmā mēs izskaidrosim, kā strādāt ar Reporter moduli.

Vispirms izskaidrosim, kā izveidot dokumentu, par pamatu izmantojot uz esošās veidnes. Mēs arī parādīsim dažādās iespējas
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modificēt dokumentus, piemēram, pievienot gan attēlus, kas glabājas Mediadent, gan arī ārpus Mediadent.

Reporter moduļa automātiskā teksta (Auto Text) funkcija ļauj būtiski ietaupīt laiku. Tā ļaus jums izveidot sarakstu ar
saīsinājumiem, kas tiek automātiski aizstāti jūsu dokumentos. Piemēram, jūs varēsiet pievienot šim sarakstam tehnisko terminoloģiju.

Jūs, protams, vēlaties kopīgot šos dokumentus ar saviem pacientiem vai kolēģiem, tāpēc pēdējā tēmā mēs aplūkosim, kā jūs varat
nosūtīt dokumentu pa e-pastu, izdrukāt dokumentu vai saglabāt dokumentu PDF formātā.

3.1. Jauna dokumenta izveidošana, par pamatu izmantojot veidni

Darbība Paskaidrojums

Palaidiet Reporter moduli, noklikšķinot uz

ikonas 

vai

Izvēlieties File > ReporterMediadent izvēlnē

.

Lai izmantotu kādu no Reporter moduļa veidnēm,
vienkārši izvēlieties vienu no veidnēm sarakstā.

Vēlamies izmantot pacientu nosūtījumu (patient referral) veidni.

Ekrāna vidū parādīsies dokuments ar fiksēto tekstu.

Tagad dokumentam varat pievienot komentārus, piemēram,
diagnozi vai jebkādas piezīmes par šo pacientu.

Piešķiriet dokumentam nosaukumu

un noklikšķiniet uz Save (Saglabāt) pogas.

Izvēlieties Yes (jā), lai apstiprinātu izmaiņu
saglabāšanu.

Vienmēr saglabājiet dokumentu, kad veicat izmaiņas.

Kad dokumentam ir piešķirts nosaukums, tas parādīsies saglabāto dokumentu
sarakstā.

Jūsu ērtībai dokumenta nosaukumam tiek pievienots dokumenta izveides
datums.

3.2. Izmaiņu veikšana esošā dokumentā

Pēc dokumenta izveidošanas konkrētam pacientam, iespējams, vēlēsieties mainīt esošo tekstu.

Darbība Paskaidrojums

Palaidiet Reporter moduli, noklikšķinot uz ikonas

vai

Izvēlieties File > ReporterMediadent izvēlnē

Ekrāna labajā pusē redzēsiet uzdevumrūti. Uzdevumrūtī ir
saraksts ar veidnēm, no kurām varat izvēlēties, lai izveidotu jaunu
dokumentu konkrētajam pacientam.

Uzdevumrūts apakšdaļā jums būs iespēja pārslēgties uz
saglabātajiem dokumentiem.

Noklikšķiniet uz pogas "Switch to saved documents"
(Pārslēgties uz saglabātajiem dokumentiem)

Izvēlieties dokumentu no saglabāto dokumentu saraksta.

Jūs redzēsiet sarakstu ar visiem saistītajiem dokumentiem, kas
izveidoti konkrētajam pacientam.

Dokumentu saglabājot, tiek pārrakstīta esošā vēstule.

Ja vēlaties novērst dokumenta pārrakstīšanu, varat izvēlēties
File > Save As no Reporter moduļa izvēlnes un piešķirt
dokumentam citu nosaukumu.
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Veiciet izmaiņas.

Saglabājiet dokumentu.

Lai izveidotu jaunu dokumentu, par pamatu izmantojot
veidni

Noklikšķiniet uz pogas "Switch to templates"
(Pārslēgties uz veidnēm)

Tiks parādīts saraksts ar veidnēm, no kurām izvēlēties.

3.3. Attēlu pievienošana dokumentam

Darbība Paskaidrojums

Dokumentiem varat pievienot 2 veidu attēlus.

1. Attēli no pacienta attēlu bibliotēkas

2. Attēli, kas glabāti ārpus Mediadent

.

1. Attēla pievienošana dokumentam no attēlu bibliotēkas

Lai pievienotu attēlu no pacienta attēlu bibliotēkas, novietojiet kursoru dokumentā, kurā vēlaties pievienot attēlu.

Izvēlieties Insert > Image

.

Dokumentā
parādīsies
lodziņš ar skaitli.
Tas ir vietturis*
un norāda attēla
pozīciju.

*Vietturis ir
pelēks lodziņš ar
skaitli tajā.

Lai pievienotu pacienta attēlu, izsauciet pacienta bibliotēku, noklikšķinot uz ikonas Reporter moduļa ikonu
joslā.

Jūs varat arī
izvēlēties
izmantot
statusa paneli

, no kura
atlasīt attēlus.

Veiciet dubultklikšķi uz attēla attēlu bibliotēkā, lai attēlu ievietotu dokumentā. Tiks parādīta
attēlu bibliotēka.

Veiciet
dubultklikšķi uz
attēla, un
vietturis tiks
aizstāts ar attēlu.

2. Tāda attēla pievienošana, kas tiek glabāts ārpus Mediadent

Varbūt vēlaties pievienot attēlus, kas nav saglabāti attēlu bibliotēkā.
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Savā sarakstē varat iekļaut .BMP, .WMF, .JPG, .GIF un .PNG failus.

Reporter izvēlnē izvēlieties Insert>External Image Novietojiet
kursoru
dokumentā vietā,
kur vēlaties
pievienot ārējo
attēlu.

Atlasiet attēlu.

Ja attēls ir pārāk
liels, lai ietilptu
pirmajā lapā, tad
attiecīgi mainiet
attēla izmēru.

Piešķiriet dokumentam nosaukumu

un noklikšķiniet uz Save (Saglabāt) pogas.

Izvēlieties Yes (jā), lai apstiprinātu izmaiņu saglabāšanu.

Vienmēr
saglabājiet
dokumentu, kad
veicat izmaiņas.

Kad
dokumentam ir
piešķirts
nosaukums, tas
parādīsies
saglabāto
dokumentu
sarakstā.

3.4. Automātiskā teksta (AutoText) funkcijas izmantošana

Automātiskā teksta funkcija ir ļoti praktiska, jo tā var sniegt jums sarakstu ar tekstiem, kurus varat izmantot atkārtoti. Tā ir balstīta uz
standarta teksta apstrādes programmas automātiskā teksta funkciju. Darbības princips ir tāds, ka jūs ievadāt saīsinājumu, kas tiek
aizstāts ar pilnu tekstu.
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Piemēram, dokumentā ierakstiet dc, un dokumentā automātiski parādīsies "zobu kariess".

Varat izveidot savu sarakstu ar saīsinājumiem un pilnu tekstu, lai atvieglotu dokumentu veidošanu.

Šajā piemērā mēs parādīsim, kā izveidot automātisko tekstu vārdam "periodonts".

Darbība Paskaidrojums

Lai aktivizētu automātiskā teksta funkciju, izvēlieties Extras > AutoText Tiek parādīts dialoglodziņš "Auto Text
Completion" (Automātiskā teksta
pabeigšana).

Ierakstiet pdl laukā Change (Mainīt): un periodonts laukā To (Uz): . Tā kā ir atzīmēts lodziņš "Alter Text
While Typing" (Mainīt tekstu rakstīšanas
laikā), ikreiz, kad ierakstīsiet kādu no
sarakstā iekļautajiem saīsinājumiem, tas
tiks aizstāts ar pilnu tekstu.

Izvēlieties Add/Replace Automātiskais teksts parādīsies sarakstā un
būs gatavs lietošanai.

Dokumentā ierakstiet "pdl". Kad dokumentā ierakstīsiet "pdl", tas tiks
aizstāts ar tekstu "periodonts".

Pēc atstarpestaustiņa nospiešanas teksts
tiks aizstāts.

Jūs ietaupīsiet daudz laika, kad būsiet
izveidojuši savu sarakstu ar saīsinājumiem.

3.5. Dažādi veidi, kā kopīgot dokumentu

Ir dažādi veidi, kā kopīgot dokumentus:

- Nosūtīt pa e-pastu

- Izdrukāt dokumentu un nosūtīt pa pastu

- Saglabāt dokumentu kā PDF failu un pārkopēt to uz citu datora

Darbība Paskaidrojums

1. Dokumenta nosūtīšana pa e-pastu

Noklikšķiniet uz e-pasta ikonas Reporter moduļa ikonu joslā

vai

izvēlieties File > Mail To Reporter moduļa izvēlnē

Pārliecinieties, ka jūsu e-pasta programma darbojas
pareizi.

Ierakstiet adresāta vārdu un nosūtiet ziņojumu. Dokuments tiek automātiski pievienots un konvertēts
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PDF faila formātā.

Jums tikai jāieraksta adresāta vārds un jānosūta
ziņojums.

2. Dokumenta drukāšana

Atlasiet dokumentu, kuru vēlaties izdrukāt.

Noklikšķiniet uz drukāšanas ikonas  Reporter moduļa ikonu joslā

vai

izvēlieties File > Print

Izmantojot šīs opcijas, dokuments tiks izdrukāts
standarta printerī.

Ja vēlaties izvēlēties citu printeri, nevis standarta printeri,

izvēlieties File > Print …

Izvēloties šo opciju, tiks atvērts printera dialoglodziņš,
lai varētu mainīt printera iestatījumus.

Pirms drukāšanas vienmēr varat iegūt
dokumenta priekšskatījumu, izvēloties File >
Preview.

Papīra izmēra, piemaļu, dokumenta orientācijas maiņu var veikt, izmantojot
opciju

File > Page Setup

Dialoglodziņš, lai mainītu lapas iestatījumus.

3. Dokumenta saglabāšana PDF formātā

Atlasiet vēstuli, kuru vēlaties saglabāt kā PDF failu.

Izvēlieties File > Export as PDF Reporter moduļa izvēlnē

Ja vēlaties kopīgot savu dokumentu un nevēlaties, lai
pēc tam kāds to mainītu, vai arī saņēmējam nav Word
programmas, jums ir iespēja saglabāt dokumentu pdf
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formātā.

3.6. Dokumentu rādīšana pacientu attēlu bibliotēkā

Ja vēlaties, lai dokuments parādītos kopā ar attēliem attēlu bibliotēkā, varat izvēlēties eksportēt dokumentu uz attēlu bibliotēku.

Darbība Paskaidrojums

Atlasiet dokumentu, kuru vēlaties eksportēt uz attēlu bibliotēku. .

Izvēlieties File > Export to Image Library … Reporter moduļa izvēlnē .

Piešķiriet dokumentam nosaukumu

Izvēlieties Save (Saglabāt) pogu

Dokumentam ir jāpiešķir nosaukums.
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Attēls parādīsies attēlu bibliotēkā kā
PDF fails.

3.7. Esošo dokumentu importēšana

Ja jums jau ir izveidoti dokumenti, tos varēsiet importēt Reporter modulī.

Darbība Paskaidrojums

Izvēlēties opciju File > Import Reporter moduļa izvēlnē. Reporter modulī
var importēt
failus RTF
formātā (Rich
Text Format).

Izvēlieties failu, kuru vēlaties importēt. .

Noklikšķiniet uz Save (Saglabāt) ikonas ikonu joslā.

Piešķiriet importētajam dokumentam nosaukumu.

Dokuments
parādīsies
Reporter
modulī.

Dokuments ir
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jāsaglabā un
tam ir jāpiešķir
nosaukums.

Jaunais
importētais
dokuments
parādīsies
sarakstā
Saglabātie
dokumenti
šim
pacientam.

4. Veidņu izveide Reporter modulī

Šeit ierakstiet savu nolaižamās sadaļas tekstu.

Šajā padziļinātajātēmā mēs izskaidrosim, kā Reporter modulī izveidot un pielāgot veidni.

Veidne satur fiksētu tekstu, ko var atkārtoti izmantot sarakstē. Veidnēs var būt jūsu logotips, adreses informācija, teksta rindkopa u.c.

Dažkārt var būt nepieciešams mainīt esošo veidni, piemēram, ja ir mainījusies zobārstniecības prakses adrese vai tālruņa numurs u.tml.

1. Lai mainītu esošo veidni, izpildiet šādas darbības

Darbība Paskaidrojums

Atveriet Reporter moduli .

Atveriet veidni, kuru vēlaties mainīt Varat atlasīt vienu no dokumentiem Reporter modulī
Šo dokumentu pamatā ir veidnes, kuras varat mainīt.

Veiciet nepieciešamās izmaiņas.

Izvēlieties File>Save As TemplateMediadent izvēlnē .
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Ierakstiet jaunās veidnes nosaukumu

Noklikšķiniet uz Save (Saglabāt) pogas

.

Veidne tiks parādīta uzdevumrūtī labajā pusē. .

7.7 Darbs ar Video kadru tveršanas moduli
 

7.7.1 Darbs ar Video kadru tveršanas moduli

Pārbaudiet, vai kamera, kuru vēlaties izmantot, ir saderīga ar WDM vai VFW. Dažas kameras var būt arī
TWAIN ierīces.

Tie visi ir standarti, un ir svarīgi saprast, kādi standarti tiek atbalstīti, pirms konfigurēt kameru programmā
Mediadent. Šo informāciju var atrast kameras lietotāja rokasgrāmatā. Parasti kopā ar kameru tiek piegādāts
kompaktdisks ar nepieciešamo programmatūru, lai kamera darbotos operētājsistēmā Windows. Pārliecinieties,
vai kamera jau darbojas operētājsistēmā Windows, pirms mēģināt to konfigurēt programmā Mediadent.

WDM ir standarts, un lielākā daļa kameru ir saderīgas ar WDM standartu. Dažas vecākas kameras ir saderīgas ar
VfW.

Ja jūsu kamera ir TWAIN ierīce, to kā tādu var konfigurēt programmā Mediadent.

Šajā sadaļā mēs izskaidrosim jūsu kameras lietošanu programmā Mediadent. Kameras konfigurēšana programmā
Mediadent ir izskaidrota mūsu tehniskajā rokasgrāmatā, un tā jāveic speciālistam (jūsu izplatītājam).

Kā minēts iepriekš, jūs varat izmantot savu kameru, izmantojot VFW StillCap vai WDM StillCap moduli.

Šajā modulī jūs varēsiet uzņemt attēlus ar savu kameru un saglabāt tos pacienta bibliotēkā, lai vēlāk tos varētu
izmantot.

Attēlu uzņem ar bezvadu intraorālo kameru: Discovery wireless camera.
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WDM StillCap moduļa atvēršana

1. Aktivizējiet WDM StillCap, izmantojot Mediadent izvēlni

Options>Video Still Capture\WDM StillCap

 

 2. Atveriet moduli

Noklikšķiniet uz ikonas 

3. Tiek atvērts WDM StillCap ekrāns.

Turpmākajās sadaļās jūs gūsiet pārskatu par attēlu iegūšanas ekrānu un uzzināsiet, kā lietot kameru attēlu
iegūšanas režīmā. Ja jūs neapmierina darbvirsma (dažādu ekrāna elementu izvietojums) attēlu iegūšanas režīmā,
vienmēr varat to mainīt. Sniegsim arī pārskatu par papildu opcijām.

1. WDM StillCap ekrāna pārskats

Pārskats par ekrāna elementiem:
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numurs funkcija

Zobu shēma                        

Ekrāns, kurā redzami ar kameru iegūtie attēli

Statusa panelis

Fullscreen: pārslēdzas uz pilnekrāna režīmu - tas ļauj skatīt vairāk detaļu

Poga "Grab": ja attēls jūs apmierina, varat to uzņemt.

Exit: iziet no ekrāna un dod iespēju saglabāt uzņemto attēlu.

2. Kameras izmantošana Mediadent

Lai izmantotu zobu shēmu ar kameru modulī, izpildiet šādas darbības:

Darbība Paskaidrojums

1. Pozicionējiet kameru pacienta mutē .

2. Zobu shēmā atlasiet zobus, lai izveidotu piesaisti Ja vēlaties izmantot zobu shēmu, jums ir
nepieciešams deaktivizēt statusu.
Iepazīstieties ar sadaļu 3. Darbvirsmas
maiņa , lai uzzinātu, kā to izdarīt.

Lai uzzinātu par darbu ar zobu shēmu,
izlasiet sadaļu Darbs ar zobu shēmu.
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3. Noklikšķiniet uz Grab pogas .

Attēls tiek uzņemts un ir gatavs
izmantošanai pacientu bibliotēkā.

Ja vēlaties uzņemt vairāk attēlu, varat
nospiest Grab pogu.

Katru reizi, kad izmantosiet pogu Grab,
tiks uzņemts attēls. Ja esat gatavi,
noklikšķiniet uz Exit pogas

4. Nospiediet pogu Exit, lai attēlus saglabātu attēlu bibliotēkā. .

Saglabājot attēlu, tas parādīsies pacientu
bibliotēkā.

3. Darbvirsmas maiņa

1. Vispārējās darbvirsmas maiņa
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Ja jūs neapmierina darbvirsmas izkārtojums attēlu iegūšanas ekrānā, varat mainīt dažādos ekrāna elementus
Mediadent ekrānā.

Izvēlieties Desktop > Load desktop izvēlnē.

Ja vēlaties pārvietot ekrāna elementus, neaizmirstiet, ka vienmēr ir vispirms jāatbloķē darbvirsma, un tikai
pēc tam varēsiet pārvietot ekrāna elementus.

Izlasiet sadaļu: Darbs ar darbvirsmām, lai iegūtu sīkāku informāciju.

2. Ekrāna elementu aktivizēšana/deaktivizēšana

Jūs varat aktivizēt un deaktivizēt ekrāna elementus (Redzamās vadīklas)

Ja ekrāns ir pārblīvēts un vēlaties deaktivizēt noteiktus ekrāna elementus, izvēlieties Desktop > Visible
controls

Jums ir iespēja paslēpt šādus elementus:

- Image library (Attēlu bibliotēka)

- Mount = Statusa panelis (vairāk par statusa paneli lasiet šeit: Darbs ar statusa paneli attēlu iegūšanas režīmā)

- Teeth = Zobu shēma (Vairāk par zobu shēmu lasiet šeit: Darbs ar zobu shēmu)

- FullScreen = pilnekrāna režīms ļaus jums redzēt lielāku daļu no uzņemamā attēla

 

Kad ir aktivizēts statusa panelis, attēli tiks parādīti statusa paneļa lodziņos. Ja ar lodziņiem ir saistītas
zobu piesaistes, tas būs redzams zobu shēmā.

 Ja izvēlaties FullScreen (Pilnekrāna režīms), tiks parādīts šāds ekrāns:
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4. Papildu opcijas

WDM StillCap modulī jūs varēsiet konfigurēt veidu, kādā Mediadent apstrādā attēlus.

Iespējams, pamanījāt, ka, uzņemot attēlu, attēls tiek parādīts spoguļattēlā. Jūs varēsiet to mainīt, lai iegūtu attēlu
sākotnējā orientācijā.

Varat aktivizēt šādas opcijas:

Options > Grab as
grayscale

Attēli tiks uzņemti pelēkos
toņos

Options > Mirror after
grab

Dažas kameras rada
spoguļattēlu. Varat atgriezt
attēlu sākotnējā orientācijā.

Options>Enhance
quality

Lai iegūtu labāku kvalitāti,
varat izmantot šo opciju.

Ierīces iestatīšanu (F10) ir paredzēts izmantot tikai tad, kad tiek veikta
kameras konfigurēšana programmā Mediadent. Tas ir izskaidrots mūsu
tehniskajā rokasgrāmatā. Pēc tam, kad tā ir konfigurēta, šajā opcijā nav
nepieciešams mainīt iestatījumus.

.
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Video rekvizīti (F11) ļaus
lietot attēlam filtrus.

Cilnē Video Image (Video
attēls) varat, piemēram,
mainīt kontrastu/gaišumu.

Pārējos iestatījumus
vislabāk saglabāt tādus,
kādi tie ir.

7.8 DFO: vispārīga informācija

Dentofaciālā ortopēdija (DFO) ir izvēles modulis programmā Mediadent.

DFO. ir pilnībā integrēts modulis, kas ļauj ērti analizēt cefalometriskos attēlus.

DFO modulī ir pieejams liels skaits standarta analīžu (piemēram, Ricketts, Rothjar, Jarabak un daudzas citas).

Pateicoties interaktīvajam palīgam, visus punktus var viegli novietot uz cefalometriskā attēla, tādējādi
automātiski aprēķinot jūsu izvēlēto analīzi.

DFO ļauj veikt arī pielāgotas analīzes, izmantojot analīzes redaktoru.

Šo moduli var iegādāties, sazinoties ar savu izplatītāju.

Pilnu DFO rokasgrāmatu var atrast DFO moduļa palīdzības sadaļā.

Palīdzības sadaļu var apskatīt, nospiežot "F1" DFO modulī.
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8 Kā lietot programmu
 

8.1 Pārskats par to, kā lietot programmu

Mediadent Ekrāns
Kā atlasīt vairāk skatvietu (Section 8.2.1)

Kā pielāgot ikonu kopu (Section 8.2.2)

Kā izvēlēties ideālo darbvirsmu (Section 8.2.3)

Kā dzēst darbvirsmu (Section 8.2.4)

Kā mainīt ārsta informāciju (Section 8.2.5)

Jauni darbvirsmas izveides un modificēšanas rīki Mediadent versijā 8 (Section 4.3)

Ekrāna izkārtojuma maiņa Mediadent (Section 4.1)

Automatizācija
Kā izveidot makro (Section 8.7.1)

Mediadent Attēlu bibliotēka
Kā pārvietot attēlus no viena pacienta uz citu (Section 8.3.1)

Kā atrast pacientus, kuriem nesen piekļūts (Section 8.3.2)

Kā arhivēt attēlus programmā Mediadent (Section 7.5.5)

Mediadent panelis
Kā izveidot statusa paneli (Section 8.5.1)

Mediadent Darbības ar attēliem
Kā aktivizēt negatoskopu (Section 8.4.1)

Kā kalibrēt attēlu (Section 8.4.2)

Kā atgūt izdzēstu attēlu (Section 8.4.3)

Darbs ar filtru logu (Section 7.2.9)

Mediadent eksportēšana
Kā nosūtīt attēlu pa e-pastu (Section 8.6.1)

Kā eksportēt vairākus viena pacienta attēlus (Section 8.6.2)

Kā importēt attēlus? ('HT12 Kā importēt attēlus' in the on-line documentation)

Kā vilkt un nomest attēlus e-pastā ('Kā vilkt un nomest attēlu e-pastā' in the on-line
documentation)

Kā ierakstīt CD ar attēliem no Mediadent (Section 8.6.3)

Jaunums: Kā nosūtīt jebkuru failu no failu pārlūka uz Mediadent

8.2 Mediadent ekrāns
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8.2.1 Kā atlasīt vairāk skatvietu

Dažkārt ir nepieciešams analizēt dažādus viena pacienta attēlus. Varbūt vēlaties salīdzināt attēlus?

Lai ielādētu attēlus, programmā Mediadent jūs izmantosiet skatvietas. Jums var būt līdz 5 skatvietas un jūs
varat analizēt 5 dažādus attēlus.

Šajā piemērā ir redzamas 2 skatvietas ar 2 attēliem.

 

Lai pievienotu skatvietas darbvirsmai:  

Izmantojiet ikonuViewport (Skatvieta) ikonu kopā:

Lai mainītu skatvietu skaitu:

NOSPIEDIET un TURIETkreiso peles pogu uz ikonas, līdz ikona tiek izvērsta.

Izvēlieties vēlamo skatvietu skaitu, noklikšķinot uz attiecīgās ikonas (1, 2, 3, 4 vai 5).

Varat izvēlēties līdz 5 skatvietas.
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8.2.2 Kā pielāgot ikonu kopu

Ikonu kopa pēc noklusējuma tiek parādīta ekrāna apakšējākreisajā stūrī.

Tas nodrošinās ātru piekļuvi noteiktām Mediadent funkcijām. Ir iespējams izmantot arī Mediadent izvēlni, taču
bieži vien būs nepieciešams vairāk peles klikšķu, lai iegūtu to pašu rezultātu.

Ikonu kopa ir interaktīva, un tā rādīs tikai tās ikonas, kas ir būtiskas.

Jūs pamanīsiet, ka tad, ja skatvietā nav ielādēts neviens attēls, vairākas ikonas ir pelēkotas.

Pēc attēla ielādēšanas redzēsiet, ka ikonu kopa mainās.

Šī ir ikonu kopa pēc attēla ielādēšanas. Var redzēt, ka visas ikonas tagad ir izceltas.

Ikonu kopa ir interaktīva un aktivizē tikai tās ikonas, kas ir noderīgas.

 

Šajā sadaļā mēs aplūkosim šādas tēmas:

1. Ikonas deaktivizēšana

Ikonu kopu var pielāgot: varat pievienot vai noņemt ikonas.

Ja konstatējat, ka jūsu ikonu kopā ir pārāk daudz ikonu, kuras neizmantojat, varat tās noņemt.

Ja, piemēram, jums nav Dicom tīkla, varat nolemt noņemt ikonu, kas palaiž Dicom tīklu:   

Darbība Paskaidrojums
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Options>Customize Button Toolbar Mēs aktivizēsim pogu rīkjoslas pielāgošanu,
izmantojot Mediadent izvēlni.

Ekrānā parādīsies Button Toolbar
Customizer (pogu rīkjoslas pielāgošana).

Kreisajā pusē redzēsiet sarakstu ar
ikonām, kas ir aktīvas ikonu kopā.

Ja ikonā redzama diagonāla sarkana
josla, tas nozīmē, ka ikona nav
aktivizēta Ikonu kopā.

Poga Save (Saglabāt) ļaus jums saglabāt ikonu
kopā veiktās izmaiņas.

Poga Defaults (Noklusējuma iestatījumi)
atjaunos ikonu kopas sākotnējos iestatījumus.

Poga Add spacer (Pievienot atstarpi) ļauj
pievienot tukšu ikonu. To izmanto, lai
strukturētu ikonu kopu.

Ar pogu Exit (Iziet) aizver ekrānu.

Varat izmantot ritināšanas joslu lai apskatītu
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Varat izmantot ritināšanas joslu, lai apskatītu
visas ikonas, ko var izvietot ikonu kopā.

Piemēram, pārvietojieties pa sarakstu,
izmantojot ritināšanas joslu, un meklējiet Dicom
tīkla ikonu. 

Mūsu piemērā mēs vēlamies deaktivizēt
Dicom tīkla ikonu.

Pārliecinieties, vai sarakstā redzama ikona

Lai deaktivizētu ikonu no ikonu kopas,
noklikšķiniet ar peles LABO pogu uz ikonas.
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Virs ikonas parādīsies sarkana diagonāla
josla.

Nospiediet Save (Saglabāt) pogu.

Nospiediet Exit (Iziet) pogu.

Pirms izejat no pogu rīkjoslas pielāgošanas
izvēlnes, izmaiņas ir jāsaglabā.
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Rezultātā ikonu kopā vairs nebūs redzama

Dicom tīkla ikona .

Jūs redzēsiet tikai Dicom printera ikonu.

2. Ikonas atkārtota aktivizēšana

Lai atkārtoti aktivizētu ikonu, ir jāveic tas pats process.

1. Mediadent izvēlnē Options>Customize Button Toolbar.

2. Atrodiet ikonu, kuru vēlaties atkal aktivizēt. Šajā ikonā būs diagonāla sarkana josla.

3. Noklikšķiniet ar peles labo pogu uz ikonas. Sarkanā diagonālā josla pazudīs.
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4. Neaizmirstiet saglabāt un iziet.

Vēl viens ikonu pielietojums ir tad, ja esat izveidojuši makro un vēlaties aktivizēt makro no ikonas ikonu
kopā. Lasiet sadaļu "Kā izveidot makro" (Section 8.7.1).

8.2.3 Kā izvēlēties ideālo darbvirsmu

Jums ir iespēja izvēlēties ideālo darbvirsmu. Ideālā darbvirsma ir darbvirsma, kurā ir redzami visi nepieciešamie
Mediadentekrāna elementi, kas nepieciešami diagnozes noteikšanai.

Kad darbvirsma ir pareizi izvēlēta, to nav nepieciešams mainīt.

Bet, ja maināt monitoru (piemēram, jaunais ekrāns ir plašāks ), darbvirsma būs jāpielāgo.

Ja pamanāt, ka uz ekrāna netiek parādīti visi Mediadent elementi, jums būs jāizvēlas cita darbvirsma.

Lai izvēlētos ideālo darbvirsmu:

Mediadent izvēlnē izvēlieties

Display>Desktop Panels>Autoset desktop
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Vai

Izvēlieties taustiņu kombināciju : Ctrl+Alt+D

 + + 

Lai pareizi izmantotu šo taustiņu kombināciju, vispirms nospiediet un turietCTRL taustiņu, pēc tam
nospiediet un turietALT taustiņu un tad nospiedietD burtu uz tastatūras.

8.2.4 Kā dzēst darbvirsmu

Monitora maiņa bieži ir iemesls, lai dzēstu iepriekš izveidoto darbvirsmu ar citu ekrāna konfigurāciju.

Lai dzēstu darbvirsmu, izpildiet šādas darbības
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1. Display>Desktop Panels>Save desktop as ...

2. Sarakstā atlasiet darbvirsmu, kuru vēlaties dzēst. Šajā piemērā mēs izvēlamies darbvirsmu "test".
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3. Noklikšķiniet uz Delete (Dzēst) pogas.

Pārliecinieties, ka darbvirsma, kuru vēlaties dzēst, nav aktīva.

8.2.5 Kā mainīt ārsta informāciju

Ja jūsu praksē ir vairāki zobārsti, var būt praktiski, ja Mediadentstatusa joslā ir norādīts ārsta vārds.

Izlasiet sadaļu: Vispārīgie iestatījumi (Section 10.3), ja vēlaties uzzināt, kā konfigurēt ārsta vārdu.

8.2.6 Kā konfigurēt darbvirsmu

Darbvirsma ir veids, kādā ekrānā tiek attēloti dažādi  Mediadent elementi.

Priekšrocība ir tā, ka varat mainīt dažādu ekrāna elementu izkārtojumu atbilstoši jūsu darba specifikai.

Ja vēlaties izmainīt darbvirsmu, vispirms ir jāzina, kā aktivizēt/deaktivizēt noteiktu ekrāna elementu.

Pēc aktivizēšanas varat pārvietot ekrāna elementus vai pat mainīt to lielumu atbilstoši savām vajadzībām.

Lai mainītu darbvirsmu, ir jāveic šādas darbības:

1. Ekrāna elementu aktivizēšana/deaktivizēšana

2. Darbvirsmas atbloķēšana

3. Elementu pārvietošana vai lieluma maiņa

4. Darbvirsmas bloķēšana

5. Darbvirsmas saglabāšana

Vispirms izlasiet sadaļu Pārskats par Mediadent ekrāna elementiem (on-line documentation), lai labāk izprastu dažādos ekrāna
elementus.

1. Mediadent ekrāna elementu aktivizēšana/deaktivizēšana
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Aktivizējot ekrāna elementu, šis elements būs redzams.

Lai aktivizētu elementu

Display > Desktop Panels > atlasiet deaktivizēto elementu

Piezīme: pārliecinieties, vai  zīme ir pirms opcijas

vai noklikšķiniet uz atbilstošās ikonas ikonu kopā, lai aktivizētu elementu.

Lai deaktivizētu elementu, izvēlieties

Display > Desktop Panels > atlasiet aktīvo elementu

Piezīme: pārliecinieties, ka   zīme NAV pirms opcijas

vai noklikšķiniet uz atbilstošās ikonas ikonu kopā, lai deaktivizētu elementu.

2. Ekrāna izkārtojuma maiņa un saglabāšana

Kad esat izvēlējušies ekrāna elementus, kurus vēlaties aktivizēt, jums ir iespēja tos pārvietot uz citu ekrāna vietu.

Lai mainītu darbvirsmu un to saglabātu, ir jāveic šādas darbības:

Darbība Paskaidrojums

1. Darbvirsmas atbloķēšana

1. Vienmēr vispirms atbloķējiet darbvirsmu

Display > Desktop Panels > Lock desktop Piezīme: pārliecinieties, ka pirms opcijas nav zīme  .

Pirms izmaiņu veikšanas vienmēr atbloķējiet darbvirsmu.

Darbvirsma ir atbloķēta, ja ekrāna elementa
kreisajāaugšējā stūrī un labajā apakšējā stūrī ir
pieejami turi.

2. Mediadent ekrāna elementu pārvietošana un/vai lieluma maiņa

2. Ekrāna elementi ir brīvi, un tos var pārvietot uz citu ekrāna vietu vai mainīt to
lielumu, lai parādītu visas opcijas. 

Pārvietojiet ekrāna elementus uz citu vietu, velkot un
nometot elementus, izmantojot turus, kas atrodas
elementa kreisajā augšējā stūrī .

Mainiet ekrāna elementu lielumu, izmantojot turi,
kas atrodas labajā apakšējā stūrī.

3. Darbvirsmas bloķēšana

3. Ja rezultāts jūs apmierina, darbvirsma ir jānobloķē.

Display > Desktop Panels > Lock Desktop Piezīme:    zīmei izvēlnē jāatrodas pirms opcijas.

4. Darbvirsmas saglabāšana

Display>Desktop Panels>Save desktop as … Parādīsies sākotnēji instalēto darbvirsmu saraksts
(atzīmētas ar *). Tās nevar mainīt.
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5. Ierakstiet atpazīstamu darbvirsmas nosaukumu lauciņā "Save current
desktop as:" (Saglabāt pašreizējo darbvirsmu kā).

6. Noklikšķiniet uz    , lai apstiprinātu.

Pēc darbvirsmas saglabāšanas to varēsiet atlasīt,
izmantojot Display > Desktop Panels>Load
Desktop

Noklikšķiniet uz šī virsraksta, lai apskatītu piemērus

Darbība Paskaidrojums

Kā aprakstīts iepriekš, atbloķējiet darbvirsmu .

Mēs deaktivizēsim Kontrasta/intensitātes kombināciju.

Mediadent izvēlnē izvēlieties

Display > Desktop Panels > noņemiet atlasi vienam elementam

Piemēram: Contrast/Intensity combo (Kontrasta/intensitātes
kombinācija)

Ekrāna elements vairs nav redzams.

Piezīme: pārliecinieties, ka pirms opcijas Contrast/Intensity combo

nav zīme    .

Papildu skatvietas pievienošana

Mediadent izvēlnē izvēlieties

Ņemiet vērā, ka aktivizētās skatvietas parādīsies zem esošajām
skatvietām. Ja darbvirsma ir atbloķēta, jūs varēsiet pārvietot
skatvietas uz citu vietu, un redzēsiet, ka parādās jaunas aktivizētās
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Display > ViewPort un atlasiet skatvietu, kuru vēlaties aktivizēt.

Šajā piemērā mēs vēlamies redzēt 3 skatvietas.

skatvietas.

Šajā piemērā 3. skatvieta bija zem 1. skatvietas. Pārvietojot 1.
skatvietu, jūs redzēsiet 3. skatvietu.

Tagad varat izvietot 3 skatvietas. Skatiet sadaļu Jauni darbvirsmas
izveides un modificēšanas rīki Mediadent versijā 8 (Section
4.3).

.

Kā aprakstīts iepriekš, bloķējiet darbvirsmu un saglabājiet to. .

3. Jauni papildu rīki, lai izveidotu vai modificētu darbvirsmu

Šajā jaunākajā versijā ir daudz kas pievienots, lai uzlabotu darbvirsmu izveidi programmā.

Lai saprastu, kas ir darbvirsma, vispirms izlasiet šo sadaļu:  Darbvirsma (Section 12.2) 

Šajā sadaļā mēs izskaidrosim papildu rīkus, kas jums ir pieejami, lai modificētu darbvirsmu.

1. Darbvirsmas paneļa opciju aktivizēšana

Izvēlnē izvēlieties Display > Desktop Panels > Position/size controls
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2. Pārskats par rīklodziņa ikonām un piemēri

Ikona Paskaidrojums

Šīs ir vadīklas, kas nosaka rīklodziņa pozīciju. Opcijas ir pa kreisi, pa labi, augšā un apakšā. Rīklodziņu var arī
vilkt un nomest manuāli.

Snap to grid (Fiksēt pie režģa): ja ikona spīd sarkanā krāsā, ekrāna elementi tiks fiksēti pie režģa. To var
deaktivizēt, noklikšķinot uz ikonas.

Align to grid (Līdzināt pie režģa): šī funkcija ļauj ekrāna elementus līdzināt pie režģa.

Ekrāna elementu līdzināšana.

Līdzināt pa kreisi, līdzināt pa labi, līdzināt uz augšu, līdzināt uz apakšu.

Līdzināšana tiek veikta attiecībā pret pirmo atlasīto lodziņu.

Piemērs: līdzināšana uz augšu

Atlasiet pirmo lodziņu 

Atlasiet otro lodziņu ar Ctrl un noklikšķiniet uz otrā lodziņa

Noklikšķiniet uz ikonas "līdzināt uz augšu" (align top) 
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 Rezultāts:

Līdzināšana blakus vai viens virs otra.

Piemērs: līdzināšana blakus viens otram.

Atlasiet pirmo lodziņu un atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl .

Noklikšķiniet uz ikonas  , lai novietotu 2 lodziņus vienu otram blakus.
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Rezultāts: 2 lodziņi ir novietoti viens otram blakus.

Vienāds lielums

Šī opcija ļauj izveidot vienāda lieluma ekrāna elementus.

Pirmais atlasītais lodziņš noteiks otra atlasītā lodziņa lielumu.

Atlasiet pirmo lodziņu, kuram ir vēlamais lielums.

Atlasiet otro lodziņu, nospiežot un turot nospiestu taustiņu Ctrl.
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Noklikšķiniet uz ikonas 

Rezultāts: Otrais lodziņš ir tāda paša lieluma kā pirmais lodziņš.

 

8.2.7 Kā ielādēt citu darbvirsmu

Ielādētā darbvirsma ir  Mediadentekrāna izkārtojums, kas ir konfigurēts atbilstoši jūsu monitora izmēram un
izšķirtspējai.

Tajā būs redzami visi dažādie Mediadent ekrāna elementi.

Lai uzzinātu vairāk par darbvirsmu, izlasiet sadaļu Darbvirsma (Section 12.2).

Ja jūs neapmierina pašreizējā Mediadent ekrāna konfigurācija, varat ielādēt citu darbvirsmu.

Ņemiet vērā, ka, ielādējot darbvirsmu, kas neatbilst jūsu monitoram, daži Mediadent ekrāna elementi
pazudīs no jūsu ekrāna.

Piemēram, izvēloties darbvirsmu, kas ir piemērota platākam monitoram, Mediadent ekrāna elementi
(piemēram, pelēko toņu korekcija, histogramma u.c.), kas atrodas labajā pusē, netiks parādīti mazākā
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monitorā.

1.  Mediadent izvēlnē izvēlieties Display > Desktop Panels > Load desktop

Tiks parādīts pieejamo noklusējuma darbvirsmu saraksts. Šīs darbvirsmas ir saistītas ar jūsu ekrāna
izšķirtspēju.

2. Noklikšķiniet uz darbvirsmas, kuru vēlaties ielādēt

Parādīsies sākotnēji instalēto darbvirsmu saraksts. Norādītie nosaukumi ir aktuālākās ekrāna izšķirtspējas.
Atkarībā no ekrāna veida jums būs iespēja izvēlēties vienu no darbvirsmām.

Darbvirsma "1024x767" nozīmē, ka Mediadent darbvirsma tiks rādīta jūsu monitorā ar izšķirtspēju 1024
pikseļi (platums) × 768 pikseļi (augstums).

Ja aktivizējat kādu no noklusējuma darbvirsmām, iespējams, jūsu darbvirsma var nebūt optimizēta. Piemēram,
jūsu ekrānā vēl var būt palikusi vieta, kas netiek izmantota.

 Ja darbvirsma nav optimizēta, ir 2 opcijas, ko varat izmantot, lai optimizētu darbvirsmu: 

1. Pēc tam, kad esat ielādējuši vienu no noklusējuma darbvirsmām un tā jūs neapmierina, varat izvēlēties opciju
Display>Desktop Panels>Autoset desktop  Mediadent izvēlnē.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

185

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Šī opcija izmantos optimālāko noklusējuma darbvirsmu.

2. Ja vēl ir iespējami uzlabojumi, izvēlieties Display>Desktop Panels>Fit this desktop to screen
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Kad darbvirsma jūs apmierina, tā ir jāsaglabā.

Lai saglabātu pielāgoto darbvirsmu, izvēlieties Display>Desktop Panels>Save desktop as ...
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Piešķiriet darbvirsmai nosaukumu, šajā gadījumā "adapted". Šī darbvirsma būs aktīva, kad nākamreiz palaidīsiet
programmu.
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Izvēloties optimizēto darbvirsmu, jūs maksimāli izmantosiet sava monitora izšķirtspēju.

Kad esat izveidojuši ideālo darbvirsmu, iespējams, vēlēsieties automātiski izveidot visus darbvirsmas,
pamatojoties uz šo ideālo darbvirsmu.

To var izdarīt, izmantojot šādu opciju: Display>Desktop Panels>Auto create desktop (all presets)
from current

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

189

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Tas automātiski izveidos visas darbvirsmas (1. skatvietu, 2. skatvietu, 3. skatvietu...), pamatojoties uz šo ideālo
darbvirsmu. Tātad, ja pēc tam pārslēgsieties uz citu darbvirsmu, jo, piemēram, vēlaties redzēt vairāk skatvietu,
darbvirsma jau būs optimizēta.

8.2.8 Kā pārvietot tālummaiņas logu

"Tālummaiņas logs"  ir viens no Mediadent ekrāna elementiem, ko varat pārvietot.
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Šajā sadaļā mēs izskaidrosim, kā pārvietot ekrāna elementu "Tālummaiņas logs". Šajā sadaļā aprakstītās darbības
attiecas uz visiem Mediadent ekrāna elementiem.

Lai pārvietotu tālummaiņas logu, izpildiet šādas darbības:

Darbība  Paskaidrojums

1. Atbloķējiet darbvirsmu, atceļot atlasi opcijai
Lock Desktop (Bloķēt darbvirsmu).

Ja vēlaties pārvietot tālummaiņas logu, vispirms
jāatbloķē darbvirsma.

Iestatījums NEDRĪKST būt aktīvs (opcijas
priekšā nav atzīmes).

2. Pārvietojiet tālummaiņas logu, izmantojot turus. Lai pārvietotu Tālummaiņas logu uz vēlamo ekrāna
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apgabalu, ir jāizmanto turi loga augšējā kreisajā
stūrī.

Jūs redzēsiet 2 horizontālas līnijas loga augšējā
kreisajā stūrī, tā ir norāde, ka Tālummaiņas logu
var pārvietot.

3. Atkal bloķējiet darbvirsmu.

Display > Desktop Panels un atlasiet Lock
Desktop (Bloķēt darbvirsmu)

Kad darbvirsma ir pareizi novietota, varat vēlreiz
izvēlēties Bloķēt darbvirsmu.

Pirms opcijas Lock Desktop (Bloķēt darbvirsmu)
jābūt atzīmei.

Kad nākamreiz izmantosiet tālummaiņas logu, tas
tiks pārvietots.

4. Saglabājiet darbvirsmu

Display > Desktop Panels un atlasiet Save desktop
(Saglabāt darbvirsmu)

Nākamreiz palaižot Mediadent, logs būs pareizi
novietots.

8.3 Mediadent attēlu bibliotēka
 

8.3.1 Kā pārvietot attēlus no viena pacienta uz citu

Šajā sadaļā tiks izskaidrots, kā pārvietot attēlu no viena pacienta bibliotēkas uz citu.

Ja esat saglabājuši attēlu nepareizā pacienta bibliotēkā, jums ir iespēja pārvietot attēlu uz pareizā pacienta attēlu bibliotēku.

Lai pārvietotu attēlu no viena pacienta bibliotēkas uz citu, izmantosim Globālo attēlu bibliotēku. Tā ir kopēja mape, kas ir pieejama no katras
pacienta bibliotēkas. Tā kalpos kā pagaidu krātuve attēliem, kurus vēlaties pārvietot. Izlasiet sadaļu: Globālā un pacienta bibliotēka (Section
12.4) un uzziniet vairāk par atšķirībām.

Ja vēlaties pārbaudīt sarakstu ar pacientiem, kuriem nesen piekļūts, lai izgūtu attēlu, izlasiet sadaļu: Kā atrast pacientus, kuriem nesen
piekļūts (Section 8.3.2).

Attēla kopēšana no viena pacienta bibliotēkas uz citu tiek veikta 4 soļos:

1. darbība. Atveriet nepareizā pacienta attēlu bibliotēku, izmantojot pacientu pārvaldības sistēmu. Tātad šis ir pacients, no kura bibliotēkas
vēlaties kopēt nepareizo attēlu.

2. darbība. Kopējiet attēlu uz globālo attēlu bibliotēku
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3. darbība. Atveriet pareizā pacienta attēlu bibliotēku, izmantojot pacientu pārvaldības sistēmu. Tātad šis ir pacients, uz kura bibliotēku
vēlaties pārkopēt attēlu.

4. darbība. Pārkopējiet attēlu no globālās attēlu bibliotēkas uz pareizā pacienta bibliotēku.

Darbība Paskaidrojums

1. Atveriet nepareizā pacienta attēlu bibliotēku

2. Atlasiet attēlu, kuru vēlaties pārvietot uz citu bibliotēku, un  noklikšķiniet ar LABO peles pogu uz attēla.

Tātad šī ir pacienta bibliotēka,
kurā ir nepareizais attēls (Mr.
White Teeth). 

Parādīsies izvēlne, un jūs varēsiet
atlasīto attēlu kopēt vai
pārvietot. Mūsu piemērā mēs
izvēlēsimies pārvietot attēlu.

3. Izvēlieties 'Move selected image(s) to the Global Folder' .

4. Noklikšķiniet uz Globālās attēlu bibliotēkas ikonas , lai apstiprinātu.
Attēls tiek pārvietots uz globālo
attēlu bibliotēku.

4. Atveriet pacienta bibliotēku, uz kuru vēlaties pārkopēt attēlu. Tas tiek darīts, izmantojot pacientu
pārvaldības sistēmu.

Šajā piemērā mēs atveram
pacienta attēlu bibliotēku Tutor
Mediadent.

5. Noklikšķiniet uz Globālās attēlu bibliotēkas ikonas , lai piekļūtu attēlam.
Iepriekšējos soļos mēs kopējām
attēlu no bibliotēkas "Mr. White
Teeth" uz globālo bibliotēku.

Mums ir jādodas uz Globālo
attēlu bibliotēku, lai iegūtu
attēlu, lai to varētu kopēt uz
pašreizējo pacienta bibliotēku
(Tutor Mediadent).

6. Noklikšķiniet ar LABO peles pogu uz attēla, kas saglabāts globālajā attēlu bibliotēkā.

 

Jūs pārvietosiet attēlu no
globālās attēlu bibliotēkas uz
pašreizējo pacienta bibliotēku.

7. Atlasiet 'Move selected image(s) to the current Patient Folder (...)' .

8. Atlasiet pacienta bibliotēku, noklikšķinot uz Pacienta bibliotēkas ikonas
Atgriezieties atpakaļ uz attēlu
bibliotēku Tutor Mediadent ,
noklikšķinot uz pacienta
bibliotēkas ikonas.

9. Rezultāts Attēls tiek saglabāts pašreizējā

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

193

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



 

pacienta bibliotēkā.

8.3.2 Kā atrast pacientus, kuriem nesen piekļūts

Dažreiz var būt praktiski atrast attēlus, kas nesen iegūti konkrētam pacientam.

Varbūt, iegūstot attēlus, jūs izvēlējāties nepareizo pacientu? Vai arī nevarat atrast noteiktus attēlus?

Mediadent var jums palīdzēt, jo jūs varēsiet piekļūt sarakstam ar pacientiem, kuriem nesen piekļūts.

Šajā sarakstā ir 100 pacienti, kuriem nesen piekļūts no šīs darbstacijas.

Lai piekļūtu šim sarakstam:

Dodieties uz File > Show patients list, recently accessed from this workstation

Saņemsiet sarakstu, kas būs līdzīgs šim. Sarakstā ir norādīts datums, kad tika veikta piekļuve pacientam,
pacienta ID, pacienta vārds un attēlu mape.

Šādā veidā jūs varat izsekot, kad tika uzņemti konkrēti attēli un kur tie tika glabāti.

Jūs varat divreiz noklikšķināt uz pacienta vārda, un bibliotēka tiks atvērta.

Lai apskatītu attēlus, aizveriet šo ekrānu, noklikšķinot uz pogas Exit (Iziet).
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Izlasiet sadaļu: Kā pārvietot attēlus no viena pacienta uz citu (Section 8.3.1).

8.3.3 Kā meklēt attēlus

Ja jums ir liels skaits attēlu par konkrētu pacientu, var būt grūti atlasīt pareizo attēlu analīzei.

Attēlu bibliotēkā jums ir iespēja meklēt vai filtrēt pareizos attēlus.

Filtrēšanas vai meklēšanas kritērijus varat noteikt, pamatojoties uz papildu informāciju vai atslēgvārdiem, kas ir saistīti ar attēliem.

Meklēt pēc atslēgvārdiem vai papildu informācijas, piemēram, lietotāja, kategorijas, veida, var tikai tad, ja tie ir saistīti ar attēlu.

Ja nekas nav piesaistīts, filtrs nedarbosies.

Lai filtrētu attēlus, pamatojoties uz papildu informāciju vai atslēgvārdiem, ir jāizmanto šāda ikona   attēlu bibliotēkā.
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Attēlus var
filtrēt vai
meklēt,
pamatojoties
uz šādiem
elementiem:

1. Datums

2. Lietotājs

3. Kategorija

4. Veids

5.
Atslēgvārdi

1. Meklēšana pēc datuma

Varat filtrēt attēlus, kas uzņemti noteiktā datumu diapazonā.

Ja jūs zināt, kad pacientam bija vizīte, jūs varat viegli izfiltrēt attēlus, kas uzņemti šajā konkrētajā datumā.

Jūs varat:

- iekļaut visus attēlus, kas uzņemti starp noteiktiem datumiem; šī filtra rezultāts būs tikai tie attēli, kas uzņemti starp noteiktiem datumiem

- izslēgt visus attēlusstarp noteiktiem datumiem - rezultātā redzēsiet attēlus, kas uzņemti ārpus datumu diapazona

- norādīt atsevišķus datumus

Noklikšķiniet  , lai apstiprinātu.

Izvēloties šo opciju, redzēsiet konkrētajam pacientam uzņemto attēlu datumus. Izvēloties kādu no datumiem, tiks parādīti attēli, kas uzņemti šim pacientam
šajā datumā.

Lai apskatītu visus attēlus, jums būs nepieciešams atiestatīt attēlu bibliotēku. Sk. tēmu 6. Attēlu bibliotēkas atiestatīšana.

2. Meklēšana pēc lietotāja

Varat iekļaut vai izslēgt attēlus, kurus ir uzņēmuši konkrēti lietotāji.

Izlasiet sadaļuMediadent iestatīšana: displeja iestatījumi, lai uzzinātu vairāk par to, kā konfigurēt Mediadent, lai attēla saglabāšanas laikā varētu izvēlēties
konkrētus lietotājus.
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Izvēlieties vienu no lietotājiem, un jūs redzēsiet tikai attiecīgā lietotāja uzņemtos attēlus.

Darbība Paskaidrojums

1. Noklikšķiniet uz Search (Meklēt) ikonas attēlu bibliotēkā .

2. Izvēlieties cilni User (Lietotājs) un atlasiet 'kris'.

3. Noklikšķiniet , lai apstiprinātu

Mēs esam pievienojuši šo atslēgas vārdu, kad saglabājām šo
attēlu.

Lai iegūtu vairāk informācijas, skatiet arī tēmu Papildu
informācijas un atslēgvārdu norādīšana.

To var pievienot arī pēc tam, izmantojot sadaļu Attēla rekvizīti.

3. Rezultāts: Jūs redzēsiet tikai tos attēlus, ar kuriem ir saistīts lietotājs gunter. Rozā josla ir norāde, ka jums ir aktīvs filtrs.

Sk. 6. Attēlu bibliotēkas atiestatīšana
Lai skatītu visus attēlus, jums būs nepieciešams atiestatīt
attēlu bibliotēku. Sk. tēmu 6. Attēlu bibliotēkas
atiestatīšana.

3. Meklēšana pēc kategorijas

Meklēšana pēc kategorijas darbojas tāpat kā meklēšana pēc lietotāja.

Noklikšķiniet uz cilnes Grade (Kategorija) un, piemēram, atlasiet, lai redzētu attēlus, kuriem ir piešķirta A kategorija .

Varat arī izvēlēties izslēgt šos attēlus.
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Vienmēr noklikšķiniet uz  , lai apstiprinātu.

Ja netiek parādīts neviens attēls, tas nozīmē, ka neviens attēls nav saistīts ar A kategoriju.

Lai skatītu visus attēlus, jums būs nepieciešams atiestatīt attēlu bibliotēku. Sk. tēmu 6. Attēlu bibliotēkas atiestatīšana.

4. Meklēšana pēc veida

Noklikšķiniet uz cilnes Type (Veids) un izvēlieties konkrētu

Vienmēr noklikšķiniet uz 

  , lai apstiprinātu.

Rezultātā redzēsiet attēlus, ar kuriem ir saistīts XRAY.

Varat arī izvēlēties izslēgt attēlus, ar kuriem ir saistīts XRAY.

Ja netiek parādīts neviens attēls, tas nozīmē, ka neviens attēls nav saistīts ar XRAY.

Lai skatītu visus attēlus, jums būs nepieciešams atiestatīt attēlu bibliotēku. Sk. tēmu 6. Attēlu bibliotēkas atiestatīšana.

5. Meklēšana pēc atslēgvārdiem

Ja esat saglabājuši attēlu ar konkrētiem atslēgas vārdiem, jums ir iespēja meklēt attēlus pēc šiem atslēgas vārdiem.

Darbība Paskaidrojums

1. Dodieties uz attēlu bibliotēku Atvērsies šāds dialoglodziņš:
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2. Noklikšķiniet uz mazo palielināmā stikla ikonu attēlu bibliotēkā.

3. Izvēlieties cilni Keywords (Atslēgvārdi) . .

4. Atlasiet atslēgvārdu "EXAMPLE" . Mēs esam pievienojuši šo atslēgas vārdu, kad saglabājām šo attēlu. Lai iegūtu
vairāk informācijas, skatiet arī tēmu Papildu informācijas un atslēgvārdu
norādīšana.

Otra metode atslēgvārdu piesaistīšanai ir izmantojot Attēla rekvizītus.

4. Noklikšķiniet uz  , lai apstiprinātu.
.

5. Rezultāts : Ir atrasts attēls ar atslēgvārdu TEST. Rozā josla ir norāde, ka jums ir aktīvs filtrs.

Sk. 6. Attēlu bibliotēkas atiestatīšana
Lai skatītu visus attēlus, jums būs nepieciešams atiestatīt attēlu
bibliotēku. Sk. tēmu 6. Attēlu bibliotēkas atiestatīšana.

6. Attēlu bibliotēkas atiestatīšana

Pēc tam, kad esat izfiltrējuši vairākus attēlus, varat atiestatīt attēlu bibliotēku, lai atkal redzētu visus attēlus.
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Lai atiestatītu attēlu bibliotēku, izpildiet šādas darbības.

Darbība

1. Noklikšķiniet uz mazo palielināmā stikla ikonu vēlreiz.

2. Noklikšķiniet uz ikonu   , lai apstiprinātu.

8.4 Mediadent darbības ar attēliem
 

8.4.1 Kā aktivizēt negatoskopu

Ja vēlaties izmantot datora ekrānu kā negatoskopu, lai parādītu rentgena attēlu, jums ir iespēja aktivizēt
negatoskopu programmā Mediadent.

Mediadent izvēlnē izvēlieties:

Display > Negatoscope

Jūs redzēsiet baltu ekrānu.

Tagad jūs varat turēt rentgenu pret datora ekrānu.

Lai atgrieztos, vienkārši noklikšķiniet uz jebkura taustiņa tastatūrā vai noklikšķiniet ar peles
pogu uz ekrāna.

8.4.2 Kā kalibrēt attēlu

Attēls ne vienmēr ir kalibrēts, jo īpaši attēli, ko saņemat no ārēja avota.

Norāde, ka attēls nav kalibrēts, attēlu bibliotēkā tiek parādīta ar pārsvītrotas lineāla ikonas palīdzību.

Zīmējot līniju, izmantojot cilni Measure (Mērījumi), līnijas mērījums ir norādīts pikseļos, nevis milimetros.

Attēla kalibrēšana ir svarīga, kad sākat izmantot mērījumus. Veicot mērījumus attēlā, pārliecināties, ka tie ir relatīvi
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attēlam.

Īpaši tad, ja tiek izmantots implantu modulis, attēls ir jākalibrē.

Šajā sadaļā mēs izskaidrosim divus attēla kalibrēšanas veidus.

1. metode: definēt uzzīmētās līnijas garumu.
Mēs uzzīmēsim līniju, izmantojot cilni Measure (Mērījumi), un norādīsim tās izmēru. Zīmētās līnijas garums būs 15 mm.

Darbība Paskaidrojums

1. Ielādējiet attēlu skatvietā

1. Noklikšķiniet uz Anotācijas ikonas Ikonu kopā pēc noklusējuma tā ir trešā
ikona.

2. Zīmējiet līniju, izmantojot cilni Measure (Mērījumi)

Izvēlieties cilni Measure (Mērījumi). Parādīsies Annotations Measure ar
dažādu anotāciju sarakstu, ko var
pievienot attēlam. Lietošana ir
izskaidrota sadaļā "Darbs ar
anotācijām" (Section 7.2.3).

Noklikšķiniet uz Line (Līnija) pogas .
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Nospiediet un turiet nospiestu ​ KREISO peles pogu, vienlaikus zīmējot
līniju uz attēla.

Jūs pamanīsiet, ka mērījums ir
norādīts pikseļos. Tas norāda, ka
attēls nav kalibrēts.

3. Kalibrējiet attēlu

Noklikšķiniet uz Calibrate (Kalibrēt) cilnes

Izvēlieties Line length in mm (līnijas garums milimetros). Šajā piemērā mēs izvēlējāmies 15 mm,
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Ierakstiet ​ garumu milimetros līnijai, kuru uzzīmējāt.

un tas nozīmē, ka attēlā uzzīmētā līnija
ir 15 mm gara.

Var būt praktiski attēla iegūšanas
laikā integrēt arī lineālu. Šādā
veidā jūs varat viegli kalibrēt,
izmantojot lineālu kā atsauci.
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Noklikšķiniet uz Apply.

Jūsu attēls ir kalibrēts.

Kad esat kalibrējuši šāda veida attēlu, varat saglabāt kalibrēšanas vērtības kalibrēšanas tabulā.
Kalibrētās vērtības pievienošanas priekšrocība ir tāda, ka ikreiz, kad jums ir attēls, kura izmērs ir tāds pats kā kalibrētajam
attēlam, attēls tiks automātiski kalibrēts.
Pievērsiet uzmanību vērtībai Pixels/Meter (pikseļi/m). Šis skaitlis būs jāieraksta kalibrēšanas tabulā.
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2. metode: vērtības pievienošana kalibrēšanas tabulā.
Darbība Paskaidrojums

1. Attēla izšķirtspēja

Ielādējiet attēlu skatvietā, veicot dubultklikšķi uz attēla attēlu bibliotēkā. Attēls tiks parādīts uz ekrāna un būs
redzama papildu informācija.

 

Ņemiet vērā attēla izšķirtspēju.
Mūsu piemērā attēla izšķirtspēja ir
800x1200x16.

Kur:

platums = 800
augstums = 1200

2. Pievienojiet kalibrēšanas vērtību tabulai

Noklikšķiniet uz "options > Calibration table" Atvērsies kalibrēšanas tabula.

 Nospiediet pogu "Add" (Pievienot), lai pievienotu ierakstu. Tādējādi tabulā varēsiet pievienot
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jaunu kalibrēšanas vērtību.

 Aizpildiet attēla izšķirtspējas un pikseļi/m vērtības.
Platums un augstums ir vērtības no attēla izšķirtspējas.
Vērtība pikseļi/m ir vai nu iegūta no tehniskajiem dokumentiem, kas sniegti no
dažādiem tehniskiem avotiem, vai arī vērtība ir iegūta, izmantojot 1. metodi. 

Mūsu piemērā platums ir 800 un
augstums ir 1200.

 Kad esat pabeiguši, nospiediet Save (Saglabāt), lai saglabātu izmaiņas.                                                                                 

Jaunums: Ja platums vai augstums vienmēr ir vienāds, bet otra vērtība ir mainīga, jums tagad ir iespēja piemērot
aizstājējzīmi.

Vienkārši pievienojiet "-1" kā vērtību platumam vai augstumam un aizpildiet pārējās vērtības, un kalibrēšana tiks veikta
automātiski.

T. i., ja attēlu izšķirtspēja vienmēr ir 1500xnx16, kur n (augstums) vienmēr mainās, iespējamais ieraksts kalibrēšanas
tabulā būs:

platums = 1500
augstums = -1
pikseļi/m = 40000*

* Vērtība jāņem no tehniskās dokumentācijas vai jāpārbauda ar 1. metodi.

8.4.3 Kā atgūt izdzēstu attēlu

Jūs varēsiet izgūt izdzēstu attēlu no atkritnes, ja tas ir aktivizēts programmas iestatījumos - Mediadent
Setup>General Settings.

Lai uzzinātu, kā atgūt izdzēstu failu no atkritnes, izlasiet sadaļu par MediadentVispārīgie iestatījumi
(Section 10.3), tēmu "Kā izvairīties no failu neatgriezeniskas dzēšanas".

8.5 Mediadent statusa panelis
 

8.5.1 Kā izveidot statusa paneli

Brīdinājums: Nemainiet esošos statusa paneļus, jo izmaiņas tiks dzēstas, atjauninot Mediadent.

Jums ir iespēja izveidot savu statusa paneli. Tas ļaus jums izveidot savu procedūru (secību) attēlu iegūšanai.

Statusa panelī varat piesaistīt zobus vai zobus un, ja nepieciešams, mainīt sensora orientāciju.

Tas tiek darīts šādos soļos:

1. Izveidojiet statusa paneli
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Pirms jauna statusa paneļa izveides jāpārliecinās, ka darbvirsma ir atbloķēta.

To var izdarīt Mediadent izvēlnē: Display > Desktop Panels > Lock desktop (šī opcija NEDRĪKST būt atzīmēta)

Ja šī opcija ir atzīmēta, jums tai ir jānoņem atzīme, noklikšķinot uz Lock desktop (Bloķēt darbvirsmu).

Darbība Paskaidrojums

Statusa paneļa izveidošana

Mediadent izvēlnē: Display > Desktop Panels > Mount view

vai

Aktivizējiet statusa paneli - sk. tēmu "Kas ir statusa panelis".

Izvēlieties esošu statusa paneli, kas ir līdzīgs tam, kuru
vēlaties izveidot.

Dodieties uz statusa paneļa vadīklām un noklikšķiniet uz
ikonas, lai izvērstu apakšizvēlni.

Izvēlieties izveidot New Scheme (jauna shēma) izvēlnē

Piešķiriet shēmai nosaukumu.

Rezultāts: Tukšs statusa panelis ar statusa paneļa lodziņiem, kas
definēti atlasītajā standarta statusa panelī, šajā piemērā "Full
Mouth".

Tagad esat gatavi pielāgot šo statusa paneli.

2. Statusa paneļa lodziņu aktivizēšana

Darbība Paskaidrojums

Pievienot vai noņemt statusa paneļa lodziņus

Varat pievienot vai noņemt statusa paneļa lodziņus, izmantojot attēlu konteinera konfiguratoru.

Kad lodziņš ir zaļš, statusa paneļa lodziņš ir redzams shēmā.
Kad lodziņš ir sarkans, statusa paneļa lodziņš nav redzams shēmā.

Nospiediet uz viena no lodziņiem, un parādīsies statusa paneļa lodziņš.
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Lodziņš būs izcelts, kas norāda, ka tas ir tikko pievienots.

Lodziņi numurēti, bet tie vēl nav saistīti ar zobu vai zobiem.

Tā kā darbvirsma ir atbloķēta, jūs varat pārvietot lodziņu uz citu pozīciju statusa panelī, izmantojot turi
(divas mazas joslas lodziņa augšējā kreisajā stūrī).

Lai atbloķētu darbvirsmu, izvēlieties Display > Desktop Panels > Lock desktop (pārliecinieties, ka šī opcija
nav atzīmēta).

Neaizmirstiet saglabāt shēmu.

Aktivizējiet apakšizvēlni (labajā pusē augšā) statusa paneļa lodziņā.

Šo procesu varat atkārtot (pievienojot un/vai noņemot statusa paneļa lodziņus), līdz esat definējuši statusa paneļa lodziņu skaitu, kādu vēlaties savā
statusa panelī.

3. Zobu/zoba piesaistīšana statusa paneļa lodziņiem

Darbība Paskaidrojums

Pārskats par attēlu piesaisti

Jūs varat piesaistīt zobu vai zobus, mainot lodziņa rekvizītus:

Izvēlieties vienu no statusa paneļa lodziņiem.

Jūs pamanīsiet, ka, atlasot lodziņu, krāsa mainās uz tumši pelēku.

Izvēlieties apakšizvēlnē > Image associations

Parādīsies Attēlu piesaistes lodziņš:

 Orientācija: Tas ļaus mainīt statusa paneļa lodziņa orientāciju.

 Pirmā cilne ‘Standard corrections’ (Standarta korekcijas) norāda digitālā sensora
orientāciju.  Tas nozīmē, ka, ja sensoru izmantojat intraorālo attēlu uzņemšanai,
jums ir iespēja mainīt orientāciju, izmantojot šo ekrānu. Jums ir arī iespēja apvērst
attēlus no kreisās puses uz labo vai no augšas uz leju atkarībā no tā, kā sensors ir
novietots pacienta mutē.

 Otrā cilne ‘Teeth Chart’ (Zobu shēma) ir daļēji paslēpta, un tā ļaus sasaistīt zobu
vai zobus ar statusa paneļa lodziņu.

Orientācijas maiņa

Aplūkosim sīkāk cilni "Standarta korekcijas". Atkarībā no tā, kā ievietojat sensoru pacienta mutē, jūs varēsiet mainīt orientāciju. 

Š
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Šajā piemērā mainīsim Statusa paneļa lodziņu uz 90°, kas ir pozīcija, kādā mēs
ievietojam sensoru pacienta mutē.

Mēs varam mainīt arī statusa paneļa lodziņa vizualizāciju. 

Attēlam, ko gribu uzņemt statusa paneļa lodziņā, jābūt orientētam ainavā; šeit mēs to
varam mainīt.

Jūs redzēsiet, ka statusa paneļa lodziņa orientācija mainās uz ainavu.

Zobu/zobu piesaistīšana statusa paneļa lodziņam

Tagad mēs piesaistīsim zobus.
Dialoglodziņā noklikšķiniet uz labās bultiņas, lai skatītu cilni Zobu piesaiste.

 

Noklikšķiniet uz cilnes Teeth Chart (Zobu shēma) .
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Tiek parādīta zobu shēma.

Šobrīd atlasītajam statusa paneļa lodziņam nav piesaistīti zobi.

Tagad statusa paneļa lodziņam var piesaistīt dažus zobus. 

 Šajā piemērā mēs šim statusa paneļa lodziņam piesaistīsim 23.-26. zobu.

To var izdarīt, izvēloties zobus zobu shēmā.

Lai uzzinātu vairāk par darbu ar zobu shēmu, izlasiet sadaļu Darbs ar zobu shēmu.

Dialoglodziņu var aizvērt, noklikšķinot uz X augšējā labajā stūrī; piesaiste tiek
saglabāta.  Varat arī noklikšķināt uz statusa paneļa lodziņa, lai apstiprinātu
savu piesaisti.

Rezultāts: Statusa paneļa lodziņa nosaukums mainīsies un atspoguļos zobu
piesaisti.

Zobu shēmas vidū varat norādīt, kā sensors tiks novietots pacienta mutē (piemēram,
90° leņķī).

Tas tiks saistīts ar statusa paneļa lodziņu, to atlasot zobu shēmā.

Jūs redzēsiet, ka parādās spīdums. Tas nozīmē, ka šis ir veids, kā tiks izmantots
intraorālais sensors.

Ir svarīgi noklikšķināt uz statusa paneļa lodziņa vai aizvērt dialoglodziņu,
lai saglabātu statusa paneļa lodziņā veiktās izmaiņas.

Šis process būs jāatkārto katram statusa paneļa lodziņam statusa panelī.

Pēc tam, kad šis process ir atkārtots visiem statusa paneļa lodziņiem, ir nepieciešams
saglabāt statusa paneli.

Aktivizējiet apakšizvēlni (labajā pusē augšā) statusa paneļa lodziņā.

4. Rentgena attēlu uzņemšanas secības maiņa

Darbība Paskaidrojums

Mediadent izvēlnē: File > Acquire FMX

-vai-

Varat mainīt secību, kādā jāuzņem attēli. 

Lai pārbaudītu kārtību jeb secību, kādā tiks uzņemti attēli, varat doties uz Attēlu
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iegūšanas režīms ar statusa paneli.

Izvēlieties Add/record a sequence (pievienot/reģistrēt
secību)

Ja secības rīkjosla nav aktivizēta, izlasiet sadaļu Kā aktivizēt secības atlasītāja
rīkjoslu (on-line documentation).

Varat izveidot savu secību, noklikšķinot uz mazās izvelkamās bultiņas secības
atlasītāja rīkjoslā.

Vispirms piešķiriet secībai nosaukumu.

Tiks parādīts šāds informācijas logs, kurā būs paskaidrots, kā var mainīt statusa
lodziņu secību.

Noklikšķiniet uz statusa paneļa lodziņa, kurā jāparādās
pirmajam attēlam.

Atkārtojiet šo procesu, līdz esat atlasījuši visus lodziņus.

Kursors mainīsies uz 01.

Tas ir kārtas numurs.

Noklikšķiniet uz statusa paneļa lodziņa, kurā jāparādās pirmajam attēlam.

Redzēsiet, kā kursors mainās uz 02, tagad noklikšķiniet uz statusa paneļa lodziņa,
kurā jāuzglabā otrais attēls.

Kursors mainīsies uz 03, ...

Atkārtojiet šo procesu, līdz esat atlasījuši visus lodziņus.

Kad esat pabeiguši, noklikšķiniet uz Esc vai noklikšķiniet ar peles labo pogu uz statusa
lodziņa.
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Jūs varēsiet atlasīt izveidoto jauno secību.

Neaizmirstiet saglabāt statusa paneli.

8.6 Mediadent eksportēšana/importēšana
 

8.6.1 Kā nosūtīt attēlu pa e-pastu

Attēlu nosūtīšana pa e-pastu var būt noderīga, ja vēlaties kopīgot savus attēlus ar kolēģiem vai slimnīcu.

Mediadent ir iespējams nosūtīt attēlu, taču datorā ir jābūt instalētai e-pasta sistēmai. Izplatītākās e-pasta
programmas ir, piemēram, Outlook, Outlook Express u.c.

Pirms sūtīt attēlu, izmantojot Mediadent, ir jāpārbauda, vai e-pasta sistēma darbojas, nosūtot e-pasta
ziņojumu e-pasta programmā.

 Ir 2 veidi, kā nosūtīt attēlus, izmantojot e-pasta programmu.

Izmantojot attēlu bibliotēkas ikonas
Izmantojot opciju Export Picture Directory (Eksportēt attēlu direktoriju)

1. E-pasta nosūtīšana tieši no pacienta attēlu bibliotēkas
Visvienkāršākais veids ir pacienta attēlu bibliotēkā atlasīt attēlus, kurus vēlaties nosūtīt, un izvēlēties Send by
Email (Sūtīt pa e-pastu) (izmantojot izvēlni) vai noklikšķināt uz e-pasta ikonas.

Sūtīšana pa e-pastu (izmantojot izvēlni)

1. Atlasiet attēlu(-us) attēlu bibliotēkā
2. Lai aktivizētu izvēlni, noklikšķiniet uz peles LABĀS pogas
3. Izvēlieties "Send by Email" (Sūtīt pa e-pastu)

 

Sūtīšana izmantojot e-pasta ikonu

1. Atlasiet attēlu(-us) attēlu bibliotēkā
2. Noklikšķiniet uz e-pasta ikonas attēlu bibliotēkā
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2. Izmantojot opciju Export Picture Directory (Eksportēt
attēlu direktoriju)
Otrā metode ir izskaidrota šajā sadaļā.

Darbība

1. Mediadent izvēlnē jūs atradīsiet funkciju File > Export Picture Directory

Lai iegūtu detalizētu ekrāna elementu aprakstu, izlasiet tēmu "Attēlu direktorija eksportēšanas ekrāns"
(Section 7.1.1).

2. Noklikšķiniet uz attēla, kuru vēlaties nosūtīt.
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3. Izvēlieties "Add" (Pievienot).

4. Attēls parādīsies sarakstā:

5. Izvēlieties e-pasta pogu.

6. Tiks palaista e-pasta programma, un attēls tiks pievienots e-pastam.
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7. Ierakstiet pacientu vārdus un nosūtiet ziņojumu.

Izmantojiet pogu "Estimate" (Novērtēt), lai iegūtu informāciju par faila lielumu. Dažas e-pasta
sistēmas neļauj nosūtīt vairāk par 5 MB. Izmantojot pogu "Estimate", jūs redzēsiet, cik MB lieli ir jūsu
vēstules pielikumi.Ja pielikums ir lielāks par atļauto izmēru, attēlu varēsiet sūtīt atsevišķos e-
pastos. Plašāku informāciju par ekrāna elementiem un pogām skatiet tēmā "Attēlu direktorija
eksportēšanas ekrāns" (Section 7.1.1).

8.6.2 Kā eksportēt vairākus viena pacienta attēlus

Dažkārt var būt nepieciešams eksportēt vairākus konkrēta pacienta attēlus, lai tos varētu kopīgot ar kolēģiem un pacientiem.

Lai eksportētu 1 attēlu, izvēlieties File > Export pictureMediadent izvēlnē.

Ja vēlaties eksportēt vairākus attēlus, varat izmantot opciju Export Picture Directory (Eksportēt attēlu direktoriju).

Dodieties uz Mediadent izvēlni un izvēlieties File > Export Picture Directory

1. Direktorija eksportēšanas ekrāna pārskats

Tiks parādīts šāds ekrāns: 

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

215

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Atlasītā pacienta attēlu bibliotēka.

Skatvieta: pirms attēla eksportēšanas varat to priekšskatīt.

Darbības pogas:

Add (Pievienot): pievieno atlasīto attēlu
Add all (Pievienot visus): pievieno visus attēlus, kas atrodas atlasītajā bibliotēkas mapē
Add all+folders (Pievienot visus+mapes): pievieno visus šī pacienta attēlus
Remove from list (Noņemt no saraksta): ļauj atlasīt attēlus, kas jānoņem no saraksta

 
Eksportējamo failu saraksts.

Destination folder (Mērķa mape): mape, uz kuru vēlaties eksportēt attēlus.

Papildu informācija

Export File Type (Eksporta faila veids): sniedz iespēju mainīt faila veidu, kādā vēlaties eksportēt failus.

Info (Informācija): sniedz papildu informāciju par faila lielumu, eksportējamo failu skaitu utt. Šī informācija tiks aizpildīta,
noklikšķinot uz pogas "Estimate" (Novērtēt) .

Poga "Estimate" (Novērtēt): Šī darbības poga aprēķina failu skaitu, avota lielumu, mērķa lielumu, kopējo saspiešanu, mapi,
failus utt. Šī informācija tiks aizpildīta lodziņā Info.

Poga "Export" (Eksportēt): Šī darbības poga eksportē sarakstā esošos failus   uz mērķa mapi.

Poga "E-mail" (E-pasts): Šī darbības poga palaiž jūsu e-pasta programmu un pievieno sarakstā esošos attēlus e-pastam.

Exit (Iziet)

 

2. Attēlu eksportēšana

Lai eksportētu vairākus konkrēta pacienta failus, izpildiet šādas darbības:

Darbība Paskaidrojums

1. Mediadent izvēlnē izvēlieties File>Export Picture Directory .

2. Atlasiet attēlu, kuru vēlaties eksportēt.

1. metode: atlasiet attēlus pa vienam

- Noklikšķiniet uz attēla ar peles kreiso pogu, lai atlasītu attēlu

Ja vēlaties atlasīt vairāk nekā 1 attēlu, varat nospiest un turēt nospiestu taustiņu CTRL
un atlasīt attēlus, kurus vēlaties eksportēt.

Ir dažādi veidi, kā atlasīt attēlus,
kurus vēlaties eksportēt.

Jums nav jāatlasa attēli pa
vienam.

2. metode: Ja vēlaties
eksportēt attēlus no atlasītās
mapes, varat izmantot
darbības pogu 

3. metode: Ja vēlaties
eksportēt attēlus no konkrētas
mapes un visām
apakšmapēm, izmantojiet
darbības pogu 

3. Pievienojiet attēlu eksportējamo attēlu sarakstam

- Noklikšķiniet ​ Add (Pievienot) pogas  

Noklikšķiniet uz pogas Add
(Pievienot), lai pievienotu atlasītos
attēlus eksportējamo attēlu
sarakstam.

Lai noņemtu attēlu no saraksta,
atlasiet attēlu un noklikšķiniet
uz pogas Remove from list
(Noņemt no saraksta).
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4. Nosakiet mērķa mapi

- Noklikšķiniet uz mazās pogas blakus lodziņam Destination folder (Mērķa mape), lai atvērtu
Windows dialoglodziņu

- Atlasiet pareizo mapi, uz kuru vēlaties eksportēt attēlus.

                      

Mērķa mape ir mape datorā, kurā
vēlaties glabāt attēlus.

5. Novērtējiet faila lielumu

- Noklikšķiniet ​ uz "Estimate" (Novērtēt) pogas

 

Pirms eksportējat attēlus uz datoru,
iespējams, vēlēsieties iegūt
priekšstatu par faila lielumu,
eksportējot failus. Šim nolūkam varat
izmantot pogu "Estimate" (Novērtēt).

6. Eksportējiet failus uz mapi

- Noklikšķiniet ​ uz "Export" (Eksportēt) pogas

 

Faili tiks eksportēti uz izvēlēto mapi.

8.6.3 Kā ierakstīt CD ar attēliem no Mediadent

Var būt noderīgi Mediadent saglabātos attēlus saglabāt CD vai DVD. 

Tas ir iespējams, izmantojot Mediadent opciju Eksportēt attēlu direktoriju. 

Ja jums ir dators ar Windows Vista vai Windows 7, to var izdarīt tieši no Mediadent.
Citās operētājsistēmās, piemēram, Windows XP, ir jāinstalē pakešu rakstīšanas programmatūra. Tā
datorā izveidos papildu diska burtu. Izmantojiet šo diska burtu Mediadent (4. darbība).

Darbība Paskaidrojums

1. Pārbaudiet sava diska burtu. Ievietojiet tukšu CD vai DVD datora diskdzinī
un pārbaudiet diska burtu. To var izdarīt,
izmantojot Windows failu pārlūku - šajā gadījumā
tas ir burts F:\

2. Programmā Mediadent izvēlieties File > Export
Picture Directory

.
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3. Eksporta loga apakšā izvēlieties diska burtu kā mērķa
mapi.

.

4. Tiek atvērts mapju pārlūks, dodieties uz diskdzini,
izvēlieties to un noklikšķiniet uz OK.

Operētājsistēmā Windows 7 vai Vista norādiet
diska burtu, kurā ir ievietots CD vai DVD.

Operētājsistēmā Windows XP norādiet diska
burtu, ko izveidojusi pakešu rakstīšanas
programmatūra.

5. Mēs iesakām izvēlēties pirmo opciju "Like a USB
flash drive" (Kā USB zibatmiņas diskā).

Šis solis attiecas tikai tad, ja jums ir
Windows Vista vai Windows 7.

Pārliecinieties, ka diskdzinī ir jauns CD vai DVD.
Windows jautās, kādā formātā vēlaties izmantot
CD.

Ja izvēlaties "Like a USB flash drive" (Kā USB
zibatmiņas diskā), varat izmantot CD vairākas
reizes - tas nozīmē, ka pēc tam varat ierakstīt
papildu attēlus tajā pašā CD.

Ja tiek izvēlēta opcija "With a CD/DVD
player" (Ar CD/DVD atskaņotāju), disks tiks
atvērts ar interfeisu.

6. Atlasiet attēlus un noklikšķiniet uz Export
(Eksportēt) pogas.

Atlasiet attēlus, video vai dokumentus, kurus
vēlaties eksportēt, atlasot failus attēlu bibliotēkā,

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

218

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



un noklikšķiniet uz Add (Pievienot) pogas. Ja
vēlaties eksportēt tos visus, noklikšķiniet uz pogas
Export all (Eksportēt visus).

Kad visi faili ir atlasīti, noklikšķiniet uz pogas
Export (Eksportēt) un tiks ierakstīts CD. Ja
progresa josla ir pilnībā zaļa, eksportēšana ir
pabeigta, un CD var izņemt.

(Windows automātiski aizvērs ierakstīšanas sesiju
kompaktdiskā.)

7. Noklikšķiniet uz Exit (Iziet) pogas.  Jūs pametīsiet eksportēšanas logu un
atgriezīsieties Mediadent galvenajā ekrānā.

8.6.4 Kā nosūtīt jebkura veida failu no failu pārlūka uz Mediadent

Kā zobārsts jūs bieži saņemat attēlus vai failus par saviem pacientiem no citiem zobārstiem.

Šie attēli vai faili tiek saglabāti kādā no jūsu diskiem. Iepriekš vienīgais veids, kā jūs varējāt importēt šos failus, bija
izmantot attēlu bibliotēkas failu importēšanas opciju.

Pamatojoties uz mūsu klientu atsauksmēm, tagad mēs piedāvājam papildu iespēju pievienot attēlus/failus jūsu
pacientu attēlu bibliotēkai.

Tagad varat pievienot failus/attēlus no Windows failu pārlūka tieši pacientu mapē.

Atlasiet 1 vai vairākus failus un izmantojiet peles labo pogu, lai aktivizētu izvēlni.

Izvēlnei ir pievienotas 2 papildu opcijas: Add to the current patient folder (Pievienot pašreizējā pacienta mapē)
un Add (Pievienot).

Ir 2 opcijas :

1. Pievienot pašreizējā pacienta mapē (pirmā opcija)

Atlasītais fails tiks nosūtīts aktīvajam pacientam (pacientam, kas ir atvērts programmā Mediadent).

2. Pievienot jebkurā aktīvā pacienta attēlu bibliotēkas vietā vai izvēlēties citu pacientu (otrā opcija).

Mēs izskaidrosim abas opcijas.
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1. opcija: Pievienot pašreizējā pacienta mapē
Piemērs: 1. opcija

Ekrāns Paskaidrojums

Palaidiet savu pacientu pārvaldības
sistēmu, atlasiet pareizo pacientu un
palaidiet Mediadent.

Noklikšķiniet ar peles labo pogu uz
attēla/faila. Izvēlnē izvēlieties opciju: Add
to current patient root folder
(Pievienot pašreizējā pacienta
saknes mapē)

Rezultāts : attēls tiks saglabāts atlasītā
pacienta saknes mapē.

 2. opcija: Add (Pievienot)
Izmantojot šo opciju, jums ir dažādas iespējas, kur tiks saglabāts atlasītais attēls vai fails:

1. Saglabāt pašreizējā saknes mapē (current patient ROOT folder): rezultāts ir tāds pats kā izvēloties pirmo
opciju Pievienot pašreizējā pacienta saknes mapē. Pacienta informācijā (Patient info) tiek parādīts
aktīvā pacienta numurs un pacienta vārds.

2. Saglabāt atlasītā pacienta pašreiz atlasītajā mapē (current patient SELECT folder): pacienta attēlu
bibliotēkā var būt vairākas mapes, un, izmantojot šo opciju, varat izvēlēties pievienot to atlasītajā mapē. Par
mapju izveidi lasiet šajā sadaļā: Darbs ar attēlu bibliotēku (Section 7.5.4)

3. Saglabāt globālajā mapē. Globālā mape (Global folder) ir mape, kas ir pieejama no jebkuras pacienta attēlu
bibliotēkas. Vairāk informācijas par globālo mapi var atrast šajā sadaļā: Globālā un pacienta bibliotēka
(Section 12.4)

4. Pirms attēla/faila saglabāšanas varat atlasīt citu pacienta mapi (SELECT another patient folder).
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2. opcija:  Attēla/faila pievienošana pašreizējā pacienta atlasītajā mapē

Ekrāns Paskaidrojums

Palaidiet savu
pacientu
pārvaldības
sistēmu,
atlasiet pareizo
pacientu un
palaidiet
Mediadent.

Noklikšķiniet
ar peles labo
pogu uz
attēla/faila un
izvēlnē atlasiet
opciju Add
(Pievienot)

Tiks atvērts
opciju ekrāns.
Izvēlieties
"Current
patient
SELECT
folder"
(pašreizējā
pacienta
atlasītā
mape)
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Nākamajā
dialoglodziņā
varēsiet
izvēlēties mapi
pacienta attēlu
bibliotēkā.

Izvēlieties,
piemēram,
"ortho".

Rezultāts:
attēls/fails tiks
saglabāts
pacienta attēlu
bibliotēkas
mapē "ortho".

Laukā
"Selected
directory"
(Atlasītais
direktorijs)
redzēsiet mapi,
kurā attēls/fails
tiks saglabāts.

3. opcija. Opcija "Saglabāt globālajā mapē" darbojas tieši tāpat kā pirmā opcija, t.i., saglabāt pašreizējā pacienta
mapē. Vienīgā atšķirība ir tāda, ka attēls/fails tiek saglabāts globālajā mapē, kas ir pieejama no jebkuras pacienta
mapes.

4. opcija: atlasīt citu pacienta mapi

Šī opcija ļauj izvēlēties citu pacienta mapi, kurā glabāt attēlu/failu. Tas nozīmē, ka jums nav jāiziet no Mediadent un
jādodas uz pacientu pārvaldības sistēmu, lai izvēlētos citu pacientu. Jūs varat izvēlēties citu pacientu tieši no
šīs opcijas.

Ekrāns Paskaidrojums

Mediadent ir jāpalaiž.
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Noklikšķiniet ar peles labo pogu uz attēla/faila un
izvēlnē atlasiet opciju Add (Pievienot)

Izvēlieties "SELECT other patient folder" (atlasīt citu pacienta
mapi).

Šī opcija ļauj izvēlēties citu pacienta mapi.

Atvērsies nākamais dialoglodziņš.

Atvērsies nākamais dialoglodziņš. Šajā dialoglodziņā var izvēlēties citu pacientu.

Pacientu saraksts, no kura var izvēlēties.

Jums ir pieejams ļoti plašs meklēšanas dialoglodziņš.

Direktorijs, kurā tiks veikta meklēšana
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Aktīvā pacienta attēlu mape, kurā var glabāt attēlus/failus.

8.7 Mediadent automatizācija
 

8.7.1 Kā izveidot makro

Kas ir makro?
Makro bieži izmanto uzdevumu atkārtošanai. Piemēram, ja jums bieži ir jāizvēlas starp attēlu iegūšanas
ierīcēm, jums ir iespēja šos soļus automatizēt.

Lai izveidotu makro, jūs ierakstīsiet vairākus taustiņsitienus vai izvēlnes opcijas. Pēc tam varat palaist
ierakstīto makro. Makro palaišanai var izmantot funkciju taustiņu vai ikonu no ikonu kopas.

To var salīdzināt ar mūzikas ierakstu, ko atskaņojat atkal un atkal.

Makro var izveidot Mediadent šādos 2 soļos:

1. Piešķirietvienu no ikonām vai funkcionālajiem taustiņiem, ko izmantosiet, lai palaistu makro. Pēc
izvēles makro var piešķirt karsto taustiņu*.

2. Ierakstiet makro. Ierakstiet taustiņsitienus vai izvēlnes opcijas.

1. darbība: Piešķiriet ikonu / karsto taustiņu

Darbība Paskaidrojums

1. Mediadent izvēlnē izvēlieties

Options > Macro's

Aktivizējiet izvēlni Macro's (Makro).

2. Noklikšķiniet uz Add (Pievienot) pogas. Poga Add (Pievienot) ļauj izveidot jaunu
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ierakstu makro sarakstā.

3. Noklikšķiniet uz "Create Button" (Izveidot pogu) un
izvēlieties vienu no ikonām ar ritjoslu

 

Šajā dialoglodziņā jums būs jāaktivizē
"Create Button" (Izveidot pogu) un
jāritina ritjoslā, lai izvēlētos vienu no
ikonām, noklikšķinot uz tās.

8. versijā ikonai tagad varat pievienot
tekstu, mainīt krāsu un fontu
lielumu.

Pēc tam šai ikonai pievienosiet makro.
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4. Laukā Description (Apraksts) ierakstiet makro nosaukumu.  Tagad esat izvēlējušies ikonu. Jums arī
būs jāpiešķir makro nosaukums.

Šajā piemērā ierakstījām nosaukumu
"Device 1".

5. Pēc izvēles: Varat piešķirt karsto taustiņu.

Tas ir īsinājumtaustiņš, ko varat izmantot, lai aktivizētu makro.

Piemēram, F3 nozīmē, ka varat izmantot
funkcijas taustiņu F3 (parasti atrodas
tastatūras augšpusē).

6. Noklikšķiniet uz Save (Saglabāt) pogas .

2. darbība: Ierakstiet makro

Darbības Paskaidrojums

1. Noklikšķiniet uz Record (Ierakstīt) pogas. Šajā ekrānā redzams, ka esat izveidojuši
makro ar nosaukumu Device 1 un tam
piešķīruši funkcijas taustiņu F3

Tagad mēs esam gatavi ierakstīt makro.

Makro ierakstīšana nozīmē, ka jūs
ierakstīsiet darbības, kuras vēlaties
saglabāt makro.

4. Noklikšķiniet uz OK Dialoglodziņā tiks paskaidrots, ka
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ieraksta pabeigšanai jāizmanto Ctrl+F12
(funkcijas taustiņš F12).

 + 

3. Sāciet ierakstīt darbības Skatiet, kādas darbības jeb soļus varat
ierakstīt, sadaļā Piemērs: makro
izveide.

4. Kad ierakstīšana ir pabeigta, nospiediet taustiņu kombināciju 

Ctrl + F12.

Tas beigs ierakstīšanu

5. Noklikšķiniet uz OK Noklikšķiniet uz OK, lai apstiprinātu, ka
ierakstīšana ir pabeigta.

Piemērs: makro izveide

Darbības Paskaidrojums

1. darbība. Aktivizējiet ikonu

1. Mediadent izvēlnē izvēlieties

Options > Macro's

Aktivizējiet izvēlni
Macro's (Makro).

2. Noklikšķiniet uz Add (Pievienot) pogas. Poga Add (Pievienot)
ļauj izveidot jaunu
ierakstu makro
sarakstā.

Š
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Šajā dialoglodziņā
jums būs jāaktivizē
"Create Button"
(Izveidot pogu) un
jāritina ritjoslā, lai
izvēlētos vienu no
ikonām, noklikšķinot
uz tās.

Piešķiriet pogai
nosaukumu, šajā
piemērā nosaukums
ir "Device 1",
mainiet fonta
lielumu uz 8 un
mainiet fonta krāsu
uz dSilver.

Makro var piešķirt
karsto taustiņu
F3.

6. Noklikšķiniet uz Save (Saglabāt) pogas .

2. darbība. Ierakstiet makro

7. Noklikšķiniet uz Record (Ierakstīt) pogas.

Veiciet darbības, kuras vēlaties ierakstīt makro.

Šajā ekrānā redzams,
ka esat izveidojuši
makro ar
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nosaukumu Device
1 un tam piešķīruši
funkcijas taustiņu
F3.

Tagad mēs esam
gatavi ierakstīt
makro.

Makro ierakstīšana
nozīmē, ka jūs
ierakstīsiet darbības,
kuras vēlaties
saglabāt makro.

8. Noklikšķiniet uz OK Kad esat pabeiguši
visas darbības, kuras
vēlaties ierakstīt savā
makro, varat
izmantot Ctrl-F12,
lai apturētu
ierakstīšanu.

3. darbība. Piemērs: Darbību ierakstīšana, lai automātiski tiktu atlasīts X-Ray Demo sensors

9. Izvēlieties Options > X-Ray Acquisition > X-Ray Demo

Sensor

Šīs ir darbības, kuras
vēlamies ierakstīt
savā makro.

10. Noklikšķiniet uz Acquisition (Iegūšana) ikonas ikonu joslā Noklikšķiniet uz
ikonas.
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Tiek atvērts attēlu
iegūšanas ierīces
ekrāns.

Atkarībā no izvēlētās
ierīces parādīsies citi
ekrāni.

11. Lai pabeigtu ierakstīšanu, nospiediet Ctrl + F12 Izmantojiet taustiņu
kombināciju Ctrl +
F12 (funkcijas
taustiņš F12)

12. Noklikšķiniet uz OK .

13. Testējiet makro, noklikšķinot uz ikonas, kurai esat piešķīruši makro, vai
izmantojot karsto taustiņu kombināciju.

Mūsu gadījumā mēs
makro piešķīrām
ikonai.
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9 Jaunums: Jautājumi un atbildes

Šajās sadaļās sniegts pārskats par atbalsta jautājumiem, ar kuriem mēs bieži saskaramies.

Aprakstītas problēmas un piedāvāti iespējamie risinājumi.

Ko darīt, kad Mediadent tiek palaista DEMO režīmā? (Section 9.1)

(Section 9.1)

9.1 Ko darīt, kad Mediadent tiek palaista DEMO režīmā?

Simptoms
Kad es palaižu Mediadent, uz ekrāna sarkanā krāsā parādās vārds "DEMO".

Apraksts
Mediadent programmatūra darbojas ar īpašu USB atslēgu vai paralēlo drošības atslēgu.

Paralēlo atslēgu attēli:
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USB drošības atslēgas attēls:

Palaižot Mediadent demonstrācijas (demo) režīmā, tam var būt vairāki iemesli, piemēram:

1. Ja šī atslēga nav pieejama jūsu datorā vai serverī, Mediadent tiks palaista demonstrācijas režīmā.

2. Cits iemesls var būt tāds, ka atslēga vairs nav derīga instalētajai Mediadent versijai.

Risinājums 
Šī problēma jārisina izplatītājam, bet, pirms sazināties ar izplatītāju, varat veikt šādu pārbaudi: 

1. Atrodiet USB atslēgu vai paralēlo atslēgu. Jūs atpazīsiet šo atslēgu, jo uz tās ir zaļa uzlīme ar numuru, kas sākas
ar U vai N. (U ir viens lietotājs, bet N nozīmē tīklu).

2. Pārliecinieties, ka atslēga ir ievietota datora USB portā vai paralēlajā portā, vai tīkla instalācijas gadījumā -
datorā, kas darbojas kā serveris.

3. Pārbaudiet, vai atslēga darbojas pareizi (USB atslēgas gadījumā jūs redzēsiet mazu zaļu gaismiņu, kas norāda,
ka atslēga darbojas pareizi) - ja jums ir aizdomas, ka USB atslēga ir bojāta, lūdzu, sazinieties ar izplatītāju.

4. Tīkla instalācijas gadījumā pārliecinieties, ka serveris ar atslēgu ir ieslēgts un ka jums ir piekļuve šim
serverim. Varat restartēt serveri un pārbaudīt, vai programma Mediadent tiek palaista normāli.

5. Ugunsmūris vai pretvīrusu programma var bloķēt piekļuvi drošības atslēgai. Lai to pārbaudītu, izslēdziet
ugunsmūri un/vai pretvīrusu programmu un pārbaudiet, vai programma Mediadent tiek palaista normāli. Lūdzu,
sazinieties ar savu izplatītāju, lai saņemtu informāciju par pareizu ugunsmūra un pretvīrusu programmas
konfigurāciju.

6. Ja esat to pārbaudījuši, iespējams, ka atslēga vairs neatbalsta Mediadent versiju, kuru mēģināt palaist.
Sazinieties ar savu izplatītāju, lai iegūtu vairāk informācijas par Mediadent jauninājumiem.
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10 Mediadent iestatīšana
 

10.1 Paziņojums

Lietotājam jāizmanto atsevišķā MediadentInstalācijas rokasgrāmata, kurā sniegtas pakāpeniskas instrukcijas
par instalēšanu/atinstalēšanu. Šis solis ir priekšnoteikums pirms Mediadent tālākas konfigurēšanas, kā
paskaidrots nākamajās apakšsadaļās. Instalāciju var veikt tikai vidē, kas atbilst minimālajām sistēmas
prasībām (3.1. sadaļa). Jautājumu gadījumā iepazīstieties ar plašāku informāciju sadaļā Atbalsta
saņemšana (13. sadaļa).

10.2 Pārskats par Mediadent iestatīšanu

Šajās sadaļās ir izskaidrotas dažādas konfigurācijas opcijas programmā Mediadent. Šī ir padziļināta tēma,
un izmaiņas var ietekmēt, to, kā darbojas Mediadent.

Ja jums ir kādi jautājumi vai piezīmes, lūdzu, sazinieties ar mums. Iepazīstieties ar plašāku informāciju sadaļā
Atbalsta saņemšana (Section 13).

1. Vispārīgie iestatījumi (Section 10.3)
2. Reģionālie reģistrācijas iestatījumi (Section 10.4)
3. Displeja iestatījumi (Section 10.5)
4. Dažādi iestatījumi un apkope (Section 10.7)
5. Moduļi (Section 10.8)

10.3 Vispārīgie iestatījumi

Šajā padziļinātajā sadaļā ir parādīti vairāki iestatījumi, kurus varat konfigurēt programmā Mediadent.

Sadaļā Vispārīgie iestatījumi varat:  

 Mainīt ārsta informāciju

 Noteikt, kā Mediadent reaģēs noteiktos apstākļos, piemēram, dzēšot attēlus, saglabājot failus utt. Varat arī
izvairīties no attēlu neatgriezeniskas dzēšanas

 Norādīt, kā Mediadent rīkojas ar attēlu formātu
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1. Kā mainīt ārsta informāciju

Ja jūsu praksē ir vairāki zobārsti, var būt praktiski, ja statusa joslā ir norādīts ārsta vārds.

 

Ir 2 veidi, kā mainīt ārsta vārdu:

1. Mainīt vārdu Mediadent Setup>General Settings.

2. Mainīt vārdu pacientu pārvaldības sistēmā. Pacientu pārvaldības sistēmas pārdevējs varēs palīdzēt jums
integrēt ārsta vārdu programmā Mediadent.

Izmaiņas, kas veiktas jūsu pacientu pārvaldības sistēmā, būs prioritāras pār Mediadent iestatīšanā
veiktajiem iestatījumiem.

Veiciet tālāk norādītās darbības, lai mainītu ārsta vārdu Mediadent.

Darbība

1. Dodieties uz Mediadent Setup>General Settings

2. Ierakstiet ārsta vārdu laukā Practitioner Info (Ārsta informācija) (var tikt noraidīts ar OLE un
komandrindu).

3. Saglabājiet izmaiņas
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4. Izejiet

2. Kā izvairīties no failu neatgriezeniskas dzēšanas

1. Lai izvairītos no failu neatgriezeniskas dzēšanas no cietā diska, izpildiet šādas darbības.

Darbība

1. Dodieties uz Options>Setup

2. Cilnē General settings (Vispārīgie iestatījumi): Atlasiet opciju "Delete files to recycle bin" (Dzēst
failus uz atkritni).

Ja šī opcija ir atzīmēta, jūs vienmēr varēsiet atgūt attēlus no atkritnes.

Tas jādara tikai vienu reizi. Šis iestatījums tiks saglabāts Mediadent.

Tas darbosies tikai šajā konkrētajā datorā. Tas nedarbosies tīkla konfigurācijā.

2. Attēlu atgūšana no atkritnes

Darbība Paskaidrojums

1. Veiciet dubultklikšķi uz atkritnesbin Windows operētājsistēmā, lai to
atvērtu

Atveriet atkritni
Windows
operētājsistēmā.

Meklējiet
Mediadentattēlu failus.

Attēlu failu veido 3
faili:

.DIC fails

.mih fails

.bmp fails

Jums jāatjauno šie 3
faili.

Atlasiet pirmo failu un noklikšķiniet ar LABO peles pogu uz faila. Parādīsies
izvēlne. Atlasiet Restore (Atjaunot) vai izvēlieties Restore this item
(Atjaunot šo vienumu) izvēlnē.

Atkārtojiet šo darbību
visiem 3 failiem.

 

Attēliem jābūt uzņemtiem darbstacijā, kurā atrodas atkritne. Tas nedarbosies tīkla vidē, ja serveris
darbojas kā attēlu glabātava.

3. Svarīgas lietas, kas jāpārbauda problēmu gadījumā
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Ja, saglabājot attēlus, rodas problēmas, pārliecinieties, vai ir pareizi konfigurēts attēlu formāts.

Pārbaudiet šo opciju un pārliecinieties par pareizu saspiešanu:

4. Kā apskatīt pēdējos attēlus skatvietās

Ir iespējams apskatīt jaunākos konkrēta pacienta attēlus. Nākamreiz atverot pacienta mapi, tiks ielādēti pēdējie
apskatītie attēli. 

Lūdzu, atzīmējiet šo opciju iestatījumos

10.4 Reģionālie reģistrācijas iestatījumi

Šajā padziļinātajā sadaļāmēs izskaidrosim Mediadent reģionālo reģistrācijas iestatījumu opcijas.

Šajā cilnē varēsiet konfigurēt šādas opcijas:

 Datuma formāts: Varat izvēlēties starp Eiropas un Amerikas datumu formātu

  Zobu numuri: Jūs varat konfigurēt zobu numurus atbilstoši jūsu valstī izmantotajam standartam.

 Reģistrācijas iestatījumi: Ja jums ir jautājumi par šo tēmu, lūdzu, sazinieties ar mūsu palīdzības
dienestu. Lai uzzinātu instrukcijas, izlasiet sadaļu Atbalsta saņemšana (Section 13).
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Vienmēr saglabājiet izmaiņas pirms izejat no dialoglodziņa, citādi izmaiņas nestāsies spēkā.

Lai iegūtu vairāk informācijas par šiem iestatījumiem, sazinieties ar mūsu palīdzības dienestu.

Kā mainīt zobu numerāciju

Jums ir iespēja mainīt zobu numerāciju.

Ir 3 iespējas:

- Universālā numerācijas sistēma

- FDI divciparu sistēma

- Palmera sistēma

Lai mainītu zobu numerāciju, noklikšķiniet uz atbilstošajām ikonām

Ikona Rezultāts
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Universālā numerācijas sistēma

FDI divciparu sistēma

Palmera sistēma
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Vitor Haderup sistēma

Vienmēr saglabājiet izmaiņas pirms izejat no dialoglodziņa, citādi izmaiņas nestāsies spēkā.

10.5 Displeja iestatījumi

Šajā padziļinātajā sadaļā mēs izskaidrosim vairākus iestatījumus, kurus var konfigurēt, lai palīdzētu jums atrast attēlus,
pamatojoties uz atslēgvārdiem un papildu informāciju, ko varat saistīt ar saviem attēliem.

Izvēlnē Mediadent Setup> Display settings jums ir iespēja konfigurēt šādas lietas:

Definēt attēla rekvizītu iestatījumus piemēram, laukus User (Lietotājs), Grade (kategorija), Type (Veids).
Izlasiet sadaļu Pārskats par konkrētu papildu informāciju un atslēgvārdiem (Section 7.5.2), lai saprastu,
kā tos var izmantot.

Definēt attēlu bibliotēkas iestatījumus, piemēram, noklusējuma mapes, ko Mediadent izveidos attēlu bibliotēkā
(piemēram, DFO, Video, u.c.).

Definēt statusa iestatījumus, kas ļaus noteikt opcijas statusa iegūšanas režīmā un statusa pilnekrāna režīmā.

Definēt skatvietu iestatījumus, piemēram, režģa vai lineāla rādīšanu kalibrētos attēlos.

Pozicionēšanas palīgs ir šīs versijas jaunums, šeit jūs varēsiet konfigurēt, kur tiek saglabāti pozicionēšanas palīga
attēli un cik ilgi tiks rādīts pilnekrāna skats.

Šeit atradīsiet arhivēšanas iestatījumus. Jūs varēsiet izvēlēties arhīva mapi.

Cilnē Ikonas varat noteikt ikonu izskatu (klasiskais vai jaunais izskats).
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1. Attēla rekvizītu iestatījumu definēšana

Cilnē Image Properties Settings (Attēla rekvizītu iestatījumi) var konfigurēt laukus, kurus varat izmantot filtrēšanai.

Š
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Sadaļā Papildu informācijas un atslēgvārdu norādīšana uzzināsiet, kā atlasīt papildu informāciju un atslēgvārdus. Šajā sadaļā
izskaidrosim, kā izveidot sarakstus ar atslēgvārdiem, no kuriem varat izvēlēties.

Ir 2 cilnes, kurās var ievadīt papildu laukus:

- Extra Info (Papildu informācija): Lauki Info (Informācija), User (Lietotājs), Grade (Kategorija), Type (Veids)

- Keywords (Atslēgvārdi): Lietotāja definētie atslēgvārdi. Šos atslēgvārdus varat izvēlēties jūs paši.

1.1 Extra Info (Papildu informācija)

Jums ir iespēja attēliem pievienot papildu informācijas laukus. Šie lauki ir saistīti ar jūsu attēliem, un tos var izmantot
filtrēšanai. Pievienojot laukus displeja iestatījumos, tie būs pieejami attēla rekvizītos.

Šajā piemērā mēs parādīsim, kā pievienot 2 vārdus lauka "Lietotājs" failam. Pēc izveidošanas tiem var piekļūt,
izmantojot attēla rekvizītus, un tāpat tie ir pieejami arī attēla saglabāšanas laikā.

Darbība Paskaidrojums

1. darbība. Mediadent izvēlnē izvēlieties Options>Setup un izvēlieties cilni Display Settings
(Displeja iestatījumi)

 

Šie ir dažādie
lauki, kurus varat
konfigurēt.

2. darbība. Noklikšķiniet uz ikonas blakus <APPLDIR>\users.txt. Šajā piemērā mēs
vēlamies
pievienot 2
lietotājus, tāpēc
attēla rekvizītos
varam izvēlēties
starp 2
lietotājiem.

Cilnē Image
Properties
Settings (Attēla
rekvizītu
iestatījumi)
noklikšķiniet uz
ikonas, lai
mainītu lauka
"Lietotājs"
failu.

Atvērsies
piezīmjbloks.

Piezīmjblokā
varēsiet ierakstīt
lietotāju sarakstu.

Piezīmjblokā var
mainīt arī
kategoriju, attēlu

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

241

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



Nākamā darbība

tipus un
komentārus.

 3. darbība. Ierakstiet vārdus piezīmjblokā Ierakstiet
lietotāju vārdus.

Šajā piemērā
lietotāji ir gunter
un Benjamin.
Ierakstiet pirmo
vārdu un
nospiediet Enter,
pēc tam ierakstiet
otro vārdu.

4. darbība. Izvēlieties File>Save

5. darbība. Izvēlieties File>Exit

Pēc vārdu
ierakstīšanas
neaizmirstiet
saglabāt
piezīmjbloka
failu.

6. darbība. Izvēlieties Save Changes (Saglabāt izmaiņas)Mediadent iestatīšanas ekrānā. 

7. darbība. Izejiet no Mediadent iestatīšanas ekrāna.

Pēc atgriešanās
Mediadent
iestatīšanas
ekrānā, izmaiņas
vēl ir jāsaglabā
Mediadent.

Lai izmaiņas stātos spēkā, programma ir jāaizverMediadent un jārestartē.

Lai pārbaudītu veiktās izmaiņas, atlasiet attēlu un mainiet tā rekvizītus. Izlasiet sadaļu Attēla rekvizītiI

Tādā pašā veidā var mainīt kategoriju, attēla veidu un komentārus. Varat atkārtot vairākus soļus jeb
darbības, kā paskaidrots iepriekš.

Darbība Paskaidrojums

Lai mainītu komentāru lauku

Atkārtojiet 1. darbību. Pārejiet uz 1.
darbību
iepriekšējā
paskaidrojumā.

2. Noklikšķiniet uz ikonas blakus <APPLDIR>\comments.txt.

 

Tas ļaus jums
pievienot
standarta
komentārus

3. Ierakstiet komentārus piezīmjblokā .

Atkārtojiet 4. līdz 7. darbību. Atgriezieties pie
iepriekšējā
skaidrojuma 4.
darbības un
atkārtojiet
darbības līdz 7.
darbībai.

Lai mainītu kategorijas lauku

Atkārtojiet 1. darbību. Pārejiet uz 1.
darbību
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iepriekšējā
paskaidrojumā.

2. Noklikšķiniet uz ikonas blakus <APPLDIR>\imagegrades.txt.

 

Tas ļaus jums
mainīt
kategorijas. Pēc
noklusējuma ir A,
B un C
kategorijas.

3. Ierakstiet kategorijas piezīmjblokā .

Atkārtojiet 4. līdz 7. darbību. Atgriezieties pie
iepriekšējā
skaidrojuma 4.
darbības un
atkārtojiet
darbības līdz 7.
darbībai.

Lai mainītu attēla tipu

Atkārtojiet 1. darbību. Pārejiet uz 1.
darbību
iepriekšējā
paskaidrojumā.

2. Noklikšķiniet uz ikonas blakus <APPLDIR>\imagetypes.txt. Tas ļaus mainīt
attēlu veida
lauku. Attēlu
veidu sarakstu
varat mainīt
piezīmjbloka
ekrānā.

3. Ierakstiet dažādus attēlu veidus piezīmjblokā .

Atkārtojiet 4. līdz 7. darbību. Atgriezieties pie
iepriekšējā
skaidrojuma 4.
darbības un
atkārtojiet
darbības līdz 7.
darbībai.

1.2. Attēlu atslēgvārdu saraksts

Šie ir lietotāja definētie atslēgvārdi, un jūs paši varat tos definēt. Šīm laukiem varēs piekļūt attēla rekvizītos, un tāpat tie
ir pieejami arī attēla saglabāšanas laikā.

Darbība Paskaidrojums

Dodieties uz Mediadent iestatīšana: Displeja iestatījumi, kā iepriekš aprakstīts

Izvēlieties "Image Keyword List" (Attēlu atslēgvārdu saraksts) cilni Cilnē "Image
Keyword List"
varat pievienot
savus
atslēgvārdus.

Š
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Ierakstiet atslēgvārdu. Šajā piemērā ir
ievadīts
atslēgvārds
"Morita".

Noklikšķiniet uz Add (Pievienot) pogas. Vajadzības
gadījumā varat
ievadīt otru
atslēgas vārdu.

Noklikšķiniet uz "Save Changes".

Vienmēr
saglabājiet
izmaiņas pirms
iziešanas no
dialoglodziņa.

Noklikšķiniet uz "Exit".

Lai pārbaudītu,
attēlu bibliotēkā
atlasiet attēlu un
mainiet attēla
rekvizītus. Jums
būs iespēja
pievienot jauno
definēto
atslēgvārdu.

Jums ir iespēja pieprasīt atslēgvārdus katru reizi, kad veicat attēla iegūšanu. Atzīmējiet opciju
"Ask for keywords after acquisition" (Pieprasīt atslēgvārdus pēc attēla iegūšanas).

.

2. Attēlu bibliotēkas iestatījumi

Attēlu bibliotēkas iestatījumi ļauj mainīt attēlu bibliotēkas izkārtojumu. Izmantojot šīs opcijas, varēsiet arī iestatīt
noklusējuma mapes, kas tiek izveidotas katru reizi, kad pievieno jaunu pacientu.
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Display logo in Image Library (Attēlu bibliotēkā rādīt logotipu): Ja nevēlaties redzēt Mediadent logotipu, noņemiet
atzīmi pie šīs opcijas.

Monitor/Auto refresh Image Library (Uzraudzīt/Automātiski atsvaidzināt attēlu bibliotēku): Šī opcija automātiski
atsvaidzina attēlu bibliotēku, kad tiek pievienoti jauni attēli.

Show tiny teeth chart (Rādīt sīku zobu shēmu): Noņemiet atzīmi pie šīs opcijas, ja nevēlaties attēlu bibliotēkā redzēt
zobu shēmu.

Ja atzīmējat opciju "Activate the global folder by default in the Image Library (Pēc noklusējuma aktivizēt
globālo mapi attēlu bibliotēkā), tas nozīmē, ka, atverot pacienta bibliotēku, globālā mape vienmēr būs redzama.

Lai saprastu, kā izmantot globālo mapi, izlasiet sadaļu Globālā un pacienta bibliotēka un Kā pārvietot attēlus no viena
pacienta uz citu.

Varat noteikt, kuras mapes pēc noklusējuma tiek izveidotas pacienta bibliotēkā.

Lai pievienotu noklusējuma mapi, ierakstiet mapes nosaukumu lodziņā.

3. Skatvietas iestatījumi

Lineāls

Šajā attēlā redzamais lineāls skaidrības labad ir iestatīts ZAĻĀ krāsā.

Režģis

Šajā attēlā redzamais režģis skaidrības labad ir iestatīts ZAĻĀ krāsā un
ar lielumu 3 mm.
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Šajā dialoglodziņā varat izvēlēties cilni Viewport Settings (Skatvietas iestatījumi) un mainīt noklusējuma iestatījumus
režģim un mērogam.

Ja šī opcija ir atzīmēta, skatvietā automātiski būs redzams režģis.

Varat mainīt režģa taisnstūra lielumu, lai nodrošinātu labāku analīzi.

Var konfigurēt arī režģa stilu.

Krāsas maiņa var palīdzēt vizualizēt režģi attēlā.

Ja vēlaties, lai lineāls būtu redzams skatvietā, atzīmējiet šo opciju.

Varat izvēlēties lineāla pozīciju: kreisajā pusē augšā, labajā pusē augšā, kreisajā pusē apakšā, labajā pusē apakšā.

Protams, krāsu var mainīt, lai nodrošinātu labāku redzamību.

Nosakiet, cik sekundes attēlu var skatīt pilnekrāna režīmā pēc attēla uzņemšanas attēlu iegūšanas režīmā.

Atzīmējiet šo opciju, ja vēlaties redzēt pēdējos skatītos pacienta attēlus.

10.6 Archive Settings (Arhīva iestatījumi)

Mediadent iestatīšanā jūs noteiksiet, kur atrodas arhīva mape.

Šajā nodaļā mēs izskaidrosim, kā iestatīt arhīva mapi un kā noņemt arhīva mapi.

1. Arhīva mapes iestatīšana

Veiciet darbības, lai noteiktu arhīva mapes atrašanās vietu:

1. Izvēlieties Options > Setup

Sadaļā General Settings (Vispārīgie iestatījumi)  izvēlieties cilni Display settings (Displeja

iestatījumi)

Cilnē Display Settings izvēlieties cilni Archive Settings (Arhīva iestatījumi)
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 Nosakiet arhīva atrašanās vietu  . Varat izvēlēties vairākas atrašanās vietas.

2. Lai izvēlētos atrašanās vietu, noklikšķiniet uz mapes ikonas   , tiks atvērts failu pārlūks, un jūs varēsiet

izvēlēties arhīva mapi  .
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3. Mape tiek pievienota arhīva mapju sarakstam.

Neaizmirstiet nospiest "Save Changes" pirms iziešanas no iestatīšanas loga.

 2. Arhīva mapes noņemšana

Jūs vienmēr varat noņemt arhīva mapi. Tas nenozīmē, ka arhīva mapē glabātie attēli tiks dzēsti. Tas ir tikai veids,
kā izņemt mapi no pieejamo vietu saraksta.

Tātad attēli joprojām būs pieejami šajā atrašanās vietā, bet lietotājs to vairs nevarēs izvēlēties no
pieejamo vietu saraksta.

1. Izvēlieties Options > Setup

Sadaļā General Settings (Vispārīgie iestatījumi) izvēlieties cilni Display Settings (Displeja iestatījumi).

Sadaļā Display Settings (Displeja iestatījumi) izvēlieties cilni Archive Settings (Arhīva iestatījumi).

 

2. Atlasiet mapi, kuru vēlaties noņemt, no pieejamo arhīva vietu saraksta . Šajā piemērā mēs izvēlamies
"c:\temp".

3. Noklikšķiniet uz ikonas  , lai noņemtu ierakstu no saraksta.

Neaizmirstiet nospiest "Save Changes" pirms iziešanas no iestatīšanas.
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10.7 Dažādi iestatījumi un apkope

Attiecībā uz programmatūras uzturēšanu pastāv divi atjaunināšanas scenāriji: automātiska atjaunināšana,
izmantojot Live Update (ja iegādāts), vai manuāla, sazinoties ar jūsu izplatītāja tehniskā atbalsta speciālistu.

Iepazīstieties ar plašāku informāciju sadaļā Atbalsta saņemšana (Section 13).

10.8 Moduļi

Šajā cilnē ir parādīti dažādie moduļi, kas ir ielādēti Mediadent.

Modulis ir neliela programma, kas tiek ielādēta, palaižot Mediadent, un šī nelielā programma nodrošina, ka
Mediadent var darboties ar jūsu attēlu iegūšanas ierīci.

Ja krāsa ir zaļa, tas nozīmē, ka modulis ir ielādēts un to var izmantot Mediadent.

Mediadentpalaišanas laikā tiek ielādēti aktivizētie moduļi.

Ja vēlaties, lai Mediadent tiktu palaista ātrāk, varat atspējot visus rentgena moduļus, noklikšķinot uz

pogas  "Disable all X-Ray modules"  . 

Pēc tam varat aktivizēt tikai to rentgena moduli, kuru vēlaties izmantot.

Ja vēlaties deaktivizēt tikai 1 moduli, noklikšķiniet uz zaļā lodziņa moduļa priekšā. Šajā gadījumā mēs
deaktivizēsim moduli X-Ray Asahi.

Jūs pamanīsiet, ka lodziņš moduļa priekšā ir SARKANS - tas nozīmē, ka modulis ir deaktivizēts un, palaižot
programmu, netiks palaists.
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Nedeaktivizējietjūsu attēlu iegūšanas ierīci!

Ja neesat pārliecināti par šo iestatījumu, lūdzu, sazinieties ar mums. Izlasiet instrukcijas par to, kā saņemt
atbalstu: Atbalsta saņemšana (Section 13).
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11 Mediadent moduļu iestatīšana
 

11.1 Optimizācijas modulis

Optimizācijas profila maiņa ir viena no padziļinātajām funkcijām programmā Mediadent.

Varat izveidot optimizācijas profilu, kas automātiski veiks noteiktas darbības, kuras uzlabos attēlu.

Optimizācijas profilā varat veikt šādas darbības, lai uzlabotu attēlu:

- Flip vertical (Apvērst vertikāli)

- Flip Horizontal (Apvērst horizontāli)

- Rotate (Rotēt)

- Invert (Invertēt)

- Lietot filtrus Unsharp Mask, Gamma, Gaussian Blur u.c.

- Stretch Intensity (Izstiept intensitāti)

- Histo Equaliz (Histogrammas ekvalaizers)

- ....

Šos iestatījumus var saglabāt optimizācijas profilā un lietot attēliem.

Optimizācijas profilu var lietot 2 veidos.

1. Optimizācijas profils tiek lietots automātiski, kad tiek veikta attēla iegūšana ar konkrētu iegūšanas ierīci.

2. Optimizācijas profils tiek lietots manuāli. Izlasiet sadaļu Darbs ar optimizācijas funkciju (Section 7.2.7). 

Šajā padziļinātajā sadaļā uzzināsiet, kā modificēt optimizācijas profilu un kā optimizācijas profilu var piešķirt attēlu iegūšanas
ierīcei, lai optimizācijas profils tiktu lietots automātiski (1. punkts).

1. Optimizācijas profila modificēšana

Darbība Paskaidrojums

Mediadent izvēlnē izvēlieties Options>Setup

Ierakstiet"Optimize" meklēšanas lodziņā

Modulis
"Optimize" būs
automātiski

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

251

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



aktīvs.
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Pārskats par optimizācijas ekrānu

Šie ir dažādie pieejamie filtri, kurus var saglabāt optimizācijas profilā.

Sarakstu var ritināt uz leju un atrast vairāk vai mazāk tādas pašas opcijas kā Filtru opcijas.

Izvēlētajai optimizācijai saglabāto filtru saraksts. Šajā piemērā ir atlasīts optimizācijas profils "Morita".

Izdzēsīs sarakstā atlasīto filtru.

Tādējādi tiks dzēsti visi šī konkrētā optimizācijas profila filtri.

Optimizācijas profila apraksts. Šajā gadījumā mēs esam pārdēvējuši "Optimize 1" par "Morita".

Katra cilne atbilst atsevišķam optimizācijas profilam. Varat konfigurēt līdz 5 optimizācijas profiliem. Katrā
optimizācijas profilā ir saraksts ar veicamajām filtrēšanas darbībām.

Pirms izejat no šī ekrāna, vienmēr saglabājiet izmaiņas (tas NETIEK veikts automātiski).

Pēc noklusējuma jau ir pieejami vairāki Optimizācijas profili.

Jūs varat mainīt Optimizācijas profilus. Ja neesat apmierināti, varat atgriezties pie noklusējuma iestatījumiem,
izmantojot šo pogu.

Cilne Appearance (Izskats) tiek izmantota, lai piesaistītu konkrētu optimizācijas profilu attēlu iegūšanas ierīcei.
Skaidrojums par to būs sniegts tālāk.

Piemērs: Mēs modificēsim Optimize 3 un pievienosim darbību Flip Vertical (Apvērst vertikāli)

1. Dodieties uz moduli Optimize (Optimizācija) Mediadent iestatījumos .

2. Noklikšķiniet uz cilnes Optimize 3

2. Noklikšķiniet uz ikonas blakus darbībai Flip Vertical

Jūs pamanīsiet,
ka darbība Flip
Vertical (Apvērst
vertikāli) ir
pievienota
lietojamo filtru
sarakstam.

Katru reizi, kad
ikonu kopā
noklikšķināsiet uz
pogas Optimize
1, šīs darbības
tiks veiktas
atlasītajam
attēlam skatvietā.

3. Saglabājiet izmaiņas Pirms iziešanas
no iestatīšanas
ekrāna vienmēr
saglabājiet
izmaiņas.

2. Optimizācijas profila piešķiršana attēlu iegūšanas ierīcei

Cilne Appearance (Izskats) tiek izmantota, lai piesaistītu konkrētu optimizācijas profilu attēlu iegūšanas ierīcei.

Piemēram: Ja jūsu ierīcei attēls vienmēr ir jāapvērš horizontāli, tad varat izveidot tam paredzētu optimizācijas profilu un piešķirt
to šai konkrētajai attēlu iegūšanas ierīcei.

 

Noklusējuma sākotnējais iestatījums (Default Core Preset). Šī ir pēc noklusējuma pieejamā optimizācija.

Šis ir attēlu iegūšanas ierīču saraksts, kurām var piešķirt optimizācijas profilu. Tiks izpildīts profilā definētais
darbību saraksts.

Lai piesaistītu optimizācijas profilu ierīcei, atzīmējiet šo izvēles rūtiņu.

Lai aktivizētu optimizācijas profilu ierīcei, atzīmējiet opcijas pogu.

Lai aktivizētu optimizācijas profilu ierīcei, atzīmējiet opcijas pogu.

Mediadent lietotāja rokasgrāmata V8 - 1. daļa:
Mediadent

253

©%2024 Imagelevel, Corilus NV. Visas tiesības aizsargātas.



3. Piemērs: Profila Optimize 3 maiņa un piesaistīšana Demo sensoram

Kā piemēru mēs veiksim 2 darbības. Vispirms jānosaka darbību saraksts un pēc tam šim darbību sarakstam jāpiešķir ierīce.

Šajā piemērā nomainīsim optimizācijas profilu Optimize 4 un piesaistīsim to Demo sensoram.

Mēs vēlamies, lai, izmantojot Demo sensoru, katru reizi, kad iegūstam attēlu, tas tiktu apvērsts vertikāli.

Darbība Paskaidrojums

1. darbība: Konfigurējiet darbību sarakstu

1. Noklikšķiniet uz cilnes Optimize 4 Vispirms mēs
konfigurēsim
darbību sarakstu
profilam
Optimize 4.

2. Noņemiet visas darbības no optimizācijas profila, nospiežot pogu Clear (Notīrīt). Mēs noņemsim
visas darbības,
kas ir
noklusējuma
darbības.

3. Noklikšķiniet uz ikonas blakus darbībai Flip Vertical Sarakstā
parādīsies
darbība "Flip
Vertical"
(Apvērst
vertikāli).

4. Saglabājiet izmaiņas Mēs saglabāsim
darbību sarakstu
Optimize 4.

2. darbība: Piesaistiet optimizācijas profilu Demo sensoram.

1. Dodieties uz cilni Appearance (Izskats).

2. Moduļu sākotnējo noascījumu sarakstā izvēlieties Demo sensoru.

3. Izvēlieties optimizācijas profilu, atzīmējot Optimize 4

4. Aktivizējiet profilu Optimize 4, atzīmējot opcijas pogu

Profila Optimize
4 sasaiste ar
attēlu iegūšanas
ierīci tiek veikta,
izmantojot cilni
Appearance
(Izskats).

Atzīmējiet
Optimize 4
izvēles rūtiņu, lai
piesaistītu
profilu ierīcei.

Tas ir arī
jāaktivizē. To
veic, atzīmējot
opcijas pogu
pirms profila
Optimize 4.

Tātad ir jāatzīmē
gan izvēles
rūtiņa, gan
opcijas poga.

5. Saglabājiet izmaiņas - Izvēlieties "Yes" (jā), lai saglabātu izmaiņas Pirms iziešanas
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no moduļa
vienmēr ir jāveic
saglabāšana,
pretējā gadījumā
iestatījumi netiks
saglabāti.

6. Nospiediet Exit (Iziet) Katru reizi, kad
izmantosiet šo
ierīci, tiks
izpildīts darbību
saraksts
Optimize 3. Šajā
gadījumā tā ir
vertikālā
apvēršana.

Optimizācijas profils ir saistīts arī ar filtriem, ko varat lietot attēlam. Visus filtra iestatījumus var saglabāt optimizācijas
profilā un lietot attēlu iegūšanas laikā.
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12 Vispārīgu tēmu skaidrojums
 

12.1 Skatvieta

Skatvieta ir reģions, kurā var ielādēt attēlu analīzes vajadzībām. Attēla ielādēšanu var veikt, vispirms
aktivizējot skatvietu. Lai aktivizētu skatvietu, tā ir jāatlasa, noklikšķinot uz reģiona ar peles kreiso pogu. Kad
skatvieta ir aktivizēta, redzēsiet, ka tā maina krāsu (tumši pelēka). Tagad varat veikt dubultklikšķi uz attēla
attēlu bibliotēkā, un tas tiks ielādēts skatvietā.

12.2 Darbvirsma

Darbvirsma ir veids, kādā ekrānā tiek attēloti dažādi ekrāna elementi, piemēram, skatvietas, ikonu kopa,
attēlu bibliotēka u.c.

Darbvirsma nosaka:

Cik daudzas Viewports <STRONG>Viewport </STRONG>is a region to which you can load an
<STRONG>image </STRONG>for analysis purposes. Loading an image can be done by first
<STRONG>activating </STRONG>the Viewport. To activate a Viewport you have to select it by clicking
in the region with your left mouse button. Once the Viewport is activated you will see that it changes
color (dark grey). Now you can <STRONG>double click </STRONG> uz attēla, un tas tiks ielādēts
skatvietā.  ir redzamas.
Kāda ir ikonu kopas pozīcija
Kur atrodas attēlu bibliotēka
Vai un kur ir novietota histogramma
Vai un kur ir novietota spilgtuma/kontrasta josla

Īsāk sakot, tā nosaka jūsu darbvirsmas izskatu programmā Mediadent.

Vairāk par dažādiem darbvirsmas elementiem lasiet tēmā par ekrāna elementiem (Section 5.1).

Viens Mediadent standarta darbvirsmas piemērs:
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Svarīgi saprast, ka darbvirsma ir saistīta arī ar jūsu ekrāna izšķirtspēju. Mainot ekrānu vai ekrāna
izšķirtspēju, var būt nepieciešams ielādēt citu darbvirsmu vai izveidot savu darbvirsmu.

               

12.3 Statusa panelis

Šajā tēmā mēs izskaidrosim pamatus alternatīvam veidam, kā strādāt ar attēliem.

Statusa panelis kopā ar attēlu bibliotēku ir veids, kā organizēt jūsu attēlus.

Attēlus var glabāt, mainīt vai dzēst statusa panelī vai attēlu bibliotēkā.

Statusa paneli var izmantot arī attēlu iegūšanas režīmā. Attēli tiks uzņemti lodziņos.

Atšķirības starp attēlu bibliotēku un statusa paneli

Attēlu bibliotēka ir galvenais konteiners, kurā tiek glabāti attēli. Veiktās darbības ar Attēlu bibliotēkā
esošajiem attēliem ir pastāvīgas. Tas nozīmē, ka, izdzēšot attēlu Attēlu bibliotēkā, tiks izdzēsts arī attēls
Statusa panelī. Attēla noņemšana no statusa paneļa neizraisa attēla dzēšanu.

Darbam ar statusa paneli ir vairākas priekšrocības:

Jums ir iespēja automatizēt attēlu uzņemšanas procesu. Dažās zobārstu praksēs ir ieviesta
noteikta attēlu uzņemšanas procedūra. Piemēram, dažos gadījumos ir vispārpieņemta prakse,
ka tiek uzņemti pilnas mutes attēli. Šādā gadījumā ir ļoti ērti, ja to var automatizēt.
Vēl viena statusa paneļa izmantošanas priekšrocība ir tā, ka varat automātiski saistīt zobu vai
zobus ar attēlu. Attēla nosaukums atspoguļos zobu vai zobu piesaisti.
Statusa panelī var noteikt arī secību, kādā tiek uzņemti attēli.
Ja uzņemat intraorālos attēlus, ir iespējams arī mainīt attēla orientāciju (pagriezt par 90° vai
apvērst horizontāli vai vertikāli) statusa paneļa lodziņā neatkarīgi no sākotnējā attēla.
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12.4 Globālā un pacienta bibliotēka

Globālā attēlu bibliotēka
Globālā attēlu bibliotēka ir bibliotēka, kas ir pieejama no katra pacienta bibliotēkas.

To var izmantot, lai glabātu attēlus demonstrēšanas nolūkos vai kā pagaidu krātuvi attēliem, kurus vēlaties
pārvietot no vienas pacienta bibliotēkas uz citu.

Globālās attēlu bibliotēkasikonu var atrast attēlu bibliotēkā: 

Noklikšķiniet uz Globālās attēlu bibliotēkas ikonas, lai apskatītu šajā bibliotēkā saglabātos attēlus.  

Pacienta attēlu bibliotēka
Pacienta attēlu bibliotēka ir mape, kurā tiek glabāti attēli, kas uzņemti konkrētajam pacientam. Jums ir
iespēja strukturēt pacienta attēlu bibliotēku jums piemērotā veidā.

Pacienta bibliotēkā varat izveidot apakšmapes.

Pacienta bibliotēkasikonu var atrast attēlu bibliotēkā: 

Noklikšķinot uz ikonas, tiek parādīti attēli pacienta attēlu bibliotēkā.

Vairāk par pacienta bibliotēkas izmantošanu varat uzzināt tēmā "Darbs ar attēlu bibliotēku" (Section
7.5.4).

Jūs varat izmantot globālo attēlu bibliotēku, ja vēlaties pārvietot vai kopēt attēlu no vienas pacienta
bibliotēkas uz citu. Sk. tēmu "Kā pārvietot attēlus no viena pacienta uz citu". (Section 8.3.1)

12.5 Kā darbojas histogramma?

Attēla histogramma ir histogrammas veids, kas darbojas kā digitālā attēla tonālā sadalījuma grafisks
attēlojums. Tā attēlo pikseļu skaitu katrai tonālajai vērtībai. Aplūkojot konkrēta attēla histogrammu, skatītājs
var novērtēt visu tonālo sadalījumu vienā mirklī.

Diagrammas horizontālā ass attēlo tonālās variācijas, bet vertikālā ass attēlo pikseļu skaitu konkrētajā tonī.

Horizontālā ass:

Horizontālās ass kreisajā pusē attēlotas melnās un tumšās zonas, vidū - vidēji tumši pelēkās, bet labajā
pusē - gaišās un baltās zonas.

Vertikālā ass:

Vertikālā ass attēlo katrā no šīm zonām fiksētā apgabala lielumu.

Tādējādi ļoti gaiša attēla ar nedaudzām tumšām zonām un/vai ēnām histogrammā lielākā daļa datu punktu
būs diagrammas labajā pusē un centrā.

Un otrādi, ļoti tumša attēla histogrammā lielākā daļa datu punktu būs diagrammas kreisajā pusē un
centrā.

Mediadent un histogramma
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Attēlu redaktoriem, piemēram, Mediadent, parasti ir iespēja izveidot rediģējamā attēla histogrammu.

Histogramma attēlo pikseļu skaitu attēlā (vertikālā ass) ar noteiktu spilgtuma vērtību (horizontālā ass).

Digitālā redaktora (Mediadent) algoritmi ļauj lietotājam vizuāli pielāgot katra pikseļa spilgtuma vērtību un
dinamiski parādīt rezultātus, kad tiek veiktas korekcijas.

Tādējādi var uzlabot attēla spilgtumu un kontrastu.

Sadaļā Darbs ar pelēko toņu korekciju (Section 7.2.1) uzzināsiet, kā izmantot histogrammu programmā
Mediadent.

(Avots: Wikipedia)
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13 Atbalsta saņemšana

Ja jums ir papildu jautājumi par Mediadent, varat sazināties ar organizāciju, no kuras iegādājāties Mediadent
(savu izplatītāju).

Tehnisku problēmu gadījumā esiet gatavi:

1. Ja rodas tehniskas problēmas, pārliecinieties, ka jums ir šādi materiāli:

- Mediadent instalācijas CD

- jūsu attēlu iegūšanas ierīces instalācijas CD

2. Jums var uzdot šādus jautājumus:

- Kādos apstākļos rodas problēma?

- Kāda Mediadent versija darbojas datorā?

- Kāda operētājsistēma darbojas datorā?

...

Lai jums varētu labāk palīdzēt, sniedziet pēc iespējas vairāk papildu informācijas.
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14 Identifikācija

Corilus SA/NV
Gaston Crommenlaan
4 bus 26

9050 Ghent, Belgium
Tel: +32 3 755 76 66
Fax: +32 3 755 76 22
info@imagelevel.com
www.imagelevel.com

Mediadent ir reģistrēta medicīniska ierīce.

2797

CE zīme attiecas uz šādiem Mediadent moduļiem ar
medicīnisku nolūku Mediadent: Pamata (Core),
Skatvieta (Viewport), Optimizēt (Optimize),
Kalibrēšana (Calibration), Mērījumi
(Measurements), 3D skatītājs (3D Viewer) un
Dentofaciālā ortopēdija (DFO).

Lietotāja rokasgrāmata (lietošanas instrukcija) tiek
piegādāta elektroniskā formātā. Ar lietotāja
rokasgrāmatu var iepazīties, izmantojot Mediadent
programmatūras palīdzības sadaļu, izmantojot
palīdzības izvēlni vai nospiežot īsinājumtaustiņu
"F1". Varat arī lejupielādēt
PDF formāta kopiju vietnē www.imagelevel.com vai
pieprasīt bezmaksas eksemplāru papīra formātā,
sazinoties ar mūsu klientu atbalsta dienestu. Papīra
rokasgrāmatas tiks piegādātas ne vēlāk kā 7
kalendāro dienu laikā.

 

 

 

 

Elektronisko lietošanas instrukciju izdošanas datums: 2024-10-31
Instrukciju redakcijas numurs: 3

Piemērojamā programmatūras versija: v8.24.02.1.5.*
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